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December 2025

Added information on the following:

Supported printer models

Upgrading to MVE 4.6

Support for Windows Server 2025

Firebird® (built-in) database version updated to 5.0.3.1683_0_x64

June 2025

Added information on the following:

Supported printer models

Upgrading to MVE 4.5

Support for Form‑Based Authentication

Updated information on authentication through Group Managed Service Accounts (gMSA) support 
addition.

Updated information on obfuscating the "certificateKeystorePassword" in the server xml file.

September 2024

Added information on the following:

Supported printer models

Upgrading to MVE 4.4

Understanding variable settings

Importing files to the resource library

Configuring email settings

Understanding ports and protocols

January 2023

Added information on Markvision™ Enterprise (MVE) configuration and workflow for ADFS.

Updated the information on accessing the security dashboard.

Added the Database access chapter.

August 2022

Added information on the following:

Enrollment over Secure Transport (EST) protocol as defined in RFC 7030

Security Dashboard

Automatic assignment of keywords during discovery

Change history
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Support for e‑mail over SSL/TLS

Support for Windows Server 2022

Updated information on the following:

Supported printer models

Managing certificates using Microsoft CA through Microsoft Certificate Enrollment Web Services 
(MSCEWS)

Configuring OpenXPKI CA server

Managing MVE configurations

March 2022

Updated information on the supported printer models.

Added information on creating a client certificate.

May 2021

Updated information on the following:

Supported printer models

Managing Microsoft Certificate Authority (CA)

Configuring MVE for automated certificate management

Configuring Microsoft Enterprise CA with Network Device Enrollment Service (NDES)

Added information on the following:

Managing certificates using Microsoft CA through Microsoft Certificate Enrollment Web Services 
(MSCEWS)

Creating SSL Certificate for Certificate Enrollment Policy Web Service (CEP) and Certificate 
Enrollment Web Service (CES) servers

Authentication methods for CEP and CES

Named device certificate

November 2020

Updated information on the following:

Supported printer models

Supported databases

Added information on the following:

Managing and deploying configurations

Backing up and restoring the database

Managing certificates using OpenXPKI and Microsoft Certificate Authority

Added support for the following:

Managing and deploying configurations to a group of printer models

Creating custom database names
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February 2020

Updated information on the following:

Supported printer models

Supported servers

Supported databases

Valid MVE upgrade path

Added information on the following:

Instructions for best practices

Instructions on managing automated certificates

Default advanced security components and their settings

Other ways in securing printers

Sample scenarios

June 2019

Updated information on the following:

Footnotes added to printer models that require certificates

Assigning dbo rights when setting up the database

Valid upgrade path when upgrading to version 3.4

Files that are needed when backing up and restoring the database

LDAP server authentication settings

Certificate validity status, dates, and time zone parameters are added to the search rule settings

Configuring the permissions and function access controls in the printer security settings

Selecting a firmware file from the resource library when updating the printer firmware

Selecting the start date, start and pause time, and days of the week when updating the printer 
firmware

Managing configurations

Added information on the following:

Understanding printer security states

Configuring advanced security components

Creating an advanced security component from a printer

Generating a printable version of the configuration settings

Uploading a printer fleet certificate authority

Removing user information and references

Understanding permissions and function access controls

Troubleshooting steps when enforcement of configurations with multiple applications fails

Troubleshooting steps when an Admin user has forgotten the password

August 2018
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Updated information on the following:

Supported printer models

Setting up the database

Upgrading to MVE 3.3

Frequently asked questions

Creating an action

Creating a schedule

Added information on the following:

Setting up a run‑as domain user account

Exporting logs

Troubleshooting steps when MVE does not recognize secured printers

July 2018

Updated information on upgrading to MVE 3.2.

April 2018

Updated information on the following:

Supported printer models

Setting up the database

Backing up and restoring database files

The URL for accessing MVE

Understanding variable settings

Added information on the following:

Configuring printer certificates

Stopping tasks

Updating printer firmware

September 2017

Updated information on the following:

System requirements

Communication between MVE and Lexmark™ Forms Printer 2580, 2581, 2590, and 2591 models

Manual dropping of Microsoft SQL Server databases

Backing up and restoring database files

Required security settings for function access controls when deploying firmware and solution files 
to printers

Support for licenses when deploying applications

Printer alerts and their associated actions

Printer state automatic recovery

Events and keywords assignment
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Understanding Markvision™ Enterprise
Markvision™ Enterprise (MVE) is a web-based printer management utility software designed for IT professionals. 
MVE is an on-premises utility designed for fleet management, enabling customers to oversee their fleet 
operations while maintaining all related data securely on a customer-configured local database.
With MVE, you can manage a large fleet of printers in an enterprise environment efficiently by doing the following:

Find, organize, and track a fleet of printers. You can audit a printer to collect printer data such as status, 
settings, and supplies.

Create configurations and assign them to printers.

Deploy firmware, printer certificates, certificate authority (CA), and applications to the printers.

Monitor printer events and alerts.

This document provides information on how to configure, use, and troubleshoot the application.
This document is intended for administrators.

Overview
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Best practices
This topic outlines the recommended steps to use MVE in managing your fleet effectively.

Install MVE in your environment.
Create a server using the latest Windows Server environment.

Related content:

Web server requirements

Create a domain user account that does not have administrator access.

Related content:

Setting up a run-as user

Create a Microsoft SQL Server database, set up encryption, and then give the new user account 
access to the databases.

Related content:

Database requirements

Setting up the database

Install MVE using the domain user account and the SQL server with Windows Authentication and 
gMSA (Group Managed Service Account).

Related content:

Installing MVE

Set up MVE, and then discover and organize your fleet.
Sign the server certificate.

Related content:

Signing the MVE certificate

Setting up MVE to manage certificates automatically

Set up the LDAP settings.

Related content:

Enabling LDAP server authentication

Installing LDAP certificates

Connect to an email server.

Related content:

Configuring e‑mail settings

Getting started
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Discover your fleet.

Related content:

Discovering printers

Schedule audits and status updates.

Related content:

Auditing printers

Updating printer status

Set up basic settings, such as contact names, locations, asset tags, and time zones.

Organize your fleet. Use keywords, such as locations, to categorize the printers.

Related content:

Assigning keywords to printers

Creating a saved search

Secure your fleet.
Secure printer access using the default advanced security components.

Related content:

Securing printers using the default configurations

Understanding permissions and function access controls

Other ways to secure your printers

Create a secured configuration that includes certificates.

Related content:

Creating a configuration

Importing files to the resource library

Enforce the configuration on your current fleet.

Related content:

Assigning configurations to printers

Enforcing configurations

Schedule enforcements and conformance checks.

Related content:

Creating a schedule

Add configurations to discovery profiles to secure new printers.

Related content:

Creating a discovery profile

Sign printer certificates.
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Related content:

Signing the MVE certificate

Keep your firmware up to date.

Related content:

Updating the printer firmware

Install and configure applications.

Related content:

Creating a configuration

Importing files to the resource library

Monitor your fleet.

Related content:

Creating a saved search

System requirements
MVE is installed as a web server and can be accessed from a web browser on any computer on the network. 
MVE also uses a database to store information about the printer fleet. The following lists are the requirements for 
the web server, database, and user system:

Web server requirements

Processor At least 4-core CPU (3GHz clock speed) that uses 
Hyper‑Threading Technology (HTT)

RAM At least 12GB

Hard disk drive At least 120GB free disk space

Note: MVE, Cloud Agent, Lexmark Document Distributor (LDD), and Device Deployment Utility (DDU) cannot 
be run on the same server.

Supported servers

Windows Server 2025 Standard Edition

Windows Server 2022 Standard Edition

Windows Server 2019

Windows Server 2016 Standard Edition

Database requirements

Supported databases
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Firebird database (built‑in version is 5.0.3.1683_0_x64)

Firebird (built-in version in MVE 4.6 is 5.0.3.1683_0_x64 version)

Microsoft SQL Server 2019

Note: The recommended minimum database size is 60GB to allocate 20MB for FRAMEWORK, and 4.5MB for 
MONITOR and QUARTZ. For more information, see “Setting up the database” on page 19.

User system requirements

Supported web browsers

Microsoft Edge

Mozilla Firefox (latest version)

Google Chrome™ (latest version)

Apple Safari (latest version)

Screen resolution

At least 1280 x 768 pixels

Supported languages
Brazilian Portuguese

English

French

German

Italian

Simplified Chinese

Spanish

Supported printer models
Lexmark B22362

Lexmark B23382, B24422, B25462, B26502, B28651

Lexmark B34402, B34422

Lexmark C2132

Lexmark C22402, C23252, C24252, C25352

Lexmark C23352

Lexmark C32242

Lexmark C33262

Lexmark C34262

Lexmark C41502, C61602, C92352
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Lexmark C43422, C43522

Lexmark C746, C748

Lexmark C792

Lexmark C9251, C950

Lexmark C9600

Lexmark C96552

Lexmark CS310, CS410, CS510

Lexmark CS317, CS417, CS517

Lexmark CS3312

Lexmark CS4212, CS5212, CS6222

Lexmark CS4312

Lexmark CS5312, CS6322

Lexmark CS7202, CS7252

Lexmark CS7272, CS7282

Lexmark CS7302

Lexmark CS7352

Lexmark CS7372

Lexmark CS8202, CS8272

Lexmark CS9212, CS9232, CS9272

Lexmark CS9432

Lexmark CS9602

Lexmark CS9632

Lexmark CX310, CX410, CX510

Lexmark CX317, CX417, CX517

Lexmark CX3312

Lexmark CX4212, CX5222, CX6222, CX6252

Lexmark CX4312

Lexmark CX5322

Lexmark CX6252

Lexmark CX6352

Lexmark CX7252

Lexmark CX7282

Lexmark CX7302

Lexmark CX7352

Lexmark CX7372

Lexmark CX8202, CX8252, CX8272, CX8302, CX8332, CX8602

Lexmark CX9202, CX9212, CX9222, CX9232, CX9242, CX9272

Lexmark CX9302, CX9312
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Lexmark CX9422, CX9432, CX9442

Lexmark CX9502, CX9512

Lexmark CX9602, CX9612, CX9622, CX9632

Lexmark M1140, M1145, M3150

Lexmark M12422, M12462, M32502, M52552, M52652, M52702

Lexmark M3346

Lexmark M33502

Lexmark M5155, M5163, M5170

Lexmark M52552, M52652, M52702

Lexmark MB22362

Lexmark MB23382, MB24422, MB25462, MB26502, MB27702

Lexmark MB34422

Lexmark MC23252, MC24252, MC25352, MC26402

Lexmark MC32242

Lexmark MC33262

Lexmark MC34262

Lexmark MS310, MS312, MS315, MS410, MS415, MS510, MS610

Lexmark MS317, MS417, MS517

Lexmark MS3212, MS4212, MS5212, MS6212, MS6222

Lexmark MS3312, MS4312

Lexmark MS5312, MS6312, MS6322

Lexmark MS617, MS817, MS818

Lexmark MS710, MS711, MS810, MS811, MS812

Lexmark MS7252, MS8212, MS8222, MS8232, MS8242, MS8252, MS8262

Lexmark MS911

Lexmark MX310, MX410, MX510, MX511, MX610, MX611

Lexmark MX317, MX417, MX517

Lexmark MX3212, MX4212, MX5212, MX5222, MX6222

Lexmark MX3312, MX4312

Lexmark MX4322

Lexmark MX5322, MX6322

Lexmark MX617, MX717, MX718

Lexmark MX6500

Lexmark MX710, MX711, MX810, MX811, MX812

Lexmark MX7212, MX7222, MX7252, MX8222, MX8242, MX8262

Lexmark MX910, MX911, MX912

Lexmark MX9312

Lexmark MX9532

Lexmark T6501, T6521, T6541, T6561
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Lexmark X6511, X6521, X6541, X6561, X6581

Lexmark X746, X748, X792

Lexmark X925, X950, X952, X954

Lexmark XC2130, XC2132

Lexmark XC22352, XC22402, XC42402

Lexmark XC2326

Lexmark XC23352

Lexmark XC2326

Lexmark XC2342

Lexmark XC43422, XC43522

Lexmark XC41402, XC41502, XC61522, XC81552, XC81602

Lexmark XC8300

Lexmark XC83552

Lexmark XC92252, XC92352, XC92452, XC92552, XC92652

Lexmark XC93252, XC93352

Lexmark XC94452, XC94552, XC94652

Lexmark XC95252, XC95352

Lexmark XC960

Lexmark XC96252, XC96352, XC96452, XC96552

Lexmark XM1135, XM1140, XM1145, XM3150

Lexmark XM12422, XM12462, XM32502

Lexmark XM31422, XM31462

Lexmark XM3346

Lexmark XM33502

Lexmark XM5163, XM5170, XM5263, XM5270

Lexmark XM53652, XM53702

Lexmark XM7155, XM7163, XM7170, XM7263, XM7270

Lexmark XM73552, MX73652, MX73702

Lexmark XM9145, XM9155, XM9165

Lexmark XM93352

Lexmark XM96552

1 A printer certificate update is required. In this release, the Java platform security and performance update 
remove support for some certificate‑signing algorithms, such as MD5 and SHA1. This change prevents MVE from 
working with some printers. For more information, see the help information documentation.
2 SNMPv3 support must be enabled on the printer.
3 If an advanced security password is set on the printer, then MVE cannot support the printer.

Setting up the database
You can use either Firebird or Microsoft SQL Server as the back-end database. The following table can help you 
decide on what database to use.
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Firebird Microsoft SQL Server

Server installation Must be installed on the same 
server as MVE.

Can be run from any server.

Communication Locked down to only localhost. Communicates over a static port 
or a dynamic named instance.

SSL/TLS communication with a 
secured Microsoft SQL server is 
supported.

Performance Shows performance issues with 
large fleets.

Shows the best performance for 
large fleets.

Database size Default database sizes are 6MB 
for FRAMEWORK, and 1MB for 
MONITOR and QUARTZ. The 
FRAMEWORK table grows at 
1KB for each printer record that 
is added.

Default database sizes are 
20MB for FRAMEWORK, and 
4.5MB for MONITOR and 
QUARTZ. The FRAMEWORK 
table grows at 1KB for each 
printer record that is added.

Configuration Configured automatically during 
installation.

Requires preinstallation setup.

If you are using Firebird, then the MVE installer installs and configures Firebird with no other configuration 
required.
If you are using Microsoft SQL Server, then before installing MVE, do the following:

Allow the application to run automatically.

Set the network libraries to use TCP/IP sockets.

Create the following databases:

Note: The following are default database names. You can also provide custom database names.

FRAMEWORK

MONITOR

QUARTZ

If you are using a named instance, then set the Microsoft SQL Server Browser service to start 
automatically. Otherwise, set a static port on the TCP/IP sockets.

Create a user account with dbowner rights to all three databases that MVE uses to connect to and set up 
the database. If the user is a Microsoft SQL Server account, then enable the Microsoft SQL Server and the 
Windows Authentication modes on the Microsoft SQL Server.

Note: Uninstalling MVE that is configured to use Microsoft SQL Server does not drop the created tables 
or databases. After uninstalling, the FRAMEWORK, MONITOR, and QUARTZ databases must be 
dropped manually.

Assign the dbo rights to the database user, and then set the dbo schema as the default schema.

Setting up a run-as user
During installation, you can specify MVE to execute either as a local system account or as a domain user 
account. Executing MVE as a run-as domain user account provides a more secure installation. The domain user 
account has limited privileges compared to a local system account.
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2.

Run‑as domain user account Run‑as local system

Local system permissions
File all access to the 
following:

$MVE_INSTALL/
tomcat/logs

$MVE_INSTALL/
tomcat/temp

$MVE_INSTALL/
tomcat/work

$MVE_INSTALL/
apps/library

$MVE_INSTALL/
apps/dm-mve/
picture

$MVE_INSTALL/../
mve_truststore*

$MVE_INSTALL/
jre/lib/security/
cacerts

$MVE_INSTALL/
apps/dm-mve/
WEB-INF/ldap

$MVE_INSTALL/
apps/dm-mve/
download

Where $MVE_INSTALL is 
the installation directory.

Windows privilege: 
LOGON_AS_A_SERVICE

Administrator permissions

Database connection 
authentication Windows Authentication 

with Microsoft SQL 
Server

SQL Authentication

SQL Authentication

Configuration A domain user must be 
configured before installation.

Configured automatically during 
installation

If you set up MVE as a run-as domain user account, then create the user on the same domain as the MVE 
server.

Installing MVE
Download the executable file into a path that does not contain any spaces.

Run the file as an administrator, and then follow the instructions on the computer screen.
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Note:

Passwords are hashed and stored securely. Make sure that you remember your passwords, or store 
them in a secure location because passwords cannot be decrypted once stored.

If you are connecting to the Microsoft SQL Server using Windows Authentication, then no connection 
verification occurs during installation. Make sure that the user designated to execute the MVE windows 
service has a corresponding account in the Microsoft SQL Server instance. The designated user must 
have dbowner rights to the FRAMEWORK, MONITOR, and QUARTZ databases.

If you are connecting to the Microsoft SQL Server using gMSA authentication, then no connection 
verification occurs during installation. Make sure that the gMSA is already installed in the system where 
the user intends to install MVE. Also, make sure that the corresponding gMSA is already added as a 
login user with public and serveradmin roles in the Microsoft SQL Server instance. The gMSA must 
have dbowner rights to the FRAMEWORK, MONITOR, and QUARTZ databases.

While installing MVE with Microsoft SQL server using gMSA authentication, the user must provide the 
full gMSA account with the domain name ending in $. For example: mve\gmsaadmin$.

Installing MVE silently

Setting Description Value

--help Shows the list of valid options.

--version Shows the product information.

--unattendedmodeui 
<unattendedmodeui>

The user interface for 
unattended mode.

Default: none

Allowed:

none

minimal

minimalWithDialogs

--optionfile <optionfile> The installation option file. Default:

--debuglevel <debuglevel> The debug information level of 
verbosity.

Default: 2

Allowed:

0

1

2

3

4

--mode <mode> The installation mode. Default: win32

Allowed:

win32

unattended
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Setting Description Value

--debugtrace <debugtrace> The debug file name. Default:

--installer-language <installer-
language>

The language selection. Default: en

Allowed:

en

es

de

fr

it

pt_BR

zh_CN

--encryptionKey 
<encryptionKey>

The encryption key. Encryption key:

Default:

--prefix <prefix> The installation directory. Default: C:\Program Files

--mveLexmark_runas 
<mveLexmark_runas>

The run‑as user options. Default: LOCAL_SYSTEM

Allowed:

LOCAL_SYSTEM

SPECIFIC_USER

--serviceRunAsUsername 
<serviceRunAsUsername>

The run‑as user name. User name:

Default:

--serviceRunAsPassword 
<serviceRunAsPassword>

The run‑as user password. Password:

Default:

--mveLexmark_database 
<mveLexmark_database>

The database type. Default:

Allowed:

FIREBIRD

SQL_SERVER

--firebirdUsername 
<firebirdUsername>

The Firebird database user 
name.

User name:

Default:

--firebirdPassword 
<firebirdPassword>

The Firebird database password. Password:

Default:

--firebirdFWDbName 
<firebirdFWDbName>

The Firebird database name for 
FRAMEWORK.

Database names:

Default: FRAMEWORK
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Setting Description Value

--firebirdMNDbName 
<firebirdMNDbName>

The Firebird database name for 
MONITOR.

Default: MONITOR

--firebirdQZDbName 
<firebirdQZDbName>

The Firebird database name for 
QUARTZ.

Default: QUARTZ

--databaseIPAddress 
<databaseIPAddress>

The database IP address or host 
name.

IP address or host name:

Default:

--databasePort <databasePort> The database port number. Port number:

Default:

--instanceName 
<instanceName>

The instance name. Instance name:

Default:

--instanceIdentifier 
<instanceIdentifier>

The instance. Default: databasePort

Allowed:

databasePort

instanceName

--databaseUsername 
<databaseUsername>

The database user name. User name:

Default:

--databasePassword 
<databasePassword>

The database password. Password:

Default:

--sqlServerAuthenticationMethod 
<sqlServerAuthenticationMethod
>

The Microsoft SQL server 
authentication method.

Default: 
sqlServerDbAuthentication

Allowed:

sqlServerDbAuthenticatio
n

sqlServerWindowsAuthen
tication

--fWDbName <fWDbName> The database name for 
FRAMEWORK.

Database names:

Default: FRAMEWORK

--mNDbName <mNDbName> The database name for 
MONITOR.

Default: MONITOR

--qZDbName <qZDbName> The database name for 
QUARTZ.

Default: QUARTZ

--mveAdminUsername 
<mveAdminUsername>

The administrator user name. User name:

Default: admin

--mveAdminPassword 
<mveAdminPassword>

The administrator password. Password:

Default:
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Accessing MVE
To access MVE, use the login credentials that you created during installation. You can also set up other login 
methods, such as LDAP, Kerberos, or other local accounts. For more information, see "Setting up user access" 
chapter.

Open a web browser, and then type https://MVE_SERVER/mve/, where MVE_SERVER is the host name 
or IP address of the server hosting MVE.

If necessary, accept the disclaimer.

Enter your credentials.

Click Log In.

Notes

After logging in, make sure that you change the default administrator password that was used during 
installation. For more information, see Changing your password on page 25.

If MVE is idle for more than 30 minutes, then the user is logged out automatically.

Changing the language
Open a web browser, and then type https://MVE_SERVER/mve/, where MVE_SERVER is the host name 
or IP address of the server hosting MVE.

If necessary, accept the disclaimer.

On the upper‑right corner of the page, select a language.

Changing your password
Open a web browser, and then type https://MVE_SERVER/mve/, where MVE_SERVER is the host name 
or IP address of the server hosting MVE.

If necessary, accept the disclaimer.

Enter your credentials.

Click Log In.

On the upper‑right corner of the page, click your user name, and then click Change password.

Change the password.
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Upgrading to MVE 4.6

Notes:

Due to issues with Oracle licensing, MVE 4.0 has been revoked. As a result, customers currently using 
version 3.x cannot upgrade directly. Instead, they must perform a fresh installation of the necessary 4.x 
version.

If you are already using any 4.x version with SQL database, then you can directly upgrade to 4.6.

When upgrading from MVE 4.3.x or MVE 4.4.x to MVE 4.6 using Firebird DB, we recommend to 
upgrading to interim MVE 4.5.1 first. Upgrading directly to MVE 4.6 can cause failures due to user 
restrictions after Firebird version upgrade to MVE 4.6.

Back up the database, application, and properties files. If necessary, provide custom database names.

Warning—Potential Damage
When you upgrade MVE, the database is changed. Do not restore a database backup which was 
created from a previous version.

Note: Any upgrade or uninstallation creates a risk of unrecoverable data loss. You can use the backup 
files to restore the application to its previous state in case the upgrade fails. For more information, see 
Backing up and restoring the database on page 26.

Download the executable file to a temporary location.

Run the installer as an administrator, and then follow the instructions on the computer screen.

Note: After upgrading, make sure to clear the browser cache before accessing the application again.

Backing up and restoring the database

Note: There is potential data loss when performing backup and restore procedures. Make sure to perform the 
steps properly.

Backing up the database and application files

backing-up-database
We recommend backing up your database regularly.

Stop the Firebird service and the Markvision Enterprise service.
Open the Run dialog box, and then type services.msc.

Right‑click Firebird Guardian - DefaultInstance, and then click Stop.

Maintaining the application
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Right‑click Markvision Enterprise, and then click Stop.

Browse to the folder where Markvision Enterprise is installed.

For example, C:\Program Files\

Back up the application and database files.

Backing up the application files

Copy the following files to a safe repository:

Lexmark\mve_encryption.jceks

Lexmark\mve_truststore.p12

Lexmark\Markvision Enterprise\apps\dm-mve\WEB-INF\classes\database.properties

Lexmark\Markvision Enterprise\apps\dm-mve\WEB-INF\classes\encryption.properties

Lexmark\Markvision Enterprise\apps\dm-mve\WEB-INF\classes\platform.properties

Lexmark\Markvision Enterprise\apps\library

Lexmark\Markvision Enterprise\apps\mve-data-service\WEB-INF\classes\database.properties

Lexmark\Markvision Enterprise\apps\mve-data-service\WEB-INF\classes\encryption.properties

Lexmark\Markvision Enterprise\jre\lib\security\cacerts

Lexmark\Markvision Enterprise\tomcat\conf\server.xml

Note: Make sure that these files are properly stored. Without the encryption keys in the 
mve_encryption.jceks file, data stored in an encrypted format in the database and on the file system 
cannot be recovered.

Backing up the database files

Do either of the following:

Note: The following files are using the default database names. These instructions also apply to 
customized database names.

If you are using a Firebird database, then copy the following files to a safe repository. These files 
must be backed up regularly to avoid data loss.

Lexmark\Markvision Enterprise\firebird\security2.fdb

If you are using custom database names, then update the following:

Lexmark\Markvision Enterprise\apps\dm-mve\WEB-INF\classes\database.properties

Lexmark\Markvision Enterprise\apps\mve-data-service\WEB-
INF\classes\database.properties

Lexmark\Markvision Enterprise\apps\mve-data-service/WEB-
INF\classes\application.yml

Lexmark\Markvision Enterprise\firebird\aliases.conf

Lexmark\Markvision Enterprise\firebird\data\QUARTZ.FDB

Lexmark\Markvision Enterprise\firebird\data\MONITOR.FDB
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Lexmark\Markvision Enterprise\firebird\data\FRAMEWORK.FDB

If you are using Microsoft SQL Server, then create a backup for FRAMEWORK, MONITOR, and 
QUARTZ.

For more information, contact your Microsoft SQL Server administrator.

Restart the Firebird service and the Markvision Enterprise service.
Open the Run dialog box, and then type services.msc.

Right‑click Firebird Guardian - DefaultInstance, and then click Restart.

Right‑click Markvision Enterprise, and then click Restart.

Restoring the database and application files

restoring-database

Warning—Potential Damage
When you upgrade MVE, the database may be changed. Do not restore a database backup that was created 
from a previous version.

Stop the Markvision Enterprise service.

For more information, see of .Backing up and restoring the database on page 0 Backing up and restoring 
the database on page 0

Browse to the folder where Markvision Enterprise is installed.

For example, C:\Program Files\

Restore the application files.

Replace the following files with the files that you saved during the backup process:

Lexmark\mve_encryption.jceks

Lexmark\mve_truststore.p12

Lexmark\Markvision Enterprise\apps\dm-mve\WEB-INF\classes\database.properties

Lexmark\Markvision Enterprise\apps\dm-mve\WEB-INF\classes\encryption.properties

Lexmark\Markvision Enterprise\apps\dm-mve\WEB-INF\classes\platform.properties

Lexmark\Markvision Enterprise\apps\library

Lexmark\Markvision Enterprise\apps\mve-data-service\WEB-INF\classes\database.properties

Lexmark\Markvision Enterprise\apps\mve-data-service\WEB-INF\classes\encryption.properties

Lexmark\Markvision Enterprise\jre\lib\security\cacerts

Lexmark\Markvision Enterprise\tomcat\conf\server.xml

Note: You can restore a database backup to a new MVE installation only if the new MVE installation is 
the same version.

Restore the database files.

file:////opt/aem/launcher/profiles/ditamaps/ditamap9828729197733793619/topics/backing-up-and-restoring-the-database-v51574692.htm
file:////opt/aem/launcher/profiles/ditamaps/ditamap9828729197733793619/topics/backing-up-and-restoring-the-database-v51574692.htm
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Do either of the following:

If you are using a Firebird database, then replace the following files that you saved during the 
backup process:

Note: The following files are using the default database names. This instruction also applies to 
customized database names.

Lexmark\Markvision Enterprise\firebird\security2.fdb

If you are using custom database names, then the following files are also restored:

Lexmark\Markvision Enterprise\apps\dm-mve\WEB-INF\classes\database.properties

Lexmark\Markvision Enterprise\apps\mve-data-service\WEB-
INF\classes\database.properties

Lexmark\Markvision Enterprise\apps\mve-data-service/WEB-
INF\classes\application.yml

Lexmark\Markvision Enterprise\firebird\aliases.conf

Lexmark\Markvision Enterprise\firebird\data\QUARTZ.FDB

Lexmark\Markvision Enterprise\firebird\data\MONITOR.FDB

Lexmark\Markvision Enterprise\firebird\data\FRAMEWORK.FDB

If you are using Microsoft SQL Server, then contact your Microsoft SQL Server administrator.

Restart the Markvision Enterprise service.

For more information, see of .Backing up and restoring the database on page 0 Backing up and restoring 
the database on page 0

Updating the installer settings after installation
The Markvision Enterprise Password Utility lets you update the Microsoft SQL Server settings that have been 
configured during installation without reinstalling MVE. The utility also lets you update the run-as user domain 
account credentials, such as user name and password. You can also use the utility to create another Admin user 
if you forget your previous Admin user credentials.

Browse to the folder where Markvision Enterprise is installed.

For example, C:\Program Files\

Launch the mvepwdutility-windows.exe file in the Lexmark\Markvision Enterprise\ directory.

Select a language, and then click OK > Next.

Follow the instructions on the computer screen.

file:////opt/aem/launcher/profiles/ditamaps/ditamap9828729197733793619/topics/backing-up-and-restoring-the-database-v51574692.htm
file:////opt/aem/launcher/profiles/ditamaps/ditamap9828729197733793619/topics/backing-up-and-restoring-the-database-v51574692.htm
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Overview
MVE lets you add internal users directly to the MVE server or use the user accounts registered in an LDAP 
server. For more information on adding internal users, see Managing users on page 31. For more information on 
using LDAP user accounts, see Enabling LDAP server authentication on page 32.
When adding users, roles must be assigned. For more information, see Understanding user roles on page 30.
During authentication, the system checks the user credentials of the internal users present in the MVE server. If 
MVE cannot authenticate the user, then it tries to authenticate the user in the LDAP server. If the user name 
exists in both the MVE server and the LDAP server, then the password in the MVE server is used.

Understanding user roles
MVE users can be assigned to one or more roles. Depending on the role, users can perform the following tasks:

Admin—Access and perform tasks in all menus. They also have administrative privileges, such as adding 
users to the system or configuring the system settings. Only users with an Admin role can stop any 
running task no matter what user type started it.

Printers

Manage discovery profiles.

Set the printer states.

Perform an audit.

Manage categories and keywords.

Schedule an audit, data export, and printer discovery.

Configurations

Manage configurations, including importing and exporting configuration files.

Upload files to the resource library.

Assign and enforce configurations to printers.

Schedule a conformance check and configurations enforcement.

Deploy files to printers.

Update the printer firmware.

Generate printer certificate signing requests.

Download printer certificate signing requests.

Event Manager

Manage actions and events.

Assign events to printers.

Test actions.

Service Desk

Update the printer status.

Setting up user access
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Reboot printers.

Run a conformance check.

Enforce configurations to printers.

Notes

All users in MVE can view the printer information page, and manage saved searches and views.

For more information on assigning user roles, see Managing users on page 31.

Managing users
This feature allows administrators to manage user accounts in Markvision Enterprise, including adding, editing, 
and deleting users.

Note: A user account is locked out after three consecutive failed login attempts. Only an Admin user can 
reactivate the user account. If the Admin user is locked out, then the system reactivates it automatically after 
five minutes.

Add a user

Click User on the upper-right corner of the page.

Click Create.

Type the user name, user ID, and password.

Select the roles.

Note: For more information, see Understanding user roles on page 30.

Click Create User.

Edit a user

Select a user ID.

Configure the settings.

Click Save Changes.

Delete users

Select one or more users.

Click Delete, and then confirm deletion.
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Enabling LDAP server authentication
LDAP is a standards-based, cross-platform, extensible protocol that runs directly on top of TCP/IP. It is used to 
access specialized databases called directories.

To avoid maintaining multiple user credentials, you can use the company LDAP server to authenticate user IDs 
and passwords.

As a prerequisite, the LDAP server must contain user groups that correspond to the required user roles. For more 
information, see Understanding user roles on page 30.

Click  on the upper‑right corner of the page.

Click LDAP, and then select Enable LDAP for authentication.

In the LDAP server hostname field, type the IP address or the host name of the LDAP server where the 
authentication occurs.

Note: If you want to use encrypted communication between the MVE server and the LDAP server, then 
use the fully qualified domain name (FQDN).

Specify the server port number according to the encryption protocol selected.

Select the encryption protocol.

None

TLS—A security protocol that uses data encryption and certificate authentication to protect the 
communication between a server and a client. If this option is selected, then a START_TLS 
command is sent to the LDAP server after the connection is established. Use this setting if you 
want a secure communication over port 389.

SSL/TLS—A security protocol that uses public‑key cryptography to authenticate the communication 
between a server and a client. Use this option if you want a secured communication from the start 
of the LDAP bind. This option is typically used for port 636 or other secured LDAP ports.

Select the binding type.

Simple—The MVE server produces the specified credentials to the LDAP server to use the LDAP 
server lookup facility.

Type the bind user name.

Type the bind password, and then confirm the password.

Kerberos—To configure the settings, do the following:

Type the bind user name.

Type the bind password, and then confirm the password.

Click Choose File, and then browse to the krb5.conf file.

SPNEGO—To configure the settings, do the following:

Type the service principal name.

Click Choose File, and then browse to the krb5.conf file.

Click Choose File, and then browse to the Kerberos keytab file.
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This option is used only for configuring the Simple and Protected GSSAPI Negotiation Mechanism 
(SPNEGO) to support the Single Sign-On functionality.

This option is used only for configuring the Simple and Protected GSSAPI Negotiation Mechanism 
(SPNEGO) to support the Single Sign-On functionality.

From the Advanced Options section, configure the following:

Search Base—The base distinguished name (DN) of the root node. In the LDAP community server 
hierarchy, this node must be the ancestor of the user node and group node. For example, 
dc=mvetest,dc=com.

Note: When specifying the root DN, make sure that only dc and o are part of the root DN. If ou
or cn is the ancestor of the user and group nodes, then use ou or cn in the user and group 
search bases.

User search base—The node in the LDAP community server where the user object exists. This 
node is under the root DN where all the user nodes are listed. For example, ou=people.

User search filter—The parameter for locating a user object in the LDAP community server. For 
example, (uid={0}).

Log in using In the User search filter field, type

Common name (CN={0})

Login name (sAMAccountName={0})

User Principal Name (userPrincipalName={0})

Telephone number (telephoneNumber={0})

Login name or common name (|(sAMAccountName={0})(CN={0}))

Note: Only the {0} and {1} patterns can be used. If {0} is used, then MVE searches for the LDAP 
user DN. If {1} is used, then MVE searches for the MVE user login name.

Search User base object and whole subtree—The system searches all the nodes under the user 
search base.

Group search base—The node in the LDAP community server containing the user groups that 
correspond to the MVE roles. This node is under the root DN where all the group nodes are listed. 
For example, ou=group.

Group search filter—The parameter for locating a user within a group that corresponds to a role in 
MVE.

Note: The only valid pattern is {0}, which means that MVE searches for the MVE user login 
name.

Group role attribute—Type the LDAP attribute for the full name of the group. An LDAP attribute 
has a specific meaning and defines a mapping between the attribute and a field name. For 
example, the LDAP attribute cn is associated with the Full Name field. The LDAP attribute 
commonname is also mapped to the Full Name field. Generally, this attribute must be left to the 
default value of cn.

Search User base object and whole subtree—The system searches all the nodes under the 
group search base.
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From the LDAP Groups to MVE Role Mapping section, type the names of the LDAP groups that 
correspond to the MVE roles.

Notes
For more information, see Understanding user roles on page 30.

You can assign one LDAP group to multiple MVE roles. You can also type more than one LDAP 
group in a role field, using the vertical bar character (|) to separate multiple groups. For example, 
to include the admin and assets groups for the Admin role, type admin|assets in the LDAP 
groups for Admin role field.

If you want to use only the Admin role and not the other MVE roles, then leave the fields blank.

Click Save Changes.

Installing LDAP server certificates
To establish an encrypted communication between the MVE server and the LDAP server, MVE must trust the 
LDAP server certificate. In the MVE architecture, when MVE is authenticating with an LDAP server, MVE is the 
client and the LDAP server is the peer.

Click  on the upper‑right corner of the page.

Click LDAP, and then configure the LDAP settings. For more information, see Enabling LDAP server 
authentication on page 32.

Click Test LDAP.

Enter a valid LDAP user name and password, and then click Start Test.

Examine the certificate for validity, and then accept it.

Adding a root CA certificate in the Java truststore
Some MVE LDAP configurations use a load balancer or a virtual IP (VIP) to redirect LDAPS requests. In these 
cases, the root CA certificate of the domain must be installed and trusted in the MVE Java truststore.

Import the root CA certificate, and then confirm that the certificate is trusted.

Back up your database and application files.

Stop the MVE service.

Run the command prompt as an administrator, and then type the following:

"C:\Program Files\Lexmark\Markvision Enterprise\jre\bin\keytool.exe" -import -trustcacerts -alias 
EnterpriseRootCA -file C:\temp\EnterpriseRootCA.cer -keystore "C:\Program 
Files\Lexmark\Markvision Enterprise\jre\lib\security\cacerts"

When prompted to enter the keystore password, type changeit.

When prompted whether to trust the certificate, type yes.
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If the process is successful, then a Certificate was added to keystore message appears.

If the file-level permissions for the cacerts file do not allow you to update the file, then an 
access‑denied message appears. You can either update the permissions for the file or run the 
command prompt as an administrator who has the permission to update the file.

Restart the MVE service.
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Creating a discovery profile
Use a discovery profile to find printers in your network and add them to the system. In a discovery profile, do 
either of the following to include or exclude a list of IP addresses or host names:

Adding entries one at a time

Importing entries using a TXT or CSV file

You can also assign and enforce a configuration automatically to a compatible printer model. A configuration must 
contain printer settings, applications, licenses, firmware, and CA certificates that can be deployed to the printers.

From the Printers menu, click Discovery Profiles › Create.

From the General section, type a unique name and description for the discovery profile, and then 
configure the following:

Timeout——How long the system waits for a printer to respond.

Retries——The number of times the system attempts to communicate with a printer.

Automatically manage discovered printers——Newly discovered printers are set to a Managed 
state automatically, and the New state is skipped during discovery.

From the Addresses section, do either of the following:

Add the addresses
Select Include or Exclude.

Type the IP address, host name, subnet, or IP address range.

Add only one entry at a time. Use the following formats for the addresses:
10.195.10.1 (single IPv4 address)

myprinter.example.com (single host name)

10.195.10.3-10.195.10.255 (IPv4 address range)

10.195.*.* (wildcards)

10.195.10.1/22 (IPv4 Classless Inter‑Domain Routing or CIDR notation)

2001:db8:0:0:0:0:2:1 (full IPv6 address)

2001:db8::2:1 (collapsed IPv6 address)

Note: If separate discovery profiles are created for the IPv6 and the IPv4 address for the same 
printer, then the last discovered address is shown. For example, if a printer is discovered using 
IPv6, and is discovered again using IPv4, then only the IPv4 address is shown in the printer list.

Discovering printers
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Click Add.

Import the addresses
Click Import.

Select whether to include or exclude IP addresses during the discovery.

Browse to the text file that contains a list of addresses. Each address entry must be placed on a 
separate line.

Sample text file
10.195.10.1
myprinter.example.com10.195.10.1
10.195.10.3-10.195.10.255
10.195.*.*
10.195.10.1/22
2001:db8:0:0:0:0:2:1
2001:db8::2:1

Click Import.

From the SNMP section, select Version 1, Version 2c or Version 3, and then set the access permissions.

Note: To discover printers using SNMP version 3, create a user name and password in the printer 
Embedded Web Server, and then restart the printer. If a connection cannot be established, then 
rediscover the printers. For more information, see the Embedded Web Server Administrator’s Guide.

If necessary, from the Enter Credentials section, select the authentication method that the printers are 
using, and then enter the credentials.

Note: This feature lets you establish communication with secured printers during discovery. The correct 
credentials must be provided to perform tasks on the secured printers, such as audit, status update, 
and firmware update.

If necessary, from the Assign Configurations section, associate a configuration with a printer model. For 
information on creating a configuration, see Creating a configuration on page 70.

If necessary, from the Assign Keywords section, associate a keyword with a printer model during 
discovery. For information on assigning keywords to printers, see Assigning keywords to printers on page 
67.

Notes
All the printers discovered through this profile are assigned with the new keywords.

The new keywords are added to the existing list of keywords which are already assigned to a 
printer.

Click Save Profile or Save and Run Profile.
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Note: A discovery can be scheduled to occur regularly. For more information, see Creating a schedule on 
page 153.

Managing discovery profiles
From the Printers menu, click Discovery Profiles.

Do any of the following:

Edit an profile

Select a profile, and then click Edit.

Configure the settings.

Click Save Profile or Save and Run Profile.

Copy a profile

Select a profile, and then click Copy.

Configure the settings.

Add the IP addresses. For more information, see Creating a discovery profile on page 36.

Click Save Profile or Save and Run Profile.

Delete a profile

Select one or more profiles.

Click Delete, and then confirm deletion.

Run a profile

Select one or more profiles.

Click Run. Check the discovery status from the Tasks menu.

Sample scenario: Discovering printers
Company ABC is a large manufacturing company occupying a nine-story building. The company just bought 30 
new Lexmark printers, distributed among the nine floors. As the IT personnel, you must add these new printers to 
MVE. The printers are already connected to the network, but you do not know all the IP addresses.

You want to secure the following new printers in the Accounting department.

10.194.55.60
10.194.56.77
10.194.55.71
10.194.63.27
10.194.63.10
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Sample implementation

Create a discovery profile for the printers in the Accounting department.

Add the five IP addresses.

Create a configuration that secures the specified printers.

Include the configurations in the discovery profile.

Save and run the profile.

Create another discovery profile for the rest of the printers.

Include the IP addresses using a wildcard. Use the following: 10.194.*.*

Exclude the five printer IP addresses in the Accounting department.

Save, and then run the profile.
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Overview
The Security dashboard lets you view the health of the device security settings. It is a visual representation of 
various security settings, such as, ports, protocols, disk encryption status, device administrator accounts, and 
default certificate status. It provides visibility to the security posture of your fleet, which helps administrators to 
identify and fix the settings which are out of compliance.

Accessing the security dashboard
From the MVE web portal, click Dashboard.

Note: The security dashboard is the default landing page for Admin users.

Click either of the following widgets:

Device Security Information

Device Conformance Check

Showing or hiding the security dashboard

Modify the dashboard.display parameter in the platform.properties file to hide or show the Security 
Dashboard.

You can find the platform.properties file in \Installation Location\Markvision Enterprise\apps\dm-mve\WEB-
INF\classes, where Installation Location is the installation folder of MVE.

The default value of this parameter is True. If you enter an incorrect value or leave the field blank for this 
parameter, then the dashboard is displayed.

To disable the dashboard, set the dashboard.display parameter to False.

After you modify the parameter, restart the MVE service.

Managing Device Security Information
This widget summarizes the security view of the fleet.

Click any bar of the chart to go to the Device Security Information window.

Hover your mouse over the bars to view the following details:

Port number

Number of associated printers

Whether the printer settings are open/enabled

Click Print to get a printable format of the detailed view.

Managing the security dashboard
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Notes

The Device Security Information window provides the user with a drill‑down feature.

Clicking any bar item in the chart enables the user to navigate to a filtered view of the printer listing 
page. For more information, see Viewing the printer list on page 42.

Managing Device Conformance Check
This widget summarizes the detailed view of the conformance check of the fleet.

Click any section of the pie chart to go to the Device Conformance Check window.

From the left pane, apply the Date Range filter.

Note: Default range is 7 days.

Click Print to get a printable format of the detailed view.

Notes

The Device Conformance Check window provides the user with a drill‑down feature.

Clicking any section of the pie chart enables the user to navigate to a filtered view of the printer listing 
page. For more information, see Viewing the printer list on page 42.
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Viewing the printer list
The Printer Listing page is the default landing page when you access MVE. The table shows the list of the 
printers that are added in MVE.

From the Printers menu, click Printer Listing.

From the Printer Listing page, do any of the following:

To search for specific printers, do any of the following:

Use the search box to search for an IP address, host name, system name, or serial number.

Change the printer listing view. For more information, see Changing the printer listing view
on page 47.

Viewing printers
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Note: If you are using the search box, then the application searches for all the printers in 
the system. The selected filters and saved searches are ignored. If you run a saved 
search, then the criteria specified in the saved search are used. The selected filters and 
the IP address or host name typed in the search box are ignored. You can also use the 
filters to narrow down the current search results.

Use the filters.

Run a saved search. For more information, see Running a saved search on page 50.
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To sort the printers, from the printer list table, click any column header. The printers are sorted 
according to the selected column header.

To view more information about the printers, resize the columns. Place your cursor over the vertical 
border of the column header, and then drag the border to the left or to the right.

Viewing the printer information
To see the complete list of information, make sure that an audit is performed on the printer. For more information, 
see Auditing printers on page 62.

From the Printers menu, click Printer Listing.

Click the IP address of the printer.

View the following information:

Status—The status of the printer.

Supplies—The supply details and remaining supply percentage.

Identification—The printer network identification information.

Note: The time zone information is available only in some printer models.

Dates—The date the printer is added to the system, the discovery date, and the most recent audit 
date.

Firmware—The printer firmware properties and code levels.

Capabilities—The printer features.

Memory Options—The hard disk size and user flash free space.

Input Options—The settings for the available trays.

Output Options—The settings for the available bins.

eSF Applications—The information about the installed Embedded Solutions Framework (eSF) 
applications on the printer.

Printer Statistics—The specific values for each of the printer properties.
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Change Details—The information about the changes in the printer.

Note: This information is available only in printers that are in a Managed (Changed) state. For 
more information, see Understanding printer life cycle states on page 48.

Printer Credentials—The credentials used in the configuration assigned to the printer.

Printer Certificate—The properties of the following printer certificates:

Default

HTTPS

802.1x

IPSec

Notes
This information is available only in some printer models.

An Expiring Soon validity status indicates the expiry date, as set in the Certificate 
Authority section under System Configuration.

Configuration Properties—The properties of the configuration assigned to the printer.

Active Alerts—The printer alerts that are waiting to be cleared.

Assigned Events—The events assigned to the printer.

Exporting printer data
MVE lets you export the printer information that is available in your current view.

From the Printers menu, click Printer Listing.

Select one or more printers.

Click Printer > Export data.

Notes
The exported data is saved in a CSV file.

Exporting data can be scheduled to occur regularly. For more information, see Creating a 
schedule on page 153.

Managing views
The Views feature lets you customize the information that is shown in the printer listing page.

Create a view

From the Printers menu, click Views.
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Click Create.

Type a unique name for the view and its description.

From the View Columns section, in the Column 1 menu, select the identifier column.

From the Possible columns section, expand a category, select the information that you want to show as a 
column, and then click >.

Capabilities—Shows whether the selected features are supported on the printer.

Certificate—Shows the printer certificate creation date, enrolment status, expiration date, renewal 
date, revision number, certificate subject, validity, and signing status.

Configuration Information—Shows configuration-related printer information, such as 
conformance, configuration name, and state.

Dates—Shows the last audit, last conformance check, last discovery, and the date the printer was 
added to the system.

Events—Shows event-related printer information.

Firmware—Shows firmware‑related information, such as the firmware version.

Identification—Shows information about the printer, such as the IP address, host name, and serial 
number.

Input Options—Shows information about the input options, such as the tray size and media type.

Options—Shows information about the printer options, such as hard disk and flash drive.

Printer Statistics—Shows information about the printer usage, such as the number of printed or 
scanned pages, and total number of faxed jobs.

Solutions—Shows the eSF applications installed on the printer, and their version numbers.

Status—Show the printer and supplies status.

Supplies—Shows supplies‑related information.

Printer Ports—Shows ports‑related information.

Note: An Unknown option in the port value means that either the port does not exist on the 
printer or MVE cannot retrieve the port.

Printer Security Options—Shows TLS and Cipher information.
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Click Create View.

Edit a view

From the Printers menu, click Views.

Select a view.

Click Edit, and then edit the settings.

Click Save Changes.

Copy a view

From the Printers menu, click Views.

Select a view.

Click Copy, and then configure the settings.

Click Create View.

Delete views

From the Printers menu, click Views.

Select one or more views.

Click Delete, and then confirm deletion.

Set a default view

From the Printers menu, click Views.

Select a view.

Click Set As Default.

The following views are system‑generated, and cannot be edited or deleted:

Configuration

Printer List

Event

Security

Service Desk

Standard

Changing the printer listing view
For more information, see Managing views on page 45.
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From the Printers menu, click Printer Listing.

Click Views, and then select a view.

Filtering printers using the search bar
Note the following when using the search bar to search for printers.

To search for an IP address, make sure to type the complete IP address or range.

For example:

10.195.10.1

10.195.10.3-10.195.10.255

10.195.*.*

2001:db8:0:0:0:0:2:1

If the search string is not a full IP address, then the printers are searched according to their host name, 
system name, or serial number.

The underscore character ( _ ) can be used as a wildcard character.

Managing keywords
Keywords let you create custom tags and assign them to printers.

From the Printers menu, click Keywords.

Do either of the following:

Add, edit, or delete a category.

Note: Categories group keywords together.

Add, edit, or delete a keyword.

For information on assigning keywords to printers, see Assigning keywords to printers on page 67.

Using saved searches

Understanding printer life cycle states

System-generated saved searches show the printers in the following printer life cycle states:

All Printers—All printers in the system.

Managed Printers—Printers that appear can be in any of the following states:

Managed (Normal)
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Managed (Changed)

Managed (Missing)

Managed (Found)

Managed (Changed) Printers—Printers in the system whose following properties were changed at the 
last audit:

Property tag

Host name

Contact name

Contact location

Memory size

Duplex

Supplies (excluding levels)

Input options

Output options

eSF applications

Default printer certificate

Managed (Found) Printers—Printers that were reported as missing, but have now been found.

Managed (Missing) Printers—Printers that the system was unable to communicate with.

Managed (Normal) Printers—Printers in the system whose properties have remained the same since the 
last audit.

New Printers—Printers that are newly discovered and are not set to a Managed state automatically.

Retired Printers—Printers marked as no longer active in the system.

Unmanaged Printers—Printers marked for exclusion from activities performed in the system.

Beginning state Ending state Transition

Start Normal Discovered.1

Start New Discovered.2

Any Normal, Unmanaged, or Retired Manual (Missing does not 
change to Normal).

Retired Normal Discovered.1

Retired New Discovered.2
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Beginning state Ending state Transition

Normal, Missing, or Found Changed New address when discovered.

Normal Changed Audit properties do not match 
the database properties.

Normal, Changed, or Found Missing Not found on audit or update 
status.

Changed Normal Audit properties match the 
database properties.

Missing Found Discovered, audit, or update 
status.

Found Normal Discovered, audit, or update 
status.

1 The "Automatically manage discovered printers" setting is enabled in the discovery profile.

2 The "Automatically manage discovered printers" setting is disabled in the discovery profile.

Running a saved search

A saved search is a saved set of parameters that returns the latest printer information that meets the parameters.

You can create and run a customized saved search, or run the default system‑generated saved searches. The 
system-generated saved searches show the printers in their life cycle states. For more information, see 
Understanding printer life cycle states on page 48.

From the Printers menu, click Printer Listing.

In the drop‑down menu, select a saved search.
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Creating a saved search

Using filters

From the Printers menu, click Printer Listing.

On the left side of the page, select the filters.

Note: The selected filters are listed above the search results header.

Click Save, and then type a unique name for your saved search and its description.

Click Create Saved Search.

Using the Saved Search page

From the Printers menu, click Saved Searches › Create.

From the General section, type a unique name for your saved search and its description.

From the Rules and Rule Groups section, in the Match menu, specify whether the search results must 
match all or any of the rules.

Do either of the following:
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Add a rule
Click Add Rule.

Specify the parameter, operation, and value for your search rule. For more information, see 
Understanding search rules settings on page 52.

Add a rule group

A rule group may contain a combination of rules. If the Match menu is set to ANY rules and rule groups, 
then the system searches for printers that match all the rules in the rule group. If the Match menu is set to 
ALL rules and rule groups, then the system searches for printers that match any of the rules in the rule 
group.

Click Add Rule Group.

Specify the parameter, operation, and value for your search rule. For more information, see 
Understanding search rules settings on page 52.

To add another rule, click Add Rule.

Click Create Saved Search or Create and Run Saved Search.

Understanding search rules settings

Parameter Description

Asset Tag The value of the asset tag setting on the printer.

Certificate Creation Date 1 The date that the certificate was created.

Certificate Enrollment Status 1 The enrollment status of the certificate.

Certificate Expiration Date 1 The date that the certificate expires.

Certificate Renewal Date 1 The date that the certificate is renewed.

Certificate Revision Number 1 The revision number of the certificate.

Certificate Signing Status 1 The status of the certificate.

Certificate Validity Status 1 The validity of the certificate.

Note: An Expiring Soon status indicates that the 
certificate expires within 30 days.

Color Capability The printer prints in color or in black and white.

Configuration The configuration name assigned to the printer.
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Parameter Description

Configuration Conformance The conformance status of the printer against the 
assigned configuration.

Contact Location The value of the contact location setting on the 
printer.

Contact Name The value of the contact name setting on the 
printer.

Copy The printer supports the copy function.

Date: Added to System The date that the printer was added to the system.

Date: Last Audited The date that the printer was last audited.

Date: Last Conformance Check The date that the printer configuration conformance 
was last checked.

Date: Last Discovered The date that the printer was last discovered.

Disk Encryption The printer is configured for disk encryption.

Disk Wiping The printer is configured for disk wiping.

Duplex The printer supports two-sided printing.

eSF Capability The printer supports managing eSF applications.

eSF Information The information about the eSF application installed 
on the printer, such as name, state, and version.

Event Name The name of the assigned events.

Fax Name The value of the fax name setting on the printer.

Fax Number The value of the fax number setting on the printer.

Fax Receive The printer supports receiving fax.

Firmware Information The information about the firmware installed on the 
printer.

Name—The name of the firmware. For 
example, Base or Kernel.

Version—The printer firmware version.

Host Name The printer host name.

IP Address The printer IP address.

Note: You can use an asterisk in the last three 
octets to search for multiple entries. For 
example, 123.123.123.*, 123.123.*.*, 123.*.*.*, 
2001:db8::2:1, and 2001:db8:0:0:0:0:2:1.

Keyword The assigned keywords.

Lifetime Page Count The lifetime page count value of the printer.

MAC Address The printer MAC address.
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Parameter Description

Maintenance Counter The value of the printer maintenance counter.

Manufacturer The printer manufacturer name.

Marking Technology The marking technology that the printer supports.

MFP Capability The printer is a multifunction product (MFP).

Model The printer model name.

Modular Serial Number The modular serial number.

Printer Status The printer status. For example, Ready, Paper 
Jam, Tray 1 Missing.

Printer Status Severity The value of the most severe status present on the 
printer. For example, Unknown, Ready, Warning, or 
Error.

Profile The printer supports profiles.

Scan to E-mail The printer supports Scan to E‑mail.

Scan to Fax The printer supports Scan to Fax.

Scan to Network The printer supports Scan to Network.

Secure Communication State The printer security or authentication state.

Serial Number The printer serial number.

State The current printer state in the database.

Supply Status The printer supplies status.

Supply Status Severity The value of the most severe supply status present 
on the printer. For example, Unknown, OK, 
Warning, or Error.

System Name The printer system name.

Time Zone The time zone of the region where the printer is 
located.

TLI The value of the TLI setting on the printer.

1Certificate-related parameters are applicable for the following device certificates:

Default

HTTPS

802.1x

IPSec

Use the following operators when searching for printers:

Exactly Matches—A parameter is equivalent to a specified value.

Is Not—A parameter is not equivalent to a specified value.

Contains—A parameter contains a specified value.

Does Not Contain—A parameter does not contain a specified value.
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Begins With—A parameter begins with a specified value.

Ends With—A parameter ends with a specified value.

Date

Older than—A parameter to search days before the days specified.

Within last—A parameter to search within days specified before today.

Within the next—A parameter to search within days specified after today.

Note: To search for printers that have parameters with empty values, use _EMPTY_OR_NULL_. For example, 
to search for printers that have empty Fax Name, in the Value field, type _EMPTY_OR_NULL_.

Managing saved searches

Edit a saved search

From the Printers menu, click Saved Searches.

Select a saved search, and then click Edit.

Note: System‑generated saved searches cannot be edited. For more information, see Understanding 
printer life cycle states on page 48.

Configure the settings.

Click Save Changes or Save and Run.

Copy a saved search

From the Printers menu, click Saved Searches.

Select a saved search, and then click Copy.

Configure the settings.

Click Create Saved Search or Create and Run Saved Search.

Delete saved searches

From the Printers menu, click Saved Searches.

Note: System‑generated saved searches cannot be deleted. For more information, see 
conkeyref="xref/understanding-printer-life-cycle-states"/>.

Select one or more saved searches.

Click Delete, and then confirm deletion.
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Sample scenario: Monitoring the toner levels of 
your fleet

As the IT personnel of Company ABC, you must organize the printer fleet to monitor them easily. You want to 
monitor the toner usage of the printers to determine whether the supplies need replacement.
Sample implementation

Create a saved search that retrieves the printers whose supplies have errors or warnings.

Sample rule for your saved search

Parameter: Supply Status Severity
Operation: Is Not
Value: Supplies OK

Create a view that shows the supply status, capacity, and level for each printer.

Sample columns to show in your supplies view

Supply Status
Black Cartridge Capacity
Black Cartridge Level
Cyan Cartridge Capacity
Cyan Cartridge Level
Magenta Cartridge Capacity
Magenta Cartridge Level
Yellow Cartridge Capacity
Yellow Cartridge Level

Run the saved search while using the view.

Notes
The information shown in the printer listing view is based on the last audit. Perform an audit and status 
update to get the current printer status.
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Understanding printer security states
During discovery, the printer can be in any of the following security states:

Unsecured—MVE does not need credentials to communicate with the device.

 Secured—MVE needs credentials and they were provided.

 Missing credentials—MVE needs credentials but they were not provided.

 Invalid credentials—MVE needs credentials but incorrect credentials were provided.

A printer is in the Invalid credentials state when the credentials are found to be invalid during discovery, audit, 
status update, conformance check, or configuration enforcement.
The printer is in an Unsecured state only when it does not require credentials during discovery.
To change the status from Unsecured to Secured, enforce a secured configuration.
To move a printer from the Missing credentials or Invalid credentials state, enter the credentials in MVE manually 
or create a configuration from the printer.

Securing printers using the default 
configurations

On some printer models, there is no default administrator user. The Guest user has open access and is not 
logged in. This setup grants the user access to all printer permissions and access controls. MVE handles this risk 
through default configurations. After a fresh installation, two advanced security components are created 
automatically. Each component contains the default security settings and preconfigured local administrator 
account. You can use these security components when creating a configuration, and then deploy and enforce the 
configuration to the new printers.
From the Configurations menu, click All Advanced Security Components.

Securing printer communications
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Simple account-based authentication

This security component contains a User Name/Password Local Account called admin.

The admin account is a member of the Admin Group, whose permissions include function access controls and 
permissions to secure the printer and restrict public access. For more information, see .Understanding 
permissions and function access controls on page 59

Before adding this component to a configuration, make sure to set the admin password and the printer 
credentials.

Simple template-based authentication

This security component contains a security template called Admin Password Protected that is configured with a 
Password Local Account.

This security template is applied to the following access controls:

Firmware Updates

Remote Management

Security Menu remotely

The remaining access controls are set to No Security. However, you can always set the other administrative 
printer menus to use the security template for more protection. For more information on the access controls, 
see .Understanding permissions and function access controls on page 59

Before adding this component to a configuration, make sure to set the password and the printer credentials.
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Understanding permissions and function access 
controls

Printers can be configured to restrict public access to administrative menus and device management features. In 
newer printer models, permissions to access printer functions can be secured through different types of 
authentication methods. In older printer models, a security template can be applied to a function access control 
(FAC).
To communicate with these secured printers and manage them, MVE requires certain permissions or FACs, 
depending on the printer model.
The following table explains what printer management functions can be managed in MVE and what permissions 
or FACs are required.
Note that MVE requires the authentication credentials when Remote Management is secured. If other 
administrative menus and device management permissions or FACs are secured, then Remote Management 
must also be secured. Otherwise, MVE cannot perform the functions.
These permissions and function access controls are predefined in MVE as default advanced security 
components, and can readily be used in a configuration. For more information, see .Securing printers using the 
default configurations on page 57
If you are not using the default advanced security components, then make sure that these permissions and 
function access controls are configured in the printer manually. For more information, see .Configuring printer 
security on page 60
Permissions or FACs Description

Remote Management The ability to read and write settings remotely. If 
any other permissions or FACs listed in this table 
are secured, then Remote Management must also 
be secured.

Firmware Updates The ability to update firmware from any method.

Apps Configuration The ability to install or remove applications from the 
printer and send application settings files to the 
printer.

Import / Export All Settings

or

Configuration File Import / Export

The ability to send configuration files to the printer.

Security Menu

or

Security Menu Remotely

The ability to manage login methods and configure 
printer security options.

To secure newer printer models in MVE, disable public access for the Remote Management and Security Menu 
permissions. For older printer models, apply a security template to the Remote Management FAC.
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Configuring printer security

For newer printer models

From the Printers menu, click Printer Listing.

Click the IP address of the printer, and then click Open Embedded Web Server.

Click Settings or Configuration.

Click Security › Login Methods .

From the Security  section, create a login method.

Click Manage Group/Permissions or Manage Permissions beside the login method.

Expand Administrative Menus, and then select Security Menu.

Expand Device Management, and then select the following permissions:
Remote Management

Firmware Updates

Apps Configuration

Import / Export All Settings

Click Save.

From the Public section, click Manage Permissions.

Expand Administrative Menus, and then clear Security Menu.

Expand Device Management, and then clear Remote Management.

Click Save.

For older printer models

From the Printers menu, click Printer Listing.

Click the IP address of the printer, and then click Open Embedded Web Server.

Click Settings or Configuration.

Click Security  › Security Setup or Edit Security Setup.

From the Advanced Security Setup section, create a building block and a security template.

Click Access Controls, and then expand Administrative Menus.

In the Security Menu Remotely menu, select the security template.

Expand Management, and then select the security template for the following function access controls:
Apps Configuration

Remote Management

Firmware Updates

Configuration File Import / Export

Click Submit.
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Securing printer communications on your fleet
Discover a secured printer. For more information, see Discovering printers chapter.

Notes

A printer is secured when  appears next to it. For information on securing a printer, see the 
help document.

For more information on printer security states, see Understanding printer security states on 
page 57.

Create a configuration from a printer. For more information, see Creating a configuration from a printer on 
page 72.

Assign the configuration to your fleet. For more information, see Assigning configurations to printers on 
page 63.

Enforce the configuration. For more information, see Enforcing configurations on page 64. A padlock 
symbol appears next to the secured printer.

Other ways to secure your printers
For more information on configuring printer security settings, see the Embedded Web Server Administrator's 
Guide for your printer.
Check your printers for the following settings:

Disk encryption is enabled.

The following ports are restricted:

TCP 79 (Finger)

TCP 21 (FTP)

UDP 69 (TFTP)

TCP 5001 (IPDS)

TCP 9600 (IPDS)

TCP 10000 (Telnet)

The default cipher list is the OWASP Cipher String ‘B.’

http://support.lexmark.com/index?page=content&clearQuestion=Y&id=FA1301&locale=en&userlocale=EN_US&segment=SUPPORT&productCode=
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Restarting the printer
From the Printers menu, click Printer Listing.

Click the IP address of the printer.

Click Restart Printer.

Viewing the printer Embedded Web Server
The Embedded Web Server is a software built into the printer that provides a control panel for configuring the 
printer from any web browser.

From the Printers menu, click Printer Listing.

Click the IP address of the printer.

Click Open Embedded Web Server.

Auditing printers
An audit collects information from any printers in the Managed state, and then stores the information in the 
system. To make sure that the information in the system is current, perform an audit regularly.

From the Printers menu, click Printer Listing.

Select one or more printers.

Click Printer > Audit.

Note: An audit can be scheduled to occur regularly. For more information, see Creating a schedule on page 
153.

Updating printer status
The Update Status feature lets you update the printer status and supplies information. To make sure that the 
printer status and supplies information is current, update the status regularly.

From the Printers menu, click Printer Listing.

Select one or more printers.

Click Printer > Update status.

Managing printers
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Note: A status update can be scheduled to occur regularly. For more information, see Creating a schedule on 
page 153.

Setting the printer state
For more information on the printer states, see Understanding printer life cycle states on page 48.

From the Printers menu, click Printer Listing.

Select one or more printers.

Click Printer, and then select one of the following:

Set state to managed—The printer is included in all activities that can be performed in the system.

Set state to unmanaged—The printer is excluded in all activities that can be performed in the 
system.

Set state to retired—The printer is removed from the network. The system retains the printer 
information, but does not expect to see the printer on the network again.

Assigning configurations to printers
Before you begin, make sure that a configuration for the printer is created. Assigning a configuration to a printer 
allows the system to run conformance checks and enforcements. For more information, see Creating a 
configuration on page 70.

From the Printers menu, click Printer Listing.

Select one or more printers.

Click Configure > Assign configurations.

From the Configuration section, select a configuration.

Note: If the system is set to Use Markvision to manage device certificates, then select Trust the 
selected devices. This confirmation is the way for the user to verify that the printers are real devices 
and not spoofed.

Click Assign Configurations.

Unassigning configurations
From the Printers menu, click Printer Listing.

Select one or more printers.

Click Configure > Unassign configurations.

Click Unassign Configurations.
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Enforcing configurations
MVE runs a conformance check against the printer. If some settings are out of conformance, then MVE changes 
those settings on the printer. MVE runs a final conformance check after changing the settings. Updates that 
require the printer to reboot, such as firmware updates, may require a second enforcement to complete.

Before you begin, make sure that a configuration is assigned to the printer. For more information, see Assigning 
configurations to printers on page 63.

From the Printers menu, click Printer Listing.

Select one or more printers.

Click Configure > Enforce configurations.

Notes

If the printer is in an error state, then some settings may not be updated.

For MVE to deploy firmware and solution files to a printer, the Firmware Updates function access 
control must be set to No Security. If security is applied, then the Firmware Updates function access 
control must use the same security template as the Remote Management function access control. For 
more information, see Deploying files to printers on page 64.

An enforcement can be scheduled to occur regularly. For more information, see Creating a schedule on 
page 153.

Checking the printer conformance with a 
configuration

During a conformance check, MVE checks the printer settings, and verifies whether they match the assigned 
configuration. MVE does not make changes to the printer during this operation.

Before you begin, make sure that a configuration is assigned to the printer. For more information, see .Assigning 
configurations to printers on page 63

From the Printers menu, click Printer Listing.

Select one or more printers.

Click Configure > Check conformance.

Notes
You can view the results in the task status page.

A conformance check can be scheduled to occur regularly. For more information, see .Creating 
a schedule on page 153

Deploying files to printers
You can deploy the following files to the printer:
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CA Certificates—.cer or .pem files that are added to the printer trust store.

Configuration bundle—.zip files that are exported from a supported printer or obtained directly from 
Lexmark.

Firmware update—An .fls file that is flashed to the printer.

Generic file—Any file that you want to send to the printer.

Raw socket—Sent over port 9100. The printer treats it like any other print data.

FTP—Send file over FTP. This deployment method is not supported on secured printers.

Printer certificate—A signed certificate that is installed on the printer as the default certificate.

Universal Configuration File (UCF)—A configuration file exported from a printer.

Web service—The HTTPS web service is used when the printer model supports it. Otherwise, the 
printer uses the HTTP web service.

FTP—Send file over FTP. This deployment method is not supported on secured printers.

From the Printers menu, click Printer Listing.

Select one or more printers.

Click Configure > Deploy file to printers.

Click Choose File, and then browse to the file.

Select a file type, and then select a deployment method.

Click Deploy File.

Notes

For MVE to deploy firmware and solution files to a printer, the Firmware Updates function access 
control must be set to No Security. If security is applied, then the Firmware Updates function access 
control must use the same security template as the Remote Management function access control.

A file deployment can be scheduled to occur regularly. For more information, see Creating a schedule
on page 153.

Updating the printer firmware
From the Printers menu, click Printer Listing.

Select one or more printers.

Click Configure > Update firmware to printers.

Select a firmware file from the resource library, or click Choose File, and then browse to the firmware file.

Note: For more information on adding firmware files to the library, see Importing files to the resource 
library on page 76.
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If necessary, to schedule the update, select Define update window, and then select the start date, start 
and pause time, and days of the week.

Note: The firmware is sent to the printers within the specified start time and pause time. The task is 
paused after the pause time, and then resumes at the next start time until it is completed.

Click Update Firmware.

Note: For MVE to update the printer firmware, the Firmware Updates function access control must be set to 
No Security. If security is applied, then the Firmware Updates function access control must use the same 
security template as the Remote Management function access control. In this case, MVE must manage the 
printer securely. For more information, see Securing printer communications chapter.

Uninstalling applications from printers
MVE can uninstall only applications that have been added to the system in the Package Builder format. For more 
information on uploading applications to the system, see Importing files to the resource library on page 76.

From the Printers menu, click Printer Listing.

Select one or more printers.

Click Configure > Uninstall Apps from printers.

Select the applications.

Click Uninstall Apps.

Assigning events to printers
Assigning events to printers lets MVE perform the associated action whenever one of the associated alerts 
occurs on the assigned printer. For more information on creating events, see "Managing printer alerts" chapter.

Note: Events can be assigned only to unsecured printers.

From the Printers menu, click Printer Listing.

Select one or more printers.

Click Assign > Events.

Select one or more events.

Note: If some of the selected printers already have the event assigned to them, then a dash in the 
check box appears. If you leave it as a dash, then the event does not change. If you select the check 
box, then the event is assigned to all the selected printers. If you clear the check box, then the event is 
unassigned from the printers it was previously assigned to.

Click Assign Events.
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Assigning keywords to printers
Assigning keywords to printers lets you organize your printers. For more information on creating keywords, see 
Managing keywords on page 48.

From the Printers menu, click Printer Listing.

Select one or more printers.

Click Assign > Keywords.

If necessary, in the View menu, select a category.

Select one or more keywords.

Note: Keywords are listed following a category. If some of the selected printers already have the 
keyword assigned to them, then a dash in the check box appears. If you leave it as a dash, then the 
keyword is not assigned or unassigned to the selected printers. If you select the check box, then the 
keyword is assigned to all the selected printers. If you clear the check box, then the keyword is 
unassigned from the printers it was previously assigned to.

Click Assign Keywords.

Entering credentials to secured printers
Secured printers can be discovered and enrolled. To communicate with these printers, you can either enforce a 
configuration or enter the credentials in MVE directly.

Note: A printer is secured when a  appears next to it.

To enter the credentials, do the following:

From the Printers menu, click Printer Listing.

Select one or more secured printers.

Click Security > Enter Credentials.

Select the authentication method, and then enter the credentials.

Click Enter Credentials.

Note: Enrolled printers that are secured but do not have the correct credentials saved in MVE are tagged as 
Missing credentials under the Communications filter. After the correct credentials are entered, the printers are 
tagged as Secured.

Configuring default printer certificates manually
When not using the automated certificate management feature, MVE can help facilitate the process of signing the 
default printer certificate on a fleet of printers. MVE gathers the certificate‑signing requests from the fleet, and 
then deploys the signed certificates to the proper printers after they are signed.
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A system administrator must do the following:

Generate the printer certificate‑signing requests.

Notes
You can select one or more printers when generating certificate-signing requests, but only one set of 
requests can exist at a time. To avoid overwriting any existing certificate-signing requests, you must 
download the certificate-signing requests before generating another set.

From the Printers menu, click Printer Listing.

Select one or more printers.

Click Security > Generate printer certificate signing requests.

Notes
You can select one or more printers when generating certificate-signing requests, but only one set of 
requests can exist at a time. To avoid overwriting any existing certificate-signing requests, you must 
download the certificate-signing requests before generating another set.

Wait for the task to finish, and then download the printer certificate‑signing requests.
From the Printers menu, click Printer Listing.

Click Security > Download printer certificate signing requests.

Use a trusted CA to sign the certificate‑signing requests.

Save the signed certificates in a ZIP file.

Notes
All the signed certificates must be in the root location of the ZIP file. Otherwise, MVE cannot parse the 
file.

From the Printers menu, click Printer Listing.

Select one or more printers.

Click Configure > Deploy file to printers.

Click Choose File, and then browse to the ZIP file.

In the File type menu, select Printer Certificates.

Click Deploy File.

Removing printers
From the Printers menu, click Printer Listing.

Select one or more printers.

Click Printer.

If necessary, to remove the printer certificate, select Delete associated device certificate(s).
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Note: If MVE is managing the device certificates, then removing the printer certificate deletes the 
default certificate from the printer. The printer then generates a new self-signed certificate.

Do either of the following:

To retain the printer information, click Retire Printer.

To remove the printer from the system, click Delete Printer.
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Overview
MVE uses configurations to manage the printers in your fleet.
A configuration is a collection of settings that can be assigned and enforced to a printer or a group of printer 
models. Within a configuration, you can modify printer settings and deploy applications, licenses, firmware, and 
printer certificates.
You can create a configuration that is composed of the following:

Basic printer settings

Advanced security settings

Color print permissions

Note: This setting is available only in configurations for supported color printers.

Printer firmware

Applications

CA certificates

Resource Files

Using configurations, you can do the following to manage the printers:

Assign a configuration to printers.

Enforce the configuration to the printers. The settings that are specified in the configuration are applied to 
the printers. The firmware, applications, printer certificate, application files (.fls), and CA certificates are 
installed.

Check whether the printers are in conformance against a configuration. If a printer is out of conformance, 
then the configuration can be enforced to the printer.

Note: Configuration enforcement and conformance checking can be scheduled to occur regularly.

If the printer supports the configuration settings but the values are not applicable, then the printer shows 
as out of conformance.

Creating a configuration
A configuration is a collection of settings that can be assigned and enforced to a printer or a group of printers. 
Within a configuration, you can modify printer settings and deploy applications, licenses, firmware, and CA 
certificates to printers.

From the Configurations menu, click All Configurations > Create.

Type a unique name for the configuration and its description.

In the Setting list, do one or more of the following:

Managing configurations
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From the Basic tab, select one or more settings, and then specify the values. If the value is a 
variable setting, then enclose the header with ${}. For example, ${Contact_Name}. To use a 
variable setting file, select the file from the Use variable setting data file menu, or import the file. 
For more information, see Understanding variable settings on page 74.

Select one or more settings, and then specify the values. If the value is a variable setting, 
then enclose the header with ${}. For example, ${Contact_Name}. To use a variable setting 
file, select the file from the Use variable setting data file menu, or import the file. For more 
information, see Understanding variable settings on page 74.

If one or more certificates are added to this configuration, you can select any of the 
certificates from the Value drop‑down menu.

From the Advanced Security tab, select an advanced security component.

Notes
To create an advanced security component, see Creating an advanced security 
component from a printer on page 73.

You can manage the advanced security settings only when creating a configuration from 
a selected printer. For more information, see Creating a configuration from a printer on 
page 72.

From the Color Print Permissions tab, configure the settings. For more information, see Configuring 
the color print permissions on page 75.

Note: This setting is available only in configurations for supported color printers.

From the Firmware tab, select a firmware file. If multiple versions of the same firmware are present 
in a configuration, only the higher firmware version is considered during conformance and 
enforcement. To import a firmware file, see Importing files to the resource library on page 76.

From the Apps tab, select one or more applications to deploy. For more information, see Creating 
an applications package on page 75.

Note: MVE does not support deploying applications with trial licenses. You can deploy only free 
applications or applications with production licenses.

From the Certificates tab, select one or more certificates to deploy. To import a certificate file, see 
Importing files to the resource library on page 76.

Note: Select Use Markvision to manage device certificates for MVE to assess missing, 
invalid, revoked, and expired certificates, and then replace them automatically.
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Select either of the following options:

Default Device Certificate

Named Device Certificate

Note: By default, a user can add 10 named certificates per MVE installation and 5 named 
certificates per MVE configuration.

Note: For more information, see Configuring MVE for automated certificate management on 
page 78.

From the Resource Files tab, select any of the following file types to deploy:

Application file (.fls)

Configuration bundle (.zip)

Universal configuration file (.ucf)

Notes
Any option under the resource tab is not conformance checked.

We do not recommend using multiple UCF and configuration bundles in a single 
configuration.

This method is not applicable to UCF files when configuring scan to network on legacy 
printers. UCF files must be deployed using the Deploy file to printer action.

Click Create Configuration.

Note: The following list shows the deployment sequence in a configuration:

CA Certificates

Application Files

Solution Packages

Advanced Security

Device Certificates

Basic Settings

UCF and configuration bundle

Firmware

Creating a configuration from a printer
The following components are not included:

Printer firmware

Applications

Certificates
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To add the firmware, applications, and certificates, edit the configuration in MVE.

From the Printers menu, click Printer Listing.

Select the printer, and then click Configure > Create configuration from printer.

If necessary, select Include advanced security settings to create an advanced security component from 
the selected printer.

If the printer is secured, then select the authentication method, and then enter the credentials.

Type a unique name for the configuration and its description, and then click Create Configuration.

From the Configurations menu, click All Configurations.

Select the configuration, and then click Edit.

If necessary, edit the settings.

Click Save Changes.

Sample scenario: Cloning a configuration
Fifteen Lexmark MX812 printers were added to the system after discovery. As the IT personnel, you must apply 
the settings of the existing printers to the newly discovered printers.

Note: You can also clone a configuration from a printer, and then enforce the configuration to a group of printer 
models.

Sample implementation

From the existing printers list, select a Lexmark MX812 printer.

Create a configuration from the printer.

Note: To secure the printers, include the advanced security settings.

Assign, and then enforce the configuration to the newly discovered printers.

Creating an advanced security component from a 
printer

Create an advanced security component from a printer to manage the advanced security settings. MVE reads all 
the settings from that printer, and then creates a component that includes the settings. The component can be 
associated to multiple configurations for printer models that have the same security framework.

From the Printers menu, click Printer Listing.

Select the printer, and then click Configure > Create advanced security component from printer.

Type a unique name for the component and its description.

If the printer is secured, then select the authentication method, and then enter the credentials.

Click Create Component.
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Notes
When you create and enforce a configuration with an advanced security component that contains local 
accounts, the local accounts are added to the printers. Any existing local accounts that are preconfigured in 
the printer are retained.

Generating a printable version of the 
configuration settings

Edit a configuration or advanced security component.

Click Printer‑friendly version.

Understanding dynamic settings
These settings include 802.1x Device Certificate, HTTPS Device Certificate, and IPSec Device Certificate 
which are listed under the Basic tab of a configuration.

The options for each of these settings are populated with the certificates selected in the Certificate tab.

When you clone, export, or import a configuration, the preselected values of these settings are cleared. 
You must select the values manually.

Understanding variable settings
Variable settings let you manage settings across your fleet that are unique to each printer, such as host name or 
asset tag. When creating or editing a configuration, you can select a CSV file to be associated with the 
configuration.
Sample CSV format:

IP_ADDRESS,Contact_Name,Address,Disp_Info

1.2.3.4,John Doe,1600 Penn. Ave., Blue

4.3.2.1,Jane Doe,1601 Penn. Ave., Red

2.3.6.5,"Joe, Jane and Douglas",1601 Penn. Ave.,Yellow

2.3.6.7,"Joe, Jane and Douglas",1600 Penn. Ave.,He is 6’7” tall

In the header row of the variable file, the first column is a unique printer identifier token. The token must be one of 
the following:

HOSTNAME

IP_ADDRESS

SYSTEM_NAME

SERIAL_NUMBER

Each subsequent column in the header row of the variable file is a user‑defined replacement token. This token 
must be referenced within the configuration using the ${HEADER} format. It is replaced with the values in the 
subsequent rows when the configuration is enforced. Make sure that the tokens do not contain any spaces.
You can import the CSV file containing the variable settings when creating or editing a configuration. For more 
information, see Creating a configuration on page 70.
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Configuring the color print permissions
MVE lets you restrict color printing for host computers and specific users.

Note: This setting is available only in configurations for supported color printers.

From the Configurations menu, click All Configurations.

Create or edit a configuration.

From the Color Print Permissions tab, do either of the following:

Configure the color print permissions for host 
computers

In the View menu, select Host computers, and then select Include color print permissions for host 
computers.

Click Add, and then type the host computer name.

To let the host computer print in color, select Allow color printing.

To let users that log in to the host computer print in color, select Override user permission.

Click Save and Add or Save.

Configure the color print permissions for users

In the View menu, select Users, and then select Include color print permissions for users.

Click Add, and then type the user name.

Select Allow color printing.

Click Save and Add or Save.

Creating an applications package
Log in to Package Builder at iss.lexmark.com/cdp/package-builder.

From the Packages page, click Create package.

From the Create Package page, enter the package name.

Click Add Product, select a product, and then click Add Product.

If necessary, select Redeem an activation code for licensed product.

Click Create Package.

Download the package by doing either of the following:

Click the package name, and then click Download.

In the Download Package column, click Download.

https://iss.lexmark.com/cdp/package-builder
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Notes

MVE does not support deploying applications with trial licenses. You can deploy only free applications 
or applications with production licenses. If you need activation codes, then contact your Lexmark 
representative.

To add the applications to a configuration, import the applications package to the resource library. For 
more information, see Importing files to the resource library on page 76.

Importing or exporting a configuration
Before you begin importing a configuration file, make sure that it is exported from the same version of MVE.

From the Configurations menu, click All Configurations.

Do either of the following:

To import a configuration file, click Import, browse to the configuration file, and then click Import.

To export a configuration file, select a configuration, and then click Export.

Notes
When you export a configuration, the passwords are excluded. After importing, manually add the 
passwords.

UCF, configuration bundles, and application files are not part of an exported configuration.

Importing files to the resource library
The resource library is a collection of firmware files, CA certificates, and application packages that are imported to 
MVE. These files can be associated with one or more configurations.

From the Configurations menu, click Resource Library.

Click Import > Choose File, and then browse to the file.

Notes
Only firmware files (FLS), application files (FLS), application packages or configuration bundles 
(ZIP), CA certificates (PEM), and universal configuration files (UCF) can be imported.

MVE cannot import CA certificates exported from Windows in the DER‑encoded binary format. 
Exporting these certificates requires a PEM-formatted certificate, which is Base64‑encoded text.

Click Import Resource.
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Setting up MVE to manage certificates 
automatically

Understanding the automated certificate management 
feature

You can configure MVE to manage printer certificates automatically, and then install them to the printers through 
configuration enforcement. The following diagram describes the end-to-end process of the automated certificate 
management feature.

The certificate authority endpoints, such as the CA server and server address, must be defined in MVE.
The following CA servers are supported:

OpenXPKI CA—Users can use either of the following protocols:

Secure Certificate Encryption Protocol (SCEP)

EST Connector

Notes
EST is the recommended way to connect to the OpenXPKI server.

For more information on configuring OpenXPKI CA using EST protocol, see
Invalid

For more information on configuring OpenXPKI CA using SCEP protocol, see
Invalid

Managing certificates
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Microsoft CA Enterprise—Users can use either of the following protocols

Secure Certificate Encryption Protocol (SCEP)

Microsoft Certificate Enrollment Web Services (MSCEWS)

Notes
MSCEWS is the recommended way to connect to the Microsoft CA Enterprise server.

For more information on configuring Microsoft CA using MSCEWS protocol, see
Invalid

For more information on configuring Microsoft CA using SCEP protocol, see
Invalid

The connection between MVE and the CA servers must be validated. During validation, MVE communicates with 
the CA server to download the certificate chain and the Certificate Revocation List (CRL). The enrollment agent 
certificate or test certificate is also generated. This certificate enables the CA server to trust MVE.
For more information on defining the endpoints and validation, see .Configuring MVE for automated certificate 
management on page 78
A configuration that is set to Use Markvision to manage device certificates must be assigned and enforced to 
the printer.
For more information, see the following topics:

Creating a configuration on page 70

Enforcing configurations on page 64

During enforcement, MVE checks the printer for conformance.
For Default Device Certificate

The certificate is validated against the certificate chain downloaded from the CA server.

If the printer is out of conformance, a Certificate Signing Request (CSR) is raised for the printer.

For Named Device Certificate

The certificate is validated against the certificate chain downloaded from the CA server.

MVE creates a self-signed named device certificate on the device.

If the printer is out of conformance, a CSR is raised for the printer.

Notes

MVE communicates with the CA server using the configured protocols.

The CA server generates the new certificate, and then MVE sends the certificate to the printer.

If a named certificate exists in the printer, then a new named certificate is not created, but a CSR is 
raised for the printer.

Configuring MVE for automated certificate management

Click  on the upper‑right corner of the page.

Click Certificate Authority > Use Certificate Authority Server.
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Notes
The Use Certificate Authority Server button appears only when configuring the certificate authority for 
the first time, or when the certificate is deleted.

Configure the server endpoints.

CA Server—The Certificate Authority (CA) server that generates the printer certificates. You can 
select either of the following:

OpenXPKI CA

Microsoft CA- Enterprise

Notes
User can also configure a CA server which supports the Enrollment over Secure Transport 
(EST) protocol.

The CA server must implement the EST protocol as defined in RFC 7030.

Notes
Any deviation from the specification may result in an invalid setup.

EST is the recommended protocol to connect to the OpenXPKI CA server.

Notes
Microsoft CA Enterprise server does not support the EST protocol.

CA Server Address—The IP address or host name of your CA server. This field is only applicable 
for SCEP and EST protocols.

Notes
Type any of the following:

For MSCA server (using SCEP): <Server IP Address or Hostname>/certsrv/mscep/mscep.dll

For OpenXPKI server (using SCEP): <Server IP Address or Hostname>/scep/scep

For EST, type any of the following:

https://172.87.95.240

https://estserver.com

estserver.com

CA Server Label (Optional)— If the user creates a new realm, then the same realm name must be 
put in this field.

CEP Server Address— This field is only applicable for the MSCEWS protocol.

Notes
Type any of the following:

For Username and Password Authentication: https://democep.com/
ADPolicyProvider_CEP_UsernamePassword/service.svc/CEP
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For Windows Integrated Authentication: https://democep.com/
ADPolicyProvider_CEP_Kerberos/service.svc/CEP

For Client Certificate Authentication: https://democep.com/
ADPolicyProvider_CEP_Certificate/service.svc/CEP

CA Server Hostname—The host name of your CA server.

Notes
For example, for MSCEWS protocol, user may select democa.lexmark.com

CN of CA Certificate—The common name of the CA certificate.

CES Server Hostname—The host name of your CES server.

Notes
For example, for MSCEWS protocol, user may select democes.lexmark.com

Challenge Password—Challenge Password is required to assert the identity of MVE to the CA 
server. This password is only required for OpenXPKI CA. It is not supported in Microsoft CA 
Enterprise.

Notes
Depending on your CA server, you must configure the server authentication mode. Do either of the 
following:

If you select EST protocol, then from the CA Server Authentication Mode menu, select any of the 
following:

Username and Password Authentication

Client Certificate Authentication

If you select MSCEWS protocol, then from the CA Server Authentication Mode menu, select any 
of the following:

Username and Password Authentication

Client Certificate Authentication

Windows Integrated Authentication

SCEP protocol only supports the Challenge Password authentication mode.

Notes
Depending on your CA server, see any of the sections:

"Managing certificates using OpenXPKI Certificate Authority through SCEP" group

"Managing certificates using Microsoft Certificate Authority through SCEP" group

"Managing certificates using Microsoft Certificate Authority through MSCEWS" group

"Managing certificates using OpenXPKI Certificate Authority through EST" group

Click Save Changes and Validate > OK.
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Notes
The Discard Changes option only works if the changes are not yet saved or saved and 
validated.

User cannot recover data from an invalid configuration as MVE does not store the last valid state 
of any configuration. MVE only stores one single certificate configuration at a time, which may or 
may not be valid.

Notes
The connection between MVE and the CA servers must be validated. During validation, MVE 
communicates with the CA server to download the certificate chain and the Certificate 
Revocation List (CRL). The enrollment agent certificate or test certificate is also generated. This 
certificate enables the CA server to trust MVE.

You can select one or multiple CEP templates when using MSCEWS protocol. Do the following:

After clicking Save Changes and Validate, the CEP Template Selection window appears.

Select one or more from the available templates.

The Use Certificate Authority Server dialog fetches the certificate revocation list.

A dialog confirms that certificate validation is successful.

You can see the selected CEP templates in the CA server configuration page.

Notes
When you enforce this configuration to any device, a certificate is created according to the selected 
template.

Navigate back to the System Configuration page, and then review the CA certificate.

Notes
You can also download or delete the CA certificate.

Configuring Microsoft Enterprise CA with NDES

Overview

In the following deployment scenario, all permissions are based on permissions set on certificate templates that 
are published in the domain controller. The certificate requests sent to the CA are based on certificate templates.
For this setup, make sure that you have the following:

A machine hosting the subordinate CA

A machine hosting the NDES service

A domain controller

Required users
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Create the following users in the domain controller:

Service Administrator

Named as SCEPAdmin

Must be a member of the local admin and Enterprise Admin groups

Must be logged locally when the installation of NDES role is triggered

Has Enroll permission for the certificate templates

Has Add template permission on CA

Service Account

Named as SCEPSvc

Must be member of the local IIS_IUSRS group

Must be a domain user and has read and enroll permissions on the configured templates

Has request permission on CA

Enterprise CA Administrator

Named as CAAdmin

Member of Enterprise Admin group

Must be a part of the local admin group

Managing certificates using Microsoft Certificate 
Authority through SCEP

This section provides information on configuring Certificate Enrollment Policy Web Service (CEP) and Certificate 
Enrollment Web Service (CES). As Microsoft recommends installing CEP and CES in two different machines, we 
are following the same in this document. We refer to these web services as CEP server and CES server, 
respectively.

Note: The user must have a preconfigured Enterprise Certificate Authority (CA) and a domain controller.

Overview

The root CA server is the main CA server in any organization, and is the top of the PKI infrastructure. The root CA 
authenticates the subordinate CA server. This server is generally kept in offline mode to prevent any intrusion and 
to secure the private key.
To configure the root CA server, do the following:

Make sure that the root CA server is installed. For more information, see Installing the root CA server on 
page 83.

Configure the Certification Distribution Point and Authority Information Access settings. For more 
information, see Configuring the Certification Distribution Point and Authority Information Access settings
on page 85.

Configure the CRL accessibility. For more information, see Configuring CRL accessibility on page 112.
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Installing the root CA server

From Server Manager, click Manage › Add Roles and Feature.

Click Server Roles, select Active Directory Certificate Services and all its features, and then click Next.

From the AD CS Role Services section, select Certification Authority, and then click Next › Install.

After installation, click Configure Active Directory Certificate Services on the destination server.

From the Role Services section, select Certification Authority › Next.

From the Setup Type section, select Standalone CA, and then click Next.

From the CA Type section, select Root CA, and then click Next.

Select Create a new private key, and then click Next.

From the Select a cryptographer provider menu, select RSA#Microsoft Software Key Storage Provider.

From the Key length menu, select 4096.

In the hash algorithm list, select SHA512, and then click Next.

In the Common name for this CA field, type the hosting server name.

In the Distinguished name suffix field, type the domain component.

Sample CA name configuration

Machine Fully Qualified Domain Name (FQDN): test.dev.lexmark.com
Common Name (CN): TEST
Distinguished name suffix: DC=DEV,DC=LEXMARK,DC=COM

Click Next.

Specify the validity period, and then click Next.

Note: Generally, the validity period is 10 years.

Do not change anything in the database locations window.

Complete the installation.

Configuring Microsoft Enterprise CA with NDES

Overview

In the following deployment scenario, all permissions are based on permissions set on certificate templates that 
are published in the domain controller. The certificate requests sent to the CA are based on certificate templates.
For this setup, make sure that you have the following:

A machine hosting the subordinate CA

A machine hosting the NDES service

A domain controller

Required users
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Create the following users in the domain controller:

Service Administrator

Named as SCEPAdmin

Must be a member of the local admin and Enterprise Admin groups

Must be logged locally when the installation of NDES role is triggered

Has Enroll permission for the certificate templates

Has Add template permission on CA

Service Account

Named as SCEPSvc

Must be member of the local IIS_IUSRS group

Must be a domain user and has read and enroll permissions on the configured templates

Has request permission on CA

Configuring subordinate CA server

Overview

The subordinate CA server is the intermediate CA server and is always online. It generally handles the 
management of certificates.
To configure the subordinate CA server, do the following:

Make sure that the subordinate CA server is installed. For more information, see Installing the subordinate 
CA server on page 84.

Configure the Certification Distribution Point and Authority Information Access settings. For more 
information, see Configuring the Certification Distribution Point and Authority Information Access settings
on page 85.

Configure the CRL accessibility. For more information, see Configuring CRL accessibility on page 112.

Installing the subordinate CA server

From the server, log in as a CAAdmin domain user.

From Server Manager, click Manage › Add Roles and Feature.

Click Server Roles, select Active Directory Certificate Services and all its features, and then click Next.

From the AD CS Role Services section, select Certification Authority and Certificate Authority Web 
Enrollment, and then click Next.

Note: Make sure that all the features of Certificate Authority Web Enrollment are added.

From the Web Server Role (IIS) Role Services section, retain the default settings.

After installation, click Configure Active Directory Certificate Services on the destination server.
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From the Role Services section, select Certification Authority and Certificate Authority Web 
Enrollment, and then click Next.

From the Setup Type section, select Enterprise CA, and then click Next.

From the CA Type section, select Subordinate CA, and then click Next.

Select Create a new private key, and then click Next.

From the Select a cryptographer provider menu, select RSA#Microsoft Software Key Storage Provider.

From the Key length menu, select 4096.

In the hash algorithm list, select SHA512, and then click Next.

In the Common name for this CA field, type the host server name.

In the Distinguished name suffix field, type the domain component.

Sample CA name configuration

Machine Fully Qualified Domain Name (FQDN): test.dev.lexmark.com
Common Name (CN): TEST
Distinguished name suffix: DC=DEV,DC=LEXMARK,DC=COM

In the Certificate Request dialog box, save the request file, and then click Next.

Do not change anything in the database locations window.

Complete the installation.

Sign the CA request of the root CA, and then export the signed certificate in PKCS7 format.

From the subordinate CA, open Certification Authority.

From the left panel, right‑click the CA, and then click All Tasks › Install CA Certificate.

Select the signed certificate, and then start the CA service.

Configuring the Certification Distribution Point and 
Authority Information Access settings

Notes
Configure the Certification Distribution Point (CDP) and Authority Information Access (AIA) settings for 
Certificate Revocation List (CRL).

From Server Manager, click Tools › Certification Authority.

From the left panel, right‑click the CA, and then click Properties › Extensions.

In the Select extension menu, select CRL Distribution Point (CDP).

In the certificate revocation list, select the C:\Windows\system32\ entry, and then do the following:
Select Publish CRLs to this location.

Clear Publish Delta CRLs to this location.

Delete all other entries except for C:\Windows\system32\.

Click Add.

In the Location field, add http://serverIP/CertEnroll/<CAName><CRLNameSuffix><DeltaCRLAllowed>.crl, 
where serverIP is the IP address of the server.
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Notes
If your server is reachable by using the FQDN, then use the <ServerDNSName> instead of the server 
IP address.

Click OK.

Select Include in the CDP extension of issued certificates for the created entry.

In the Select extension menu, select Authority Information Access (AIA).

Delete all other entries except for C:\Windows\system32\.

Click Add.

In the Location field, add http://serverIP/CertEnroll/<ServerDNSName>_<CAName><CertificateName>.crt, 
where serverIP is the IP address of the server.

Notes
If your server is reachable by using the FQDN, then use the <ServerDNSName> instead of the server 
IP address.

Click OK.

Select Include in the AIA extension of issued certificates for the created entry.

Click Apply > OK.

Notes
If necessary, restart the certification service.

From the left panel, expand the CA, right‑click Revoked Certificates, and then click Properties.

Specify the value for CRL publication interval and for Publish Delta CRLs Publication interval, and then 
click Apply › OK.

From the left panel, right‑click Revoked Certificates, click All Tasks, and then publish the New CRL.

Configuring CRL accessibility

Note: Before you begin, make sure that Internet Information Services (IIS) Manager is installed.

From IIS Manager, expand the CA, and then expand Sites.

Right‑click Default Web Site, and then click Add Virtual Directory.

In the Alias field, type CertEnroll.

In the Physical path field, type C:\Windows\System32\CertSrv\CertEnroll.

Click OK.

Right‑click CertEnroll, and then click Edit Permissions.

From the Security tab, remove any write access except for the system.

Click OK.
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Configuring the NDES server

From the server, log in as an SCEPAdmin domain user.

From Server Manager, click Manage › Add Roles and Feature.

Click Server Roles, select Active Directory Certificate Services and all its features, and then click Next.

From the AD CS Role Services section, clear Certification Authority.

Select Network Device Enrollment Service and all its features, and then click Next.

From the Web Server Role (IIS) Role Services section, retain the default settings.

After installation, click Configure Active Directory Certificate Services on the destination server.

From the Role Services section, select Network Device Enrollment Service, and then click Next.

Select the SCEPSvc service account.

From the CA for NDES section, select either CA name or Computer name, and then click Next.

From the RA Information section, specify the information, and then click Next.

From the Cryptography for NDES section, do the following:

Select the appropriate signature and encryption key providers.

From the Key length menu, select the same key length as the CA server.

Click Next.

Complete the installation.

You can now access the NDES server from a web browser as an SCEPSvc user. From the NDES server, you can 
view the CA certificate thumbprint, the enrollment challenge password, and the validity period of the challenge 
password.

Accessing the NDES server

Open a web browser, and then type http://NDESserverIP/certsrv/mscep_admin, where NDESserverIP is the IP 
address of the NDES server.

Configuring NDES for MVE

Note: Before you begin, make sure that the NDES server is working properly.

Creating a certificate template

From the subordinate CA (certserv), open Certification Authority.

From the left panel, expand the CA, right‑click Certificate Templates, and then click Manage.

In Certificate Templates Console, create a copy of Web Server.

From the General tab, type MVEWebServer as the template name.

From the Security tab, give the SCEPAdmin and SCEPSvc users the appropriate permissions.
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Note: For more information, see Overview on page 83.

From the Subject Name tab, select Supply in the request.

From the subordinate CA (certserv), open Certification Authority.

From the Extensions tab, select Application Policies › Edit.

Click Add › Client Auhthentication › OK.

From the left panel, expand the CA, right‑click Certificate Templates, and then click New › Certificate 
Template to Issue.

Select the newly created certificates, and then click OK.

You can now access the templates using the CA web enrollment portal.

Accessing the templates

Open a web browser, and then type http://CAserverIP/certsrv/certrqxt.asp, where CAserverIP is the IP 
address of the CA server.

In the Certificate template menu, view the templates.

Setting certificate templates for NDES

From your computer, launch the registry editor.

Navigate to HKEY_LOCAL_MACHINE › SOFTWARE › Microsoft › Cryptography › MSCEP.

Configure the following, and then set them to MVEWebServer:

EncryptionTemplate

GeneralPurposeTemplate

SignatureTemplate

Give the SCEPSvc user full permission to MSCEP.

From IIS Manager, expand the CA, and then click Application Pools.

From the right panel, click Recycle to restart the SCEP application pool.

From IIS Manager, expand the CA, and then expand Sites › Default Web Site.

From the right panel, click Restart.

Disabling Challenge Password in Microsoft CA server

From your computer, launch the registry editor.

Navigate to HKEY_LOCAL_MACHINE › SOFTWARE › Microsoft › Cryptography › MSCEP.

Set EnforcePassword to 0.
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From IIS Manager, expand the CA, click Application Pools, and then select SCEP.

From the right panel, click Advanced Settings.

Set Load User Profile to True, and then click OK.

From the right panel, click Recycle to restart the SCEP application pool.

From IIS Manager, expand the CA, and then expand Sites › Default Web Site.

From the right panel, click Restart.

When opening the NDES from web browser, you can now only view the CA thumbprint.

Managing certificates using Microsoft Certificate 
Authority through MSCEWS

This section provides information on configuring Certificate Enrollment Policy Web Service (CEP) and Certificate 
Enrollment Web Service (CES). As Microsoft recommends installing CEP and CES in two different machines, we 
are following the same in this document. We refer to these web services as CEP server and CES server, 
respectively.

Note: The user must have a preconfigured Enterprise Certificate Authority (CA) and a domain controller.

System requirements

The Windows Server 2012 R2 and onwards operating system is used for all setups in this section. The following 
installation requirements and capabilities apply to both CEP and CES, unless otherwise specified.

Create the following types of accounts in the domain controller:

Service Administrator: Named as CEPAdmin and CESAdmin

This user must be a part of the local admin group in the respective CEP and CES servers.

This user must be a member of the Enterprise Admin group.

Service Account: Named as CEPSvc and CESSvc

This user must be a part of the local IIS_IUSRS group.

Requires Request Certificates permission on the CA for the respective CEPSvc and CESSvc.
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Network connectivity requirements

Network connectivity requirements are a key part of deployment planning, particularly for scenarios where 
the CEP and CES are hosted in a perimeter network.

All client connectivity to both services occurs within an HTTPS session, so only HTTPS traffic is allowed 
between the client and the web services.

CEP communicates with Active Directory Domain Services (AD DS), using standard Lightweight Directory 
Access Protocol (LDAP) and secure LDAP (LDAPS) ports (TCP 389 and 636 respectively).

CES communicates with CA using Distributed Component Object Model (DCOM).

Notes
By default, DCOM uses random ephemeral ports.

CA can be configured to reserve a specific range of ports to simplify firewall configuration.

Creating SSL certificates for CEP and CES servers

CES and CEP must use Secure Sockets Layer (SSL) for communication with clients (by using HTTPS). Each 
service must have a valid certificate that has an Enhanced Key Usage (EKU) policy of server authentication in the 
local computer certificate store.

Install the IIS service in the server.

Log in to the CEP server, and then add the Root CA certificate in the Trusted Root Certification Authority 
store.

Launch the IIS Manager Console and then, select Server Home.

From the main view section, open Server Certificates.

Click Actions > Create Certificate Request.

In the Distinguished Name Properties window, provide the necessary information and then, click Next.

In the Cryptographic Service Provider Properties dialog, select the bit length, and then click Next.

Save the file.

Get the file signed by the CA that you are planning to use for CEP and CES.

Notes
Make sure that Server Authentication EKU is enabled in the signed certificate.

Copy the signed file back to the CEP server.

From the IIS Manager Console, select Server Home.

From the Main View section, open Server Certificates.

Click Actions > Complete Certificate Request.

In Specify Certificate Authority Response window, select the signed file.

Type a name, and then in the Certificate Store menu, select Personal.

Complete the certificate installation.

From IIS Manager Console, select the default website.

Click Actions > Bindings.

In the Site Bindings dialog, click Add.
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In the Add Site Binding dialog, set Type to https, and then from the SSL certificate, browse for the newly 
created certificate.

From the IIS Manager Console, select Default Web Site, and then open the SSL settings.

Enable Require SSL and set Client certificates to Ignore.

Restart IIS.

Notes
Follow the same process for CES server.

Creating certificate templates

The user must create a certificate template for the certificate enrollment. Do the following to copy from an existing 
certificate template:

Log in to the Enterprise CA with CA administrator credentials.

Expand the CA, right‑click Certificate Templates, and then click Manage.

In the Certificate Templates Console, right‑click Web Server Certificate Template, and then click 
Duplicate Template.

From the General tab of the template, name the template MVEWebServer.

In the Security tab, give the CA administrator Read, Write, and Enroll permissions.

Give Read and Enroll permissions to the authenticated users.

In the Subject Name tab, select Supply in the request.

In the General tab, set the certificate validity period.

If you plan to use this certificate template for issuing a 802.1X Certificate for printers, then do the 
following:

From the Extensions tab, select Application Policies from the list of extensions included in this 
template.

Click Edit > Add.

In Add Application Policy dialog box, select Client Authentication.

Click OK.

In the Certificate Template Properties dialog box, click OK.

In the CA window, right‑click Certificate Templates, and then click New > Certificate template.

Select MVEWebServer, and then click OK.

Understanding authentication methods

CEP and the CES support the following authentication methods:

Windows‑integrated authentication, also known as Kerberos Authentication

Client certificate authentication, also known as X.509 Certificate Authentication

Username and Password Authentication
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Windows-integrated authentication

Windows-integrated authentication uses Kerberos to provide an uninterrupted authentication flow for devices 
connected to the internal network. This method is preferred for internal deployments because it uses the existing 
Kerberos infrastructure within AD DS. It also requires minimal changes to certificate client computers.

Note: Use this authentication method if you need clients to access only the web service while connected 
directly to your internal network.

Client certificate authentication

This method is preferred over user name and password authentication because it is more secure. It does not 
require a direct connection to the corporate network.

Notes

Use this authentication method if you plan to provide clients with digital X.509 certificates for 
authentication.

This method enables the web services available on the Internet.

User name and password authentication

The user name and password method is the simplest form of authentication. This method is typically used for 
servicing clients who are not directly connected to the internal network. It is a less secure authentication option 
than client certificate authentication, but it does not require provisioning a certificate.

Note: Use this authentication method when you can access the web service on the internal network or over 
the Internet.

Delegation requirements

Delegation enables a service to impersonate a user or computer account to access resources throughout the 
network.
Delegation is required for the CES server when all the following scenarios apply:

CA and CES are not residing on the same computer.

CES can process initial enrollment requests, as opposed to only processing certificate renewal requests.

The authentication type is set to Windows-integrated authentication or Client certificate 
authentication.

Delegation is not required for the CES server in the following scenarios:

CA and CES are residing on the same computer.

User name and password is the authentication method.
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Notes

Microsoft recommends running CEP and CES as domain user accounts.

Users must create an appropriate service principal name (SPN) before configuring delegation on the 
domain user account.

Enabling delegation

To create an SPN for a domain user account, use the setspn command as follows:

setspn -s http/ces.msca.com msca\CESSvc

Notes
The account name is CESSvc.

CES is running on a computer with a fully qualified domain name (FQDN) of ces.msca.com in 
the msca.com domain.

Open the CESSvc domain user account in the domain controller.

From the Delegation tab, select Trust this user for delegation to specified services only.

Select the appropriate delegation based on the authentication method.

Notes
If you select Windows-integrated authentication, then configure delegation to use Kerberos 
only.

If the service is using client certificate authentication, then configure delegation to use any 
authentication protocol.

If you plan to configure multiple authentication methods, then configure delegation to use any 
authentication protocol.

Click Add.

In the Add Services dialog, select Users or Computers.

Type your CA server host name, and then click Check Names.

From the Add Services dialog, select either of the following services to delegate:

Host service (HOST) for that CA server

Remote Procedure Call System Service (RPCSS) for that CA server

Close the domain user properties dialog.

For CEP domain users using Windows-integrated authentication, do the following:

To create an SPN for a domain user account, use the setspn command as follows:
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setspn -s http/cep.msca.com msca\CEPSvc

Note: The account name is CEPSvc.

Open the CEPSvc domain user account in the domain controller.

From the Delegation tab, select Do not trust this user for delegation.

Configuring windows-integrated authentication

To install CEP and CES, use Windows PowerShell.

Configuring CEP

The Install-AdcsEnrollmentPolicyWebService cmdlet configures the Certificate Enrollment Policy Web Service 
(CEP). It is also used to create other instances of the service within an existing installation.

Log in to the CEP server using CEPAdmin user name, and then launch PowerShell in administrative 
mode.

Run the command Import-Module ServerManager.

Run the command Add-WindowsFeature Adcs-Enroll-Web-Pol.

Run the command Install-AdcsEnrollmentPolicyWebService -AuthenticationType Kerberos 
-SSLCertThumbprint "sslCertThumbPrint".

Note: Replace <sslCertThumbPrint> with the thumbprint of the SSL certificate created for the CEP 
server, after deleting the spaces between the thumbprint values.

Complete the installation either by selecting either Y or A.

Launch the IIS Manager Console.

In the Connections pane, expand the web server that is hosting CEP.

Expand Sites, expand Default Web Site, and then click the appropriate installation virtual application 
name, ADPolicyProvider_CEP_Kerberos.

In the virtual application called Home , double-click the application settings, and then double‑click 
FriendlyName.

Type a name under Value, and then close the dialog.

Double‑click URI, and then copy Value.

Notes
If you want to configure another authentication method on the same CEP server, then you must 
change the ID.

This URL is used in MVE or any client application.
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From the left pane, click Application Pools.

Select WSEnrollmentPolicyServer, and then from the right pane, click Actions > Advanced Settings .

Select the identity field under Process Model.

In the Application Pool Identity dialog box, select the custom account, and then type CEPSvc as the 
domain user name.

Close all dialog boxes, and then recycle IIS from the right pane of the IIS Manager Console.

From PowerShell, type iisreset to restart IIS.

Configuring CES

The Install-AdcsEnrollmentWebService cmdlet configures the Certificate Enrollment Web Service (CES). It is 
also used to create other instances of the service within an existing installation.

Log in to the CES server using CESAdmin as user name, and then launch PowerShell in administrative 
mode.

Run the command Import-Module ServerManager.

Run the command Add-WindowsFeature Adcs-Enroll-Web-Svc.

Run the command Install-AdcsEnrollmentWebService -ApplicationPoolIdentity -CAConfig 
"CA1.contoso.com\contoso-CA1-CA" -SSLCertThumbprint "sslCertThumbPrint" -AuthenticationType 
Kerberos.

Notes
Replace <sslCertThumbPrint> with the thumbprint of the SSL certificate created for the CES 
server, after deleting the spaces between the thumbprint values.

Replace CA1.contoso.com with your CA computer name.

Replace contoso-CA1-CA with your CA common name.

Complete the installation by selecting either Y or A.

Launch the IIS Manager Console.

In the Connections pane, expand the web server that is hosting CES.

Expand Sites, expand Default Web Site, and then click the appropriate installation virtual application 
name: contoso-CA1-CA _CES_Kerberos.

From the left pane, click Application Pools.

Select WSEnrollmentServer, and then from the right pane, click Actions > Advanced Settings .

Select the identity field under Process Model.

In the Application Pool Identity dialog, select the custom account, and then type CESSvc as the domain 
user name.

Close all dialogs, and then recycle IIS from the right pane of IIS Manager Console.

From PowerShell, type iisreset to restart IIS.

For CESSvc domain users, enable delegation. For more information, see Enabling delegation on page 93.
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Configuring client certificate authentication

Configuring CEP

The Install-AdcsEnrollmentPolicyWebService cmdlet configures CEP. It is also used to create other instances 
of the service within an existing installation.

Log in to the CEP server using CEPAdmin user name, and then launch PowerShell in administrative 
mode.

Run the command Import-Module ServerManager.

Run the command Add-WindowsFeature Adcs-Enroll-Web-Pol.

Run the command Install-AdcsEnrollmentPolicyWebService -AuthenticationType Certificate 
-SSLCertThumbprint “sslCertThumbPrint”.

Note: Replace <sslCertThumbPrint> with the thumbprint of the SSL certificate created for the CEP 
server, after deleting the spaces between the thumbprint values.

Complete the installation by selecting either Y or A.

Launch the IIS Manager Console.

In the Connections pane, expand the web server that is hosting CEP.

Expand Sites, expand Default Web Site, and then click the appropriate installation virtual application 
name ADPolicyProvider_CEP_Certificate.

In the virtual application called Home , double-click the application settings, and then double‑click 
FriendlyName.

Type a name under Value and close the dialog.

Double‑click URI, and then copy Value.

Notes
If you want to configure another authentication method on the same CEP server, then you must 
change the ID.

This URL is used in MVE or any client application.

From the left pane, click Application Pools.

Select WSEnrollmentPolicyServer, and then from the right pane, click Actions > Advanced Settings.

Select the identity field under Process Model.

In the Application Pool Identity dialog box, select the custom account, and then type CEPSvc as the 
domain user name.

Close all dialog boxes, and then recycle IIS from the right pane of the IIS Manager Console.

From PowerShell, type iisreset to restart IIS.
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Configuring CES

The Install-AdcsEnrollmentWebService cmdlet configures the Certificate Enrollment Web Service (CES). It is 
also used to create other instances of the service within an existing installation.

Log in to the CES server using CESAdmin as user name, and then launch PowerShell in administrative 
mode.

Run the command Import-Module ServerManager.

Run the command Add-WindowsFeature Adcs-Enroll-Web-Svc.

Run the command Install-AdcsEnrollmentWebService -ApplicationPoolIdentity -CAConfig 
“CA1.contoso.com\contoso-CA1-CA” -SSLCertThumbprint “sslCertThumbPrint” -AuthenticationType 
Certificate.

Notes
Replace <sslCertThumbPrint> with the thumbprint of the SSL certificate created for the CES 
server, after deleting the spaces between the thumbprint values.

Replace CA1.contoso.com with your CA computer name.

Replace contoso-CA1-CA with your CA common name.

If you have already configured one authentication method in the host, then remove 
ApplicationPoolIdentity from the command.

Complete the installation either by selecting Y or A.

Launch the IIS Manager Console.

In the Connections pane, expand the web server that is hosting CEP.

Expand Sites, expand Default Web Site, and then click the appropriate installation virtual application 
name: contoso-CA1-CA _CES_Certificate.

From the left pane, click the Application Pools.

Select WSEnrollmentServer, and then from the right pane, click Actions > Advanced Settings.

Select the identity field under Process Model.

In the Application Pool Identity dialog, select the custom account, and then type CESSvc as the domain 
user name.

Close all dialogs, and then recycle IIS from the right pane of the IIS Manager Console.

From PowerShell, type iisreset to restart IIS.

For CESSvc domain user, enable delegation. For more information, see Enabling delegation on page 93.

Creating a client certificate

From any domain user account, open certlm.msc.

Click Certificates > Personal > Certificates > All Tasks > Request New Certificate.

Click Next.

Click Active Directory Enrollment > Client access.
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Note: Do the following if you do not want to use Active Directory Enrollment options:

Click Configured by You > Add New.

Enter the Enrollment Policy Server URI as CEP server address for either Username_Password or 
Kerberos Authentication.

Select Authentication type as Windows Integrated.

Click Validate Server.

After successful validation, click Add.

Click Next.

Select any template.

Click Details > Properties.

Click Enroll.

In the Subject tab, provide a fully qualified domain name (FQDN).

In the Private Key tab, select Make private key exportable.

Click Apply > Enroll.

After enrolling the client certificate, do the following to export the client certificate in PFX format.

Click Certificate > All Tasks > Export.

Click Next > Yes, export the private key.

Click Next.

Type the password provided by the client.

Click Next.

Specify the file name in the Certificate Export dialog box.

Click Next > Finish.

Configuring username-password authentication

Configuring CEP

The Install-AdcsEnrollmentPolicyWebService cmdlet configures the Certificate Enrollment Policy Web Service 
(CEP). It is also used to create other instances of the service within an existing installation.

Log in to the CEP server using CEPAdmin user name, and then launch PowerShell in administrative 
mode.

Run the command Import-Module ServerManager.

Run the command Add-WindowsFeature Adcs-Enroll-Web-Pol.

Run the command Install-AdcsEnrollmentPolicyWebService -AuthenticationType UserName 
-SSLCertThumbprint “sslCertThumbPrint”.

Note: Replace <sslCertThumbPrint> with the thumbprint of the SSL certificate created for the CEP 
server, after deleting the spaces between the thumbprint values.
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Complete the installation by selecting either Y or A.

Launch the IIS Manager Console.

In the Connections pane, expand the web server that is hosting CEP.

Expand Sites, expand Default Web Site, and then click the appropriate installation virtual application 
name: ADPolicyProvider_CEP_UsernamePassword.

In the virtual application called Home , double-click the application settings, and then double click 
FriendlyName.

Type a name under Value and close the dialog.

Double‑click URI, and then copy Value.

Notes
If you want to configure another authentication method on the same CEP server, then you must 
change the ID.

This URL is used in MVE or any client application.

From the left pane, click Application Pools.

Select WSEnrollmentPolicyServer, and then from the right pane, click Actions > Advanced Settings.

Select the identity field under Process Model.

In the Application Pool Identity dialog box, select the custom account, and then type CEPSvc.

Close all dialog boxes, and then recycle IIS from the right pane of the IIS Manager Console.

From PowerShell, type iisreset to restart IIS.

Configuring CES

The Install-AdcsEnrollmentWebService cmdlet configures the Certificate Enrollment Web Service (CES). It is 
also used to create other instances of the service within an existing installation.

Log in to the CES server using CESAdmin as user name, and then launch PowerShell in administrative 
mode.

Run the command Import-Module ServerManager.

Run the command Add-WindowsFeature Adcs-Enroll-Web-Svc.

Run the command Install-AdcsEnrollmentWebService -ApplicationPoolIdentity -CAConfig 
“CA1.contoso.com\contoso-CA1-CA” -SSLCertThumbprint “sslCertThumbPrint” -AuthenticationType 
UserName.
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Notes
Replace <sslCertThumbprint> with the thumbprint of the SSL certificate created for the CES 
server, after deleting the spaces between the thumbprint values.

Replace CA1.contoso.com with your CA computer name.

Replace contoso-CA1-CA with your CA common name.

If you have already configured one authentication method in the host, then remove 
ApplicationPoolIdentity from the command.

Complete the installation by selecting either Y or A.

Launch the IIS Manager Console.

In the Connections pane, expand the web server that is hosting CES.

Expand Sites, expand Default Web Site, and then click the appropriate installation virtual application 
name: contoso-CA1-CA_CES_UsernamePassword.

From the left pane, click Application Pools.

Select WSEnrollmentServer, and then from the right pane, click Actions > Advanced Settings under 
Actions.

Select the identity field under Process Model.

In the Application Pool Identity dialog, select the custom account, and then type CESSvc as the domain 
user name.

Close all dialogs, and then recycle IIS from the right pane of IIS Manager Console.

From PowerShell, type iisreset to restart IIS.

Managing certificates using OpenXPKI Certificate 
Authority through SCEP

This section helps user to configure OpenXPKI CA version 3.x.x using EST protocol..

Notes

Make sure that you are using the Debian 10 Buster operating system.

For more information on OpenXPKI, go to www.openxpki.org.

Configuring OpenXPKI CA

Installing OpenXPKI CA

Connect the machine using PuTTY or another client.

From the client, run the sudo su - command to go to the root user.

Enter the root password.
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In nano /etc/apt/sources.list, change the source for installing the updates.

Update the file. For example:

#

# deb cdrom:[Debian GNU/Linux 8.11.1 _Jessie_ - Official amd64 

CD Binary-1 20190211-02:10]/ jessie local main

# deb cdrom:[Debian GNU/Linux 8.11.1 _Jessie_ - Official amd64 

CD Binary-1 20190211-02:10]/ jessie local main

deb http://security.debian.org/ jessie/updates main

deb-src http://security.debian.org/ jessie/updates main

# jessie-updates, previously known as 'volatile'

# A network mirror was not selected during install.  The 

following entries

# are provided as examples, but you should amend them as 

appropriate

# for your mirror of choice.

#

deb http://ftp.debian.org/debian/jessie-updates main

deb-src http://ftp.debian.org/debian/jessie-updates main

deb http://ftp.us.debian.org/debian/jessie main

Save the file.

Run the following commands:

apt-get update

apt-get upgrade

Update the CA certificate lists in the server using apt-get install ca-certificates.

Install en_US.utf8 locale using dpkg-reconfigure locales.

Select the en_US.UTF-8 UTF-8 locale, and then make it the default locale for the system.

Note: Use the Tab and spacebar keys for selecting and navigating the menu.

Check the locales that you have generated using locale –a.

Sample output

C

C.UTF-8

en_IN

en_IN.utf8

en_US.utf8

POSIX
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Copy the fingerprint of the OpenXPKI package using nano /home/Release.key. For this instance, copy the 
key in /home.

Type 9B156AD0 F0E6A6C7 86FABE7A D8363C4E 1611A2BE 2B251336 01D1CDB4 6C24BEF3 as the 
value.

Run the following command:

gpg --print-md sha256 /home/Release.key

Add the package using the wget https://packages.openxpki.org/v2/debian/Release.key -O - | apt-key add -
command.

Add the repository to your source list (jessie) using echo "deb http://packages.openxpki.org/v2/debian/
jessie release" > /etc/apt/sources.list.d/openxpki.list, and then aptitude update.

Install MySQL and Perl MySQL binding using aptitude install mysql-server libdbd-mysql-perl.

Install apache2.2-common using aptitude install apache2.2-common.

In nano /etc/apt/sources.list, install the fastcgi module to speed up the user interface.

Note: We recommend using mod_fcgid.

Add the deb http://http.us.debian.org/debian/jessie main line in the file, and then save it.

Run the following commands:

apt-get update
aptitude install libapache2-mod-fcgid

Enable the fastcgi module using a2enmod fcgid.

Install the OpenXPKI core package using aptitude install libopenxpki-perl openxpki-cgi-session-driver 
openxpki-i18n.

Restart the Apache® server using service apache2 restart.

Check whether the installation is successful using openxpkiadm version.

Note: If the installation is successful, then the system shows the version of the installed OpenXPKI. For 
example, Version (core): 2.5.5.

Create the empty database, and then assign the database user using mysql -u root –p.

Notes
This command must be typed in the client. Otherwise, you cannot enter the password.

Type the password for the MySQL. For this instance, root is the MySQL user.

openxpki is the user on which OpenXPKI is installed.

CREATE DATABASE openxpki CHARSET utf8; 

CREATE USER 'openxpki'@'localhost' IDENTIFIED BY 'openxpki';
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GRANT ALL ON openxpki.* TO 'openxpki'@'localhost';

flush privileges;

If the MySQL service is not running, then run /etc/init.d/mysql start to start the service.

Type quit to exit from MySQL.

Store the used credentials in /etc/openxpki/config.d/system/database.yaml.

Sample file content

debug: 0

type: MySQL

name: openxpki

host: localhost

port: 3306

user: openxpki 

passwd: openxpki

Note: Change user and passwd to match the MySQL user name and password.

Save the file.

For empty database schema, run zcat /usr/share/doc/libopenxpki-perl/examples/schema-mysql.sql.gz | 
\mysql -u root --password --database openxpki from the provided schema file.

Enter the password for the database.

Configuring OpenXPKI CA using default script

Note: The default script configures only the default realm, ca-one. The CDP and CRLs are not configured.

Unzip the sample script for installing the certificate using gunzip -k /usr/share/doc/libopenxpki-perl/
examples/sampleconfig.sh.gz.

Run the script using bash /usr/share/doc/libopenxpki-perl/examples/sampleconfig.sh.

Confirm the setup using openxpkiadm alias --realm ca-one.

Sample output

=== functional token ===

scep (scep):

Alias    : scep-1

Identifier: YsBNZ7JYTbx89F_-Z4jn_RPFFWo

NotBefore : 2015-01-30 20:44:40

NotAfter  : 2016-01-30 20:44:40

vault (datasafe):

Alias    : vault-1
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Identifier: lZILS1l6Km5aIGS6pA7P7azAJic

NotBefore : 2015-01-30 20:44:40

NotAfter  : 2016-01-30 20:44:40

ca-signer (certsign):

Alias    : ca-signer-1

Identifier: Sw_IY7AdoGUp28F_cFEdhbtI9pE

NotBefore : 2015-01-30 20:44:40

NotAfter  : 2018-01-29 20:44:40

=== root ca ===

current root ca:

Alias     : root-1

Identifier: fVrqJAlpotPaisOAsnxa9cglXCc

NotBefore : 2015-01-30 20:44:39

NotAfter  : 2020-01-30 20:44:39

upcoming root ca:

  not set

Check whether the installation is successful using openxpkictl start.

Sample output

Starting OpenXPKI...

OpenXPKI Server is running and accepting requests.

DONE.

Do the following to access the OpenXPKI server:
From a web browser, type http://ipaddress/openxpki/.

Log in as Operator. The default password is openxpki.

Note: The Operator login has two preconfigured operator accounts, raop and raop2.

Create one certificate request, and then test it.

Configuring OpenXPKI CA manually

Overview

Note: Before you begin, make sure that you have a basic knowledge on creating OpenSSL certificates.

To configure OpenXPKI CA manually, create the following:

Root CA certificate. For more information, see Creating a root CA certificate on page 107.

CA signer certificate, signed by the root CA. For more information, see Creating a signer certificate on 
page 107.
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Data vault certificate, self‑signed. For more information, see Creating a root CA certificate on page 107.

SCEP certificate, signed by the signer certificate.

Notes

When selecting the signature hash, use either SHA256 or SHA512.

Changing the public key size is optional.

For this instance, we are using the /etc/certs/openxpki_ca-one/ directory for certificate generation. However, 
you can use any directory.

Creating an OpenSSL configuration file

Run the following command:

nano /etc/certs/openxpki_ca-one/openssl.conf

Note: If your server is reachable using the fully qualified domain name (FQDN), then use the DNS of 
the server instead of its IP address.

Sample file

# x509_extensions               = v3_ca_extensions

# x509_extensions               = v3_issuing_extensions

# x509_extensions               = v3_datavault_extensions

# x509_extensions               = v3_scep_extensions

# x509_extensions               = v3_web_extensions

# x509_extensions               = v3_ca_reqexts # not for root 

self-signed, only for issuing

## x509_extensions              = v3_datavault_reqexts # not 

required self-signed

# x509_extensions               = v3_scep_reqexts

# x509_extensions               = v3_web_reqexts

[ req ]

default_bits            = 4096

distinguished_name      = req_distinguished_name

[ req_distinguished_name ]

domainComponent         = Domain Component

commonName              = Common Name

[ v3_ca_reqexts ]

subjectKeyIdentifier    = hash

keyUsage                = digitalSignature, keyCertSign, cRLSign

[ v3_datavault_reqexts ]

subjectKeyIdentifier    = hash

keyUsage                = keyEncipherment
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extendedKeyUsage        = emailProtection

[ v3_scep_reqexts ]

subjectKeyIdentifier    = hash

[ v3_web_reqexts ]

subjectKeyIdentifier    = hash

keyUsage                = critical, digitalSignature, 

keyEncipherment

extendedKeyUsage        = serverAuth, clientAuth

[ v3_ca_extensions ]

subjectKeyIdentifier    = hash

keyUsage                = digitalSignature, keyCertSign, cRLSign

basicConstraints        = critical,CA:TRUE

authorityKeyIdentifier  = keyid:always,issuer

[ v3_issuing_extensions ]

subjectKeyIdentifier    = hash

keyUsage                = digitalSignature, keyCertSign, cRLSign

basicConstraints        = critical,CA:TRUE

authorityKeyIdentifier  = keyid:always,issuer:always

crlDistributionPoints   = URI:http://FQDN of the server/

CertEnroll/MYOPENXPKI.crl

authorityInfoAccess     = caIssuers;URI:http://FQDN of the 

server/CertEnroll/MYOPENXPKI.crt

[ v3_datavault_extensions ]

subjectKeyIdentifier    = hash

keyUsage                = keyEncipherment

extendedKeyUsage        = emailProtection

basicConstraints        = CA:FALSE

authorityKeyIdentifier  = keyid:always,issuer

[ v3_scep_extensions ]

subjectKeyIdentifier    = hash

basicConstraints        = CA:FALSE

authorityKeyIdentifier  = keyid,issuer

[ v3_web_extensions ]

subjectKeyIdentifier    = hash

keyUsage                = critical, digitalSignature, 

keyEncipherment

extendedKeyUsage        = serverAuth, clientAuth

basicConstraints        = critical,CA:FALSE

subjectAltName          = DNS:stlopenxpki.lexmark.com

crlDistributionPoints   = URI:http://FQDN of the server/

CertEnroll/MYOPENXPKI_ISSUINGCA.crl

authorityInfoAccess     = caIssuers;URI:http://FQDN of the 

server/CertEnroll/MYOPENXPKI_ISSUINGCA.crt

Change the IP address and CA certificate name with your setup information.
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Save the file.

Creating a password file for certificate keys

Run the following command:

nano /etc/certs/openxpki_ca-one/pd.pass

Type your password.

Save the file.

Creating a root CA certificate

Note: You can create a self‑signed root CA certificate or generate a certificate request, and then get it signed 
by the root CA.

Run the following commands:

Note: Replace the key length, signature algorithm, and certificate name with the appropriate values.

openssl genrsa -out /etc/certs/openxpki_ca-one/ca-root-1.key -passout file:/etc/certs/openxpki_ca-one/
pd.pass 4096

openssl req -new -key /etc/certs/openxpki_ca-one/ca-root-1.key -subj /DC=COM/DC=LEXMARK/
DC=DEV/DC=CA-ONE/CN=MYOPENXPKI_ROOTCA -out /etc/certs/openxpki_ca-one/ca-root-1.csr

openssl req -config /etc/certs/openxpki_ca-one/openssl.conf -extensions v3_ca_extensions -x509 -days 
3560 -in /etc/certs/openxpki_ca-one/ca-root-1.csr -key /etc/certs/openxpki_ca-one/ca-root-1.key -out /etc/
certs/openxpki_ca-one/ca-root-1.crt -sha256

Creating a signer certificate

Note: Replace the key length, signature algorithm, and certificate name with the appropriate values.

Run the following command:

openssl genrsa -out /etc/certs/openxpki_ca-one/ca-signer-1.key -passout file:/etc/certs/openxpki_ca-one/
pd.pass 4096

Change the subject in the request with your CA information using openssl req -config /etc/certs/
openxpki_ca-one/openssl.conf -reqexts v3_ca_reqexts -new -key /etc/certs/openxpki_ca-one/ca-
signer-1.key -subj /DC=COM/DC=LEXMARK/DC=DEV/DC=CA-ONE/CN=MYOPENXPKI_ISSUINGCA 
-out /etc/certs/openxpki_ca-one/ca-signer-1.csr.

Get the certificate signed by the root CA using openssl x509 -req -extfile /etc/certs/openxpki_ca-one/
openssl.conf -extensions v3_issuing_extensions -days 3650 -in /etc/certs/openxpki_ca-one/ca-signer-1.csr 
-CA /etc/certs/openxpki_ca-one/ca-root-1.crt -CAkey /etc/certs/openxpki_ca-one/ca-root-1.key 
-CAcreateserial -out /etc/certs/openxpki_ca-one/ca-signer-1.crt -sha256.
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Creating a vault certificate

Notes

The vault certificate is self‑signed.

Replace the key length, signature algorithm, and certificate name with the appropriate values.

Run the following command:

openssl genrsa -out /etc/certs/openxpki_ca-one/vault-1.key -passout file:/etc/certs/openxpki_ca-one/
pd.pass 4096

Change the subject in the request with your CA information using openssl req -config /etc/certs/
openxpki_ca-one/openssl.conf -reqexts v3_datavault_reqexts -new -key /etc/certs/openxpki_ca-one/
vault-1.key -subj /DC=COM/DC=LEXMARK/DC=DEV/DC=CA-ONE/DC=STLOPENXPKI_INTERNAL/
CN=MYOPENXPKI_DATAVAULT -out /etc/certs/openxpki_ca-one/vault-1.csr.

Run the following command:

openssl req -config /etc/certs/openxpki_ca-one/openssl.conf -extensions v3_datavault_extensions -x509 
-days 3560 -in /etc/certs/openxpki_ca-one/vault-1.csr -key /etc/certs/openxpki_ca-one/vault-1.key -out /
etc/certs/openxpki_ca-one/vault-1.crt

Creating an SCEP certificate

Note: The SCEP certificate is signed by the signer certificate.

Run the following commands:

Note: Replace the key length, signature algorithm, and certificate name with the appropriate values.

openssl genrsa -out /etc/certs/openxpki_ca-one/scep-1.key -passout file:/etc/certs/openxpki_ca-one/
pd.pass 4096

openssl req -config /etc/certs/openxpki_ca-one/openssl.conf -reqexts v3_scep_reqexts -new -key /etc/
certs/openxpki_ca-one/scep-1.key -subj /DC=COM/DC=LEXMARK/DC=DEV/DC=CA-ONE/
CN=MYOPENXPKI_SCEPCA -out /etc/certs/openxpki_ca-one/scep-1.csr

openssl x509 -req -extfile /etc/certs/openxpki_ca-one/openssl.conf -extensions v3_scep_extensions -days 
900 -in /etc/certs/openxpki_ca-one/scep-1.csr -CA /etc/certs/openxpki_ca-one/ca-signer-1.crt -CAkey /etc/
certs/openxpki_ca-one/ca-signer-1.key -CAcreateserial -out /etc/certs/openxpki_ca-one/scep-1.crt 
-sha256

Copying the key file and creating a symlink

Copy the key files to /etc/openxpki/ca/ca-one/.

Note: The key files must be readable by OpenXPKI.
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cp /etc/certs/openxpki_ca-one/ca-signer-1.key /etc/openxpki/ca/

ca-one/

cp /etc/certs/openxpki_ca-one/vault-1.key /etc/openxpki/ca/ca-

one/

cp /etc/certs/openxpki_ca-one/scep-1.key /etc/openxpki/ca/ca-

one/

Create the symlink.

Note: Symlinks are aliases used by the default configuration.

ln -s /etc/openxpki/ca/ca-one/ca-signer-1.key /etc/openxpki/ca/

ca-one/ca-signer-1.pem

ln -s /etc/openxpki/ca/ca-one/scep-1.key /etc/openxpki/ca/ca-

one/scep-1.pem

ln -s /etc/openxpki/ca/ca-one/vault-1.key /etc/openxpki/ca/ca-

one/vault-1.pem

Importing certificates

Import the root certificate, signer certificate, vault certificate, and SCEP certificate into the database with the 
appropriate tokens.

Run the following commands:

openxpkiadm certificate import --file /etc/certs/openxpki_ca-one/ca-root-1.crt

openxpkiadm certificate import --file /etc/certs/openxpki_ca-one/ca-signer-1.crt --realm ca-one --token 
certsign

openxpkiadm certificate import --file /etc/certs/openxpki_ca-one/scep-1.crt --realm ca-one --token scep

openxpkiadm certificate import --file /etc/certs/openxpki_ca-one/vault-1.crt --realm ca-one --token datasafe

Check whether the import is successful using openxpkiadm alias --realm ca-one.

Sample output

=== functional token ===

scep (scep):

Alias    : scep-1

Identifier: YsBNZ7JYTbx89F_-Z4jn_RPFFWo

NotBefore : 2015-01-30 20:44:40

NotAfter  : 2016-01-30 20:44:40
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vault (datasafe):

Alias    : vault-1

Identifier: lZILS1l6Km5aIGS6pA7P7azAJic

NotBefore : 2015-01-30 20:44:40

NotAfter  : 2016-01-30 20:44:40

ca-signer (certsign):

Alias    : ca-signer-1

Identifier: Sw_IY7AdoGUp28F_cFEdhbtI9pE

NotBefore : 2015-01-30 20:44:40

NotAfter  : 2018-01-29 20:44:40

=== root ca ===

current root ca:

Alias     : root-1

Identifier: fVrqJAlpotPaisOAsnxa9cglXCc

NotBefore : 2015-01-30 20:44:39

NotAfter  : 2020-01-30 20:44:39

upcoming root ca:

  not set

Starting OpenXPKI

Run the openxpkictl start command.

Sample output

Starting OpenXPKI...

OpenXPKI Server is running and accepting requests.

DONE.

Do the following to access the OpenXPKI server:
From a web browser, type http://ipaddress/openxpki/.

Note: Instead of ipaddress, you can also use the FQDN of the server.

Log in as Operator. The default password is openxpki.

Note: The Operator login has two preconfigured operator accounts, raop and raop2.

Create one certificate request, and then test it.
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Generating CRL information

Note: If your server is reachable using the FQDN, then use the DNS of the server instead of its IP address.

Stop the OpenXPKI service using Openxpkictl stop.

In nano /etc/openxpki/config.d/realm/ca-one/publishing.yaml, update the connectors: cdp section to 
the following:

class: Connector::Builtin::File::Path

LOCATION: /var/www/openxpki/CertEnroll/

file: "[% ARGS.0 %].crl"

content: "[% pem %]"

In nano /etc/openxpki/config.d/realm/ca-one/profile/default.yaml, update the following:

crl_distribution_points: section

critical: 0

uri:

    - http://FQDN of the server/CertEnroll/[% 

ISSUER.CN.0 %].crl

    - ldap://localhost/[% ISSUER.DN %]

authority_info_access: section

critical: 0

ca_issuers: http://FQDN of the server/CertEnroll/

MYOPENXPKI.crt

ocsp: http://ocsp.openxpki.org/

Change the IP address and CA certificate name according to your CA server.

In nano /etc/openxpki/config.d/realm/ca-one/crl/default.yaml, do the following:

If necessary, update nextupdate and renewal.

Add ca_issuers to the following section:

extensions:

            authority_info_access:

                    critical: 0

                    # ca_issuers and ocsp can be scalar 

or list

                    ca_issuers: http://FQDN of the 

server/CertEnroll/MYOPENXPKI.crt

                   #ocsp: http://ocsp.openxpki.org/

Change the IP address and CA certificate name according to your CA server.
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Start the OpenXPKI service using Openxpkictl start.

Configuring CRL accessibility

Stop the Apache service using service apache2 stop.

Create a CertEnroll directory for crl in the /var/www/openxpki/ directory.

Set openxpki as the owner of this directory, and then configure the permissions to let Apache read and 
execute, and other services to read only.

chown openxpki /var/www/openxpki/CertEnroll
chmod 755 /var/www/openxpki/CertEnroll

Add a reference to the Apache alias.conf file using nano /etc/apache2/mods-enabled/alias.conf.

After the <Directory "/usr/share/apache2/icons"> section, add the following:

            Alias /CertEnroll/ "/var/www/openxpki/CertEnroll/"

             <Directory "/var/www/openxpki/CertEnroll">

               Options FollowSymlinks

               AllowOverride None

               Require all granted

             </Directory>

Add a reference in the apache2.conf file using nano /etc/apache2/apache2.conf.

Add the following in the Apache2 HTTPD server section:

             <Directory /var/www/openxpki/CertEnroll>

               Options FollowSymlinks

               AllowOverride None

               Allow from all

             </Directory>

Start the Apache service using service apache2 start.

Enabling the SCEP service

Stop the OpenXPKI service using openxpkictl stop.

Install the openca-tools package using aptitude install openca-tools.

Start the OpenXPKI service using openxpkictl start.

Test the service using any client, such as certnanny with SSCEP.

Note: SSCEP is a command line client for SCEP. You can download SSCEP from https://github.com/
certnanny/sscep.
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Enabling the Signer on Behalf (enrollment agent) 
certificate

For automatic certificate requests, we are using the Signer on Behalf certificate feature of OpenXPKI.

Stop the OpenXPKI service using openxpkictl stop.

In nano /etc/openxpki/config.d/realm/ca-one/scep/generic.yaml, from the authorized_signer: section, 
add a rule for the subject name of the signer certificate.

rule1:

                # Full DN

                    subject: CN=Markvision_.*

Notes
In this rule, any certificate CN starting with Markvision_ is the Signer on Behalf certificate.

The subject name is set in MVE for generating the Signer on Behalf certificate.

Review the space and indention in the script file.

If the CN is changed in MVE, then add the updated CN in OpenXPKI.

You can specify only one certificate as Signer on Behalf, and then specify the full CN.

Save the file.

Start the OpenXPKI service using openxpkictl start.

Enabling automatic approval of certificate requests in 
OpenXPKI CA

Stop the OpenXPKI service using openxpkictl stop.

In nano /etc/openxpki/config.d/realm/ca-one/scep/generic.yaml, update the eligible: section:

Old content

eligible:

            initial:

                value@: connector:scep.generic.connector.initial

               args: '[% context.cert_subject_parts.CN.0 %]'

               expect:

                   - Build

                   - New

New content
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eligible:

            initial:

                value: 1

                # value@: 

connector:scep.generic.connector.initial

                # args: '[% context.cert_subject_parts.CN.0 %]'

                # expect:

                #    - Build

                #    - New

Notes
Review the space and indention in the script file.

To approve certificates manually, comment value: 1, and then uncomment the other lines that 
are previously commented.

Save the file.

Start the OpenXPKI service using openxpkictl start.

Creating a second realm

In OpenXPKI, you can configure multiple PKI structures in the same system. The following topics show how to 
create another realm for MVE named ca-two.

Copying and setting the directory

Copy the /etc/openxpki/config.d/realm/ca-one sample directory tree to a new directory (cp -avr /etc/
openxpki/config.d/realm/ca-one /etc/openxpki/config.d/realm/ca-two) within the realm directory.

In /etc/openxpki/config.d/system/realms.yaml, update the following section:

Old content

# This is the list of realms in this PKI

# You only need to enable the realms which are visible on the 

server

ca-one:

    label: Verbose name of this realm

    baseurl: https://pki.example.com/openxpki/

#ca-two:

#    label: Verbose name of this realm

#    baseurl: https://pki.acme.org/openxpki/
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New content

# This is the list of realms in this PKI

# You only need to enable the realms which are visible on the 

server

ca-one:

    label: CA-ONE

    baseurl: https://pki.example.com/openxpki/

ca-two:

    label: CA-TWO

    baseurl: https://pki.example.com/openxpki/

Save the file.

Creating certificates

The following instructions show how to generate the signer certificate, vault certificate, and SCEP certificate. The 
root CA signs the signer certificate, and then the signer certificate signs the SCEP certificate. The vault certificate 
is self‑signed.

Generate, and then sign the certificates. For more information, see "Configuring OpenXPKI CA manually" 
sub-group.

Note: Change the certificate common name so that the user can easily distinguish between different 
certificates for different realms. You may change DC=CA-ONE to DC=CA-TWO. The certificate files are 
created in the /etc/certs/openxpki_ca-two/ directory.

Copy the key files to /etc/openxpki/ca/ca-two/.

Note: The key files must be readable by OpenXPKI.

cp /etc/certs/openxpki_ca-two/ca-signer-1.key /etc/openxpki/ca/

ca-two/

cp /etc/certs/openxpki_ca-two/vault-1.key /etc/openxpki/ca/ca-

two/

cp /etc/certs/openxpki_ca-two/scep-1.key /etc/openxpki/ca/ca-

two/

Create the symlink. Also, create a symlink for the root CA certificate.
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ln -s /etc/openxpki/ca/ca-one/ca-root-1.crt /etc/openxpki/ca/ca-

two/ca-root-1.crt

ln -s /etc/openxpki/ca/ca-two/ca-signer-1.key /etc/openxpki/ca/

ca-two/ca-signer-1.pem

ln -s /etc/openxpki/ca/ca-two/scep-1.key /etc/openxpki/ca/ca-

two/scep-1.pem

ln -s /etc/openxpki/ca/ca-two/vault-1.key /etc/openxpki/ca/ca-

two/vault-1.pem

Import the signer certificate, vault certificate, and SCEP certificate into the database with the appropriate 
tokens for ca-two.

openxpkiadm certificate import --file /etc/certs/openxpki_ca-

two/ca-signer-1.crt --realm ca-two –issuer /etc/openxpki/ca/ca-

two/ca-one-1.crt --token certsign

openxpkiadm certificate import --file /etc/certs/openxpki_ca-

two/scep-1.crt --realm ca-two --token scep

openxpkiadm certificate import --file /etc/certs/openxpki_ca-

two/vault-1.crt --realm ca-two --token datasafe

Check whether the import is successful using openxpkiadm alias --realm ca-two.

Sample output

=== functional token ===

scep (scep):

Alias    : scep-1

Identifier: YsBNZ7JYTbx89F_-Z4jn_RPFFWo

NotBefore : 2015-01-30 20:44:40

NotAfter  : 2016-01-30 20:44:40

vault (datasafe):

Alias    : vault-1

Identifier: lZILS1l6Km5aIGS6pA7P7azAJic

NotBefore : 2015-01-30 20:44:40

NotAfter  : 2016-01-30 20:44:40

ca-signer (certsign):

Alias    : ca-signer-1

Identifier: Sw_IY7AdoGUp28F_cFEdhbtI9pE

NotBefore : 2015-01-30 20:44:40
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NotAfter  : 2018-01-29 20:44:40

=== root ca ===

current root ca:

Alias     : root-1

Identifier: fVrqJAlpotPaisOAsnxa9cglXCc

NotBefore : 2015-01-30 20:44:39

NotAfter  : 2020-01-30 20:44:39

upcoming root ca:

  not set

In this instance, the root CA information is the same for ca-one and ca-two.

If you changed the certificate key password during certificate creation, then update nano /etc/openxpki/
config.d/realm/ca-two/crypto.yaml.

Generate the CRLs for this realm. For more information, see Generating CRL information on page 111.

Publish the CRLs for this realm. For more information, see Configuring CRL accessibility on page 112.

Restart the OpenXPKI service using openxpkictl restart.

Sample output

Stopping OpenXPKI

Stopping gracefully, 3 (sub)processes remaining...

DONE.

Starting OpenXPKI...

OpenXPKI Server is running and accepting requests.

DONE.

Do the following to access the OpenXPKI server:
From a web browser, type http://ipaddress/openxpki/.

Log in as Operator. The default password is openxpki.

Note: The Operator login has two preconfigured operator accounts, raop and raop2.

Configuring SCEP endpoint for multiple realms

The default realm SCEP endpoint is http://<ipaddress>/scep/scep. If you have multiple realms, then configure a 
unique SCEP endpoint (different configuration file) for each realm. In the following instructions, we use two PKI 
realms, ca-one and ca-two.

Copy the default configuration file in cp /etc/openxpki/scep/default.conf /etc/openxpki/scep/ca-
one.conf.
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Note: Name the file as ca-one.conf.

In nano /etc/openxpki/scep/ca-one.conf, change the realm value to realm=ca-one.

Create another configuration file in cp /etc/openxpki/scep/default.conf /etc/openxpki/scep/ca-
two.conf.

Note: Name the file as ca-two.conf.

In nano /etc/openxpki/scep/ca-two.conf, change the realm value to realm=ca-two.

Restart the OpenXPKI service using openxpkictl restart.

The SCEP endpoints are the following:

ca‑one—http://ipaddress/scep/ca-one

ca-two—http://ipaddress/scep/ca-two

If you want to differentiate between login credentials and default certificate templates for different PKI realms, 
then you may need advanced configuration.

Enabling multiple active certificates with same subject 
to be present at a time

By default, in OpenXPKI only one certificate with the same subject name can be active at a time. But when you 
are enforcing multiple Named Certificates, multiple active certificates with the same subject name must be 
present at a time.

In /etc/openxpki/config.d/realm/REALM NAME/scep/generic.yaml, from the policy section, change the 
value of max_active_certs from 1 to 0.

Notes
REALM NAME is the name of the realm. For example, ca‑one.

Review the space and indentation in the script file.

Restart the OpenXPKI service using openxpkictl restart.

Setting the default port number for OpenXPKI CA

By default, Apache listens in port number 80. Set the default port number for OpenXPKI CA to avoid conflicts.

In /etc/apache2/ports.conf, add or modify a port. For example, Listen 8080.

In /etc/apache2/sites-enabled/000-default.conf, add or modify the VirtualHost section to map new port. 
For example, <VirtualHost *:8080>.

Restart the Apache server using systemctl restart apache2.
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To check the status, run netstat -tlpn| grep apache. The OpenXPKI SCEP URL is now http://ipaddress:8080/
scep/ca-one, and the web URL is http://ip address:8080/openxpki.

Rejecting certificate requests without Challenge 
Password in OpenXPKI CA

By default, OpenXPKI accepts requests without checking the challenge password. The certificate request is not 
rejected, and the CA and CA administrator determine whether to approve or reject the request. To avoid potential 
security concerns, disable this feature so that any certificate requests that contain invalid passwords are rejected 
immediately. In MVE, Challenge Password is required only when generating the enrollment agent certificate.

In etc/openxpki/config.d/realm/REALM NAME/scep/generic.yaml, from the policy section, change the 
value of allow_man_authen from 1 to 0.

Notes
REALM NAME is the name of the realm. For example, ca‑one.

Review the space and indentation in the script file.

Restart the OpenXPKI service using openxpkictl restart.

Adding client authentication EKU in certificates

In /etc/openxpki/config.d/realm/REALM NAME/profile/
I18N_OPENXPKI_PROFILE_TLS_SERVER.yaml, from the extended_key_usage: section, change the 
value of client_auth: to 1.

Notes
REALM NAME is the name of the realm. For example, ca‑one.

Review the space and indentation in the script file.

Restart the OpenXPKI service using openxpkictl restart.

Getting the full certificate subject when requesting 
through SCEP

By default, OpenXPKI reads only the CN of the subject of the requesting certificate. The rest of the information, 
such as country, locality, and DC, are hard‑coded. For example, if a certificate subject is C=US, ST=KY, 
L=Lexington, O=Lexmark, OU=ISS, CN=ET0021B7C34AEC.dhcp.dev.lexmark.com, then after signing the 
certificate through SCEP, the subject is changed to DC=Test Deployment, DC= OpenXPKI, 
CN=ET0021B7C34AEC.dhcp.dev.lexmark.com.

Notes
REALM NAME is the name of the realm. For example, ca‑one.
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In /etc/openxpki/config.d/realm/REALM NAME/profile/
I18N_OPENXPKI_PROFILE_TLS_SERVER.yaml, from the enroll section, change the value of dn to the 
following:

CN=[% CN.0 %][% IF OU %][% FOREACH entry = OU %],OU=[% entry %]

[% END %][% END %][% IF O %][% FOREACH entry = O %],O=[% entry 

%][% END %][% END %][% IF L %],L=[% L.0 %][% END %][% IF ST 

%],ST=[% ST.0 %][% END %][% IF C %],C=[% C.0 %][% END %][% IF DC 

%][% FOREACH entry = DC %],DC=[% entry %][% END %][% END %][% IF 

EMAIL %][% FOREACH entry = EMAIL %],EMAIL=[% entry %][% END %][% 

END %]

Save the file.

Create a file titled l.yaml in the /etc/openxpki/config.d/realm/REALM NAME/profile/template directory.

Add the following:

id: L

label: L

description: I18N_OPENXPKI_UI_PROFILE_L_DESC

preset: L

type: freetext

width: 60

placeholder: Kolkata

Save the file.

Create a file titled st.yaml in the /etc/openxpki/config.d/realm/REALM NAME/profile/template directory.

Add the following:

id: ST

label: ST

description: I18N_OPENXPKI_UI_PROFILE_ST_DESC

preset: ST

type: freetext

width: 60

placeholder: WB

Save the file.

Notes
OpenXPKI must own both files and must be readable, writable, and executable.

Restart the OpenXPKI service using openxpkictl restart.
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Revoking certificates and publishing CRL

Access the OpenXPKI server.
From a web browser, type http://ipaddress/openxpki/.

Log in as Operator. The default password is openxpki.

Note: The Operator login has two preconfigured operator accounts, raop and raop2.

Click Workflow Search > Search now.

Click a certificate to revoke, and then click the certificate link.

From the Action section, click revocation request.

Type the appropriate values, and then click Continue > Submit request.

On the next page, approve the request. The certificate revocation is waiting for the next CRL publish.

From the PKI Operation section, click Issue a certificate revocation list (CRL).

Click Enforce creation of revocation lists > Continue.

From the PKI Operation section, click Publish CA/CRL.

Click Workflow Search > Search now.

Click the revoked certificate with a certificate_revocation_request_v2 type.

Click Force wake up.

In the new CRL, you can find the serial number and the revocation reason of the revoked certificate.

Managing certificates using OpenXPKI Certificate 
Authority through EST

This section helps user to configure OpenXPKI CA version 3.x.x using EST protocol..

Notes

Make sure that you are using the Debian 10 Buster operating system.

For more information on OpenXPKI, go to www.openxpki.org.

Configuring OpenXPKI CA

Installing OpenXPKI CA

Connect the machine using PuTTY or another client.

From the client, run the sudo su - command to go to the root user.

Enter the root password.
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In nano /etc/apt/sources.list, change the source for installing the updates.

Update the file. For example:

#

# deb cdrom:[Debian GNU/Linux testing _Buster_ - Official 

Snapshot amd64 DVD Binary-1 20190527-04:04]/ buster contrib main

# deb cdrom:[Debian GNU/Linux testing _Buster_ - Official 

Snapshot amd64 DVD Binary-1 20190527-04:04]/ buster contrib main

deb http://security.debian.org/debian-security buster/updates 

main contrib

deb-src http://security.debian.org/debian-security buster/

updates main contrib

# buster-updates, previously known as 'volatile'

# A network mirror was not selected during install. The 

following entries

# are provided as examples, but you should amend them as 

appropriate

# for your mirror of choice.

#

deb http://ftp.debian.org/debian/ buster-updates main

deb-src http://ftp.debian.org/debian/ buster-updates main

deb http://ftp.us.debian.org/debian/ buster main

Save the file.

Run the following commands:

apt-get update

apt-get upgrade

Update the CA certificate lists in the server using apt-get install ca-certificates.

Install en_US.utf8 locale using dpkg-reconfigure locales.

Select the en_US.UTF-8 UTF-8 locale, and then make it the default locale for the system.

Note: Use the Tab and spacebar keys for selecting and navigating the menu.

Check the locales that you have generated using locale –a.

Sample output

C

C.UTF-8

en_IN

en_IN.utf8
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en_US.utf8

POSIX

Copy the fingerprint of the OpenXPKI package using nano /home/Release.key. For this instance, copy the 
key in /home.

Type 55D89776 006F632B E0196E3E D2495509 BAFDDC74 22FEAAD2 F055074E 0FE3A724 as the 
value.

Run the following command:

gpg --print-md sha256 /home/Release.key

Add the package using the wget https://packages.openxpki.org/v3/debian/Release.key -O - | apt-key add -
command.

Add the repository to your source list (buster) using echo " deb http://packages.openxpki.org/v3/debian/ 
buster release" > /etc/apt/sources.list.d/openxpki.list, and then apt update.

Install MySQL and Perl MySQL binding using apt install mariadb-server libdbd-mariadb-perl.

Install apache2.2-common using apt install apache2.

In nano /etc/apt/sources.list, install the fastcgi module to speed up the user interface.

Note: We recommend using mod_fcgid.

Add the deb http://http.us.debian.org/debian/ buster main line in the file, and then save it.

Run the following commands:

apt-get update
apt install libapache2-mod-fcgid

Enable the fastcgi module using a2enmod fcgid.

Install the OpenXPKI core package using apt install libopenxpki-perl openxpki-cgi-session-driver openxpki-
i18n.

Restart the Apache® server using service apache2 restart.

Check whether the installation is successful using openxpkiadm version.

Note: If the installation is successful, then the system shows the version of the installed OpenXPKI. For 
example, Version (core): 3.18.2.

Create the empty database, and then assign the database user using mariadb -u root -p.

Notes
This command must be typed in the client. Otherwise, you cannot enter the password.

Type the password for the MySQL. For this instance, root is the MySQL user.

openxpki is the user on which OpenXPKI is installed.
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CREATE DATABASE openxpki CHARSET utf8; 

CREATE USER 'openxpki'@'localhost' IDENTIFIED BY 'openxpki';

GRANT ALL ON openxpki.* TO 'openxpki'@'localhost';

flush privileges;

If the MySQL service is not running, then run /etc/init.d/mysql start to start the service.

Type quit to exit from MySQL.

Store the used credentials in /etc/openxpki/config.d/system/database.yaml.

Sample file content

main:

debug: 0

type: MariaDB

name: openxpki

host: localhost

port: 3306

user: openxpki 

passwd: openxpki

Note: Change user and passwd to match the MariaDB user name and password.

Save the file.

For empty database schema, run zcat /usr/share/doc/libopenxpki-perl/examples/schema-mariadb.sql.gz | \ 
mysql -u root --password --database openxpki from the provided schema file.

Type the password for the database.

Configuring OpenXPKI CA using the default script

Notes
The default script configures only the default realm, ca-one. The CDP and CRLs are not configured.

Run the script using bash /usr/share/doc/libopenxpki-perl/examples/sampleconfig.sh.

Confirm the setup using openxpkiadm alias --realm democa.

Sample output

=== functional token ===

scep (scep):

Alias    : scep-1

Identifier: YsBNZ7JYTbx89F_-Z4jn_RPFFWo

NotBefore : 2015-01-30 20:44:40

NotAfter  : 2016-01-30 20:44:40
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vault (datasafe):

Alias    : vault-1

Identifier: lZILS1l6Km5aIGS6pA7P7azAJic

NotBefore : 2015-01-30 20:44:40

NotAfter  : 2016-01-30 20:44:40

ca-signer (certsign):

Alias    : ca-signer-1

Identifier: Sw_IY7AdoGUp28F_cFEdhbtI9pE

NotBefore : 2015-01-30 20:44:40

NotAfter  : 2018-01-29 20:44:40

=== root ca ===

current root ca:

Alias     : root-1

Identifier: fVrqJAlpotPaisOAsnxa9cglXCc

NotBefore : 2015-01-30 20:44:39

NotAfter  : 2020-01-30 20:44:39

upcoming root ca:

  not set

Check whether the installation is successful using openxpkictl start.

Sample output

Starting OpenXPKI...

OpenXPKI Server is running and accepting requests.

DONE.

Do the following to access the OpenXPKI server:
From a web browser, type http://ipaddress/openxpki/.

Add the user name and their corresponding passwords in a userdb.yaml file. To add the user name 
and the password, do the following:

Check out to /home/pkiadm, and then nano userdb.yaml.

Paste the following:

estRA:  

       digest:"{ssha256}somePassword”

       role: RA Operator

Notes
In this instance, estRA refers to the user name. To generate the password, type 
openxpkiadm hashpwd. When a message asking for the password and a ssha256 
encrypted password appears, copy and paste it to the digest of any user.
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Notes
The available roles in the Operator login are RA Operator, CA Operator, and user.

Enter the user name and password.

Create one certificate request, and then test it.

Configuring OpenXPKI CA manually

Overview

Note: Before you begin, make sure that you have a basic knowledge on creating OpenSSL certificates.

To configure OpenXPKI CA manually, create the following:

Root CA certificate. For more information, see Creating a root CA certificate on page 107.

CA signer certificate, signed by the root CA. For more information, see Creating a signer certificate on 
page 107.

Data vault certificate, self‑signed. For more information, see Creating a root CA certificate on page 107.

Web certificate, signed by the signer certificate. For more information, see Setting up the webserver on 
page 130.

Notes

When selecting the signature hash, use either SHA256 or SHA512.

Changing the public key size is optional.

For version 3.10 or later, you can manage the keys directly using the openxpkiadm alias command:

Run mkdir -p /etc/openxpki/local/keys to create the directory. The default location of the directory is /etc/
openxpki/local/keys.

Run openxpkictl start to start the server.

For this instance, we are using the /etc/certs/openxpki_democa/ directory for certificate generation. However, 
you can use any directory.

Creating an OpenSSL configuration file

The OpenSSL configuration file contains X.509 extensions for generating and signing certificate requests.

Run the following command:

nano /etc/certs/openxpki_democa/openssl.conf
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Note: If your server is reachable using the fully qualified domain name (FQDN), then use the DNS of 
the server instead of its IP address.

Sample file

# x509_extensions               = v3_ca_extensions

# x509_extensions               = v3_issuing_extensions

# x509_extensions               = v3_datavault_extensions

# x509_extensions               = v3_scep_extensions

# x509_extensions               = v3_web_extensions

# x509_extensions               = v3_ca_reqexts # not for root 

self-signed, only for issuing

## x509_extensions              = v3_datavault_reqexts # not 

required self-signed

# x509_extensions               = v3_scep_reqexts

# x509_extensions               = v3_web_reqexts

[ req ]

default_bits            = 4096

distinguished_name      = req_distinguished_name

[ req_distinguished_name ]

domainComponent         = Domain Component

commonName              = Common Name

[ v3_ca_reqexts ]

subjectKeyIdentifier    = hash

keyUsage                = digitalSignature, keyCertSign, cRLSign

[ v3_datavault_reqexts ]

subjectKeyIdentifier    = hash

keyUsage                = keyEncipherment

extendedKeyUsage        = emailProtection

[ v3_scep_reqexts ]

subjectKeyIdentifier    = hash

[ v3_web_reqexts ]

subjectKeyIdentifier    = hash

keyUsage                = critical, digitalSignature, 

keyEncipherment

extendedKeyUsage        = serverAuth, clientAuth

[ v3_ca_extensions ]

subjectKeyIdentifier    = hash

keyUsage                = digitalSignature, keyCertSign, cRLSign

basicConstraints        = critical,CA:TRUE

authorityKeyIdentifier  = keyid:always,issuer

[ v3_issuing_extensions ]

subjectKeyIdentifier    = hash
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keyUsage                = digitalSignature, keyCertSign, cRLSign

basicConstraints        = critical,CA:TRUE

authorityKeyIdentifier  = keyid:always,issuer:always

crlDistributionPoints   = URI:https://FQDN of your system/

openxpki/CertEnroll/MYOPENXPKI.crl

authorityInfoAccess     = caIssuers;URI:https://FQDN of your 

system/download/MYOPENXPKI.crt

[ v3_datavault_extensions ]

subjectKeyIdentifier    = hash

keyUsage                = keyEncipherment

extendedKeyUsage        = emailProtection

basicConstraints        = CA:FALSE

authorityKeyIdentifier  = keyid:always,issuer

[ v3_scep_extensions ]

subjectKeyIdentifier    = hash

basicConstraints        = CA:FALSE

authorityKeyIdentifier  = keyid,issuer

[ v3_web_extensions ]

subjectKeyIdentifier    = hash

keyUsage                = critical, digitalSignature, 

keyEncipherment

extendedKeyUsage        = serverAuth, clientAuth

basicConstraints        = critical,CA:FALSE

subjectAltName          = DNS:FQDN of est server

crlDistributionPoints   = URI:https://FQDN of your system/

openxpki/CertEnroll/MYOPENXPKI_ISSUINGCA.cr

authorityInfoAccess     = caIssuers;URI:https://FQDN of your 

system/download/MYOPENXPKI_ISSUINGCA.crt

Replace the IP address and CA certificate name with your setup information.

Save the file.

Creating a password file for certificate keys

Run the following command:

nano /etc/certs/openxpki_democa/pd.pass

Type your password.

Save the file.

Creating a root CA certificate

You can create a self‑signed root CA certificate, or generate a certificate request and then get it signed by the 
root CA.
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Note: Replace the key length, signature algorithm, and certificate name with the appropriate values.

Run the following command:

openssl genrsa -out /etc/certs/openxpki_democa/ca-root-1.key -passout file:/etc/certs/openxpki_democa/
pd.pass 4096

Replace the subject in the request with your CA information using openssl req -new -key /etc/certs/
openxpki_democa/ca-root-1.key -out /etc/certs/openxpki_democa/ca-root-1.csr.

Get the certificate signed by the root CA using openssl req -config /etc/certs/openxpki_democa/
openssl.conf -extensions v3_ca_extensions - x509 -days 3560 -in /etc/certs/openxpki_democa/ca-
root-1.csr -key /etc/certs/openxpki_democa/ca-root-1.key -out /etc/certs/openxpki_democa/ca-root-1.crt - 
sha256.

Go to /etc/certs/openxpki_democa/ where ca-root-1.crt is saved.

Run the following command:

openxpkiadm certificate import --file ca-root-1.crt

Creating a signer certificate

Note: Replace the key length, signature algorithm, and certificate name with the appropriate values.

Run the following command:

openssl genrsa -out /etc/certs/openxpki_democa/ca-signer-1.key -passout file:/etc/certs/
openxpki_democa/pd.pass 4096

Replace the subject in the request with your CA information using openssl req -config /etc/certs/
openxpki_democa/openssl.conf -reqexts v3_ca_reqexts -new -key /etc/certs/openxpki_democa/ca-
signer-1.key -subj /DC=COM/DC=LEXMARK/DC=DEV/DC=CA-ONE/CN=MYOPENXPKI_ISSUINGCA 
-out / etc/certs/openxpki_democa/ca-signer-1.csr.

Get the certificate signed by the root CA using openssl x509 -req -extfile /etc/certs/openxpki_democa/
openssl.conf -extensions v3_issuing_extensions -days 3650 -in /etc/certs/openxpki_democa/ca-
signer-1.csr -CA /etc/certs/openxpki_democa/ca-root-1.crt -CAkey /etc/certs/openxpki_democa/ca-
root-1.key -CAcreateserial -out /etc/certs/openxpki_democa/ca-signer-1.crt -sha256.

Run the following command:

openxpkiadm alias --realm democa --token certsign --file ca-signer-1.crt --key ca-signer-1.key

Creating a vault certificate

Notes

The vault certificate is self‑signed.

Replace the key length, signature algorithm, and certificate name with the appropriate values.
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Run the following command:

openssl req -new -x509 -keyout vault.key -out vault.crt -days 1100 -config /etc/certs/openxpki_democa/
openssl.conf

Change the subject in the request with your CA information using openxpkiadm certificate import --file 
vault.crt.

Run the following command:

openxpkiadm alias --realm democa --token datasafe --file vault.crt --key vault.key

Note: Provide the necessary values, but keep /CN=DataVault as the subject.

Creating a web certificate

Run the following command:

openssl genrsa -out /etc/certs/openxpki_democa/web-1.key -passout file:/etc/certs/openxpki_democa/
pd.pass 4096

Replace the subject in the request with your CA information using openssl req -config /etc/certs/
openxpki_democa/openssl.conf -reqexts v3_web_reqexts -new -key /etc/certs/openxpki_democa/
web-1.key -subj /DC=COM/DC=LEXMARK/DC=DEV/DC=CA-ONE/CN=FQDN of your system -out /etc/
certs/openxpki_democa/web-1.csr.

Run the following command:

openssl x509 -req -extfile /etc/certs/openxpki_democa/openssl.conf -extensions v3_web_extensions -days 
900 -in /etc/certs/openxpki_democa/web-1.csr -CA /etc/certs/openxpki_democa/ca-signer-1.crt -CAkey /
etc/certs/openxpki_democa/ca-signer-1.key -CAcreateserial -out /etc/certs/openxpki_democa/web-1.crt 
-sha256

Setting up the webserver

Run the following commands:

a2enmod ssl rewrite headers
a2ensite openxpki
a2dissite 000-default default-ssl
mkdir -m755 -p /etc/openxpki/tls/chain
cp /etc/certs/openxpki_democa/ca-root-1.crt /etc/openxpki/tls/chain/
cp /etc/certs/openxpki_democa/ca-signer-1.crt /etc/openxpki/tls/chain/
c_rehash /etc/openxpki/tls/chain/
mkdir -m755 -p /etc/openxpki/tls/endentity
mkdir -m700 -p /etc/openxpki/tls/private
cp /etc/certs/openxpki_democa/web-1.crt /etc/openxpki/tls/endentity/openxpki.crt
cat /etc/certs/openxpki_democa/ca-signer-1.crt >> /etc/openxpki/tls/endentity/openxpki.crt
openssl rsa -in /etc/certs/openxpki_democa/web-1.key -passin file:/etc/certs/openxpki_democa/pd.pass 
-out /etc/openxpki/tls/private/openxpki.pem
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chmod 400 /etc/openxpki/tls/private/openxpki.pem

Restart the Apache service using apache2 restart.

Run the following command to check the successful import of the files:

openxpkiadm alias --realm democa

Sample output

=== functional token ===

ca-signer (certsign):

          Alias     : ca-signer-2

          Identifier: XjC6MPbsnyfLZkI9Poi9vm4Z5rk

          NotBefore : 2022-04-06 10:03:01

          NotAfter  : 2032-04-03 10:03:01

vault (datasafe):

          Alias     : vault-2

          Identifier: G8ekluAsskGVC0N-jZhB2n9kvdM

          NotBefore : 2022-04-06 09:53:57

          NotAfter  : 2025-04-10 09:53:57

scep (scep):

          not set

ratoken (cmcra):

          not set

=== root ca ===

current root ca:

          Alias     : root-2

          Identifier: prTHU5vCfcJuCnQWyb5wUknvXQM

          NotBefore : 2022-04-06 09:40:27

          NotAfter  : 2032-01-04 09:40:27

Making the certificate key password available to OpenXPKI

Change the value in the nano /etc/openxpki/config.d/system/crypto.yaml file.

Uncomment the cache: daemon under secret: default:

secret:

  default:

    label: Global Secret group

    export: 0

    method: literal

    value: root

    cache: daemon
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Starting OpenXPKI

Run the openxpkictl start command.

Sample output

Starting OpenXPKI...

OpenXPKI Server is running and accepting requests.

DONE.

Access the OpenXPKI server:
From a web browser, type http://ipaddress/openxpki/.

Add the user names and corresponding passwords in a userdb.yaml file:

Check out to /home/pkiadm and then to nano userdb.yaml.

Paste the following:

estRA:  

       digest:"{ssha256}somePassword”

       role: RA Operator

Note: Here estRA refers to the user name.

To generate the password, type openxpkiadm hashpwd. A message showing the password 
and an ssha256 encrypted password appears.

Copy the password, and then paste it in the digest of any user.

Note: The Operator login has two preconfigured available roles: RA Operator, CA Operator, and 
user.

Type the user name and password.

Create one certificate request, and then test it.

Generating CRL information

Note: If your server is reachable using the FQDN, then use the DNS of the server instead of its IP address.

Stop the OpenXPKI service using openxpkictl stop.

In nano /etc/openxpki/config.d/realm/democa/publishing.yaml, update the connectors: cdp section to 
the following:

class: Connector::Builtin::File::Path

LOCATION: /var/www/openxpki/CertEnroll/
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file: "[% ARGS.0 %].crl"

content: "[% pem %]"

In nano /etc/openxpki/config.d/realm/democa/profile/default.yaml, update the following:

crl_distribution_points: section

critical: 0

uri:

    - https://FQDN of the est/openxkpi/CenrtEnroll/[% 

ISSUER.CN.0 %].crl

    - ldap://localhost/[% ISSUER.DN %]

authority_info_access: section

critical: 0

ca_issuers: http://FQDN of the est/download/

MYOPENXPKI.crt

ocsp: http://ocsp.openxpki.org/

Change the IP address and CA certificate name according to your CA server.

Note: The authority_info_access (AIA) path is saved in the Download folder, but you can set the 
location according to your preference.

In nano /etc/openxpki/config.d/realm/democa/crl/default.yaml, do the following:

If necessary, update nextupdate and renewal.

Add ca_issuers to the following section:

extensions:

            authority_info_access:

                    critical: 0

                    # ca_issuers and ocsp can be scalar 

or list

                    ca_issuers: https://FQDN of the 

est/download/MYOPENXPKI.crt

                   #ocsp: http://ocsp.openxpki.org/

Change the IP address and CA certificate name according to your CA server.

Start the OpenXPKI service using openxpkictl start.

Publishing CRL information

After creating the CRLs, you must publish them to be accessed by all.
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Stop the Apache service using service apache2 stop.

Create a CertEnroll directory for the CRL in the /var/www/openxpki/ directory.

Set openxpki as the owner of this directory, and then configure the permissions to let Apache read and 
execute, and other services to read only.

chown openxpki /var/www/openxpki/CertEnroll
chmod 755 /var/www/openxpki/CertEnroll

Add a reference to the Apache alias.conf file using nano /etc/apache2/mods-enabled/alias.conf.

After the <Directory "/usr/share/apache2/icons"> section, add the following:

            Alias /CertEnroll/ "/var/www/openxpki/CertEnroll/"

             <Directory "/var/www/openxpki/CertEnroll">

               Options FollowSymlinks

               AllowOverride None

               Require all granted

             </Directory>

Add a reference in the apache2.conf file using nano /etc/apache2/apache2.conf.

Add the following in the Apache2 HTTPD server section:

             <Directory /var/www/openxpki/CertEnroll>

               Options FollowSymlinks

               AllowOverride None

               Allow from all

             </Directory>

Start the Apache service using service apache2 start.

Enabling automatic approval of certificate requests in 
OpenXPKI CA

Stop the OpenXPKI service using openxpkictl stop.

In /etc/openxpki/config.d/realm/democa/est/default.yaml, update the eligible: section:

Old content

eligible:

            initial:

                value@: connector:scep.generic.connector.initial

               args: '[% context.cert_subject_parts.CN.0 %]'

               expect:

                   - Build

                   - New
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New content

eligible:

            initial:

                value: 1

                # value@: 

connector:scep.generic.connector.initial

                # args: '[% context.cert_subject_parts.CN.0 %]'

                # expect:

                #    - Build

                #    - New

Notes
Review the space and indention in the script file.

To approve certificates manually, comment value: 1, and then uncomment the other lines that 
are previously commented.

Save the file.

Start the OpenXPKI service using openxpkictl start.

Changing details to enable ca-certs download

Run the following command:

nano /usr/lib/cgi-bin/est.fcgi

Replace my $mime = "application/pkcs7-mime; smime-type=certs-only"; with my $mime = "application/
pkcs7-mime";.

Start the OpenXPKI service using openxpkictl.

Creating a second realm

In OpenXPKI, you can configure multiple PKI structures in the same system. The following topics show how to 
create another realm for MVE named democa-two.

Copying and setting the directory

Create a directory, namely democa2, for the second realm inside /etc/openxpki/config.d/realm.

Copy the /etc/openxpki/config.d/realm/ca-one sample directory tree to a new directory (cp -r /etc/
openxpki/config.d/realm.tpl/*/etc/openxpki/config.d/realm/democa2) within the realm directory.

In /etc/openxpki/config.d/system/realms.yaml, update the following section:
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# This is the list of realms in this PKI

# You only need to enable the realms which are visible on the 

server

democa:

    label: Verbose name of this realm

    baseurl: https://pki.example.com/openxpki/

#democa2:

#    label: Verbose name of this realm

#    baseurl: https://pki.acme.org/openxpki/

New content

# This is the list of realms in this PKI

# You only need to enable the realms which are visible on the 

server

democa:

    label: Example.org Demo CA

    baseurl: https://pki.example.com/openxpki/

democa2:

    label: Example.org Demo CA2

    baseurl: https://pki.example.com/openxpki/

Save the file.

Configuring EST endpoint for multiple realms

You can configure the EST endpoint with a tuple composed of the authority portion of the URI and the optional 
label (for example, www.example.com:80 and arbitraryLabel1). In the following instructions, we use two PKI 
realms, democa and democa2.

Copy the default configuration file in cp /etc/openxpki/est/default.conf /etc/openxpki/est/democa.conf.

Note: Name the file as democa.conf.

In nano /etc/openxpki/est/democa.conf, change the realm value to realm=democa.

Note: According to your needs, you may need to uncomment the corresponding lines for the 
simpleenroll, simplereenroll, csrattrs, and cacerts sections. Keep the environment sections 
commented. Do the same for default.conf.
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Create another configuration file in cp /etc/openxpki/est/default.conf /etc/openxpki/est/democa2.conf.

Note: Name the file as democa2.conf.

In nano /etc/openxpki/est/democa2.conf, change the realm value to realm=democa2.

Note: According to your needs, you may need to uncomment the corresponding lines for the 
simpleenroll, simplereenroll, csrattrs, and cacerts sections. Keep the environment sections 
commented.

Copy the default.yaml file in the following locations:

cp /etc/openxpki/config.d/realm/democa/est/default.yaml

/etc/openxpki/config.d/realm/democa/est/democa.yaml

Note: Name the file as democa.yaml.

Copy the default.yaml file in the following locations:

cp /etc/openxpki/config.d/realm/democa2/est/default.yaml

/etc/openxpki/config.d/realm/democa2/est/democa2.yaml

Note: Name the file as democa2.yaml.

Restart the OpenXPKI service using openxpkictl restart.

Select the following URLs to open the EST server corresponding to a realm via a web browser:

democa—http://ipaddress/est/democa

democa2—http://ipaddress/est/democa2

If you want to differentiate between login credentials and default certificate templates for different PKI realms, 
then you may need advanced configuration.

Creating a signer certificate

The following instructions show how to generate a signer certificate in the second realm. You can use the same 
root and vault certificates as those in the first realm.

Create an OpenSSL configuration file in nano /etc/certs/openxpki_democa2/openssl.conf.

Note: Change the certificate common name so that the user can easily distinguish between different 
certificates for different realms. The certificate files are created in the /etc/certs/openxpki_democa2/
directory.
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Go to the directory of the vault certificate in the first realm, and then import the certificate from the first 
realm.

Run the following code:

openxpkiadm alias --realm democa2 --token datasafe --file vault.crt

Creating a password file for certificate keys

Run the following command:

nano /etc/certs/openxpki_democa2/pd.pass

Type your password.

Create a signer certificate. For more information, see Creating a signer certificate on page 107.

Check whether the import is successful using openxpkiadm alias --realm democa2.

Note: If you changed the key password of the certificate during certificate creation, update nano /etc/
openxpki/config.d/realm/democa2/crypto.yaml.

Generate the CRLs for the second realm. For more information, see Generating CRL information on page 
111.

Note: Make sure that you use the correct CA certificate name according to the realm.

Publish the CRLs for this realm. For more information, see Publishing CRL information on page 133.

Restart the OpenXPKI service using openxpkictl restart.

Sample output

Stopping OpenXPKI

Stopping gracefully, 3 (sub)processes remaining...

DONE.

Starting OpenXPKI...

OpenXPKI Server is running and accepting requests.

DONE.

Enabling multiple active certificates with the same subject to 
be present at a time

By default, in OpenXPKI only one certificate with the same subject name can be active at a time. But when you 
are enforcing multiple Named Certificates, multiple active certificates with the same subject name must be 
present at a time.

In /etc/openxpki/config.d/realm/REALM NAME/est/< REALM NAME >.yaml, from the policy section, 
change the value of max_active_certs from 1 to 0.
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Notes
REALM NAME is the name of the realm. For example, ca‑one.

Review the space and indentation in the script file.

Restart the OpenXPKI service using openxpkictl restart.

Setting the default port number for OpenXPKI CA

By default, Apache listens in port number 443 for https. Set the default port number for OpenXPKI CA to avoid 
conflicts.

In /etc/apache2/ports.conf, modify the 443 port to any other port. For example:

Old content

Listen 80

<IfModule ssl_module>

   Listen 443

</IfModule>

<IfModule mod_gnutls.c>

  Listen 443

</IfModule>

New content

Listen 80

<IfModule ssl_module>

   Listen 9443

</IfModule>

<IfModule mod_gnutls.c>

  Listen 9443

</IfModule>

In /etc/apache2/sites-available/openxpki.conf, add or modify the VirtualHost section to map a new port. 
For example, <VirtualHost *:443> to <VirtualHost *:9443>.

In /etc/apache2/sites-available/default-ssl.conf, add or modify the VirtualHost_default section to map a 
new port. For example, change <VirtualHost *:443> to <VirtualHost *:9443>.

Restart the Apache server using systemctl restart apache2.
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Note: If it asks for the SSL/TLS passphrase, then type the password while adding the TLS web server 
certificate in the EST server.

In tinddopenxpkiweb01.dhcp.dev.lexmark.com:9443 (RSA):, enter the passphrase for the SSL/TLS
keys.

To check the status, run netstat -tlpn| grep apache. The OpenXPKI SCEP URL is now https://ipaddress, and the 
web URL is FQDN:9443/openxpki.

Enabling basic authentication

Run the following command:

apt -y install apache2-utils

Create a user account that has access to the server. Enter the following details:

htpasswd -c /etc/apache2/.htpasswd <username>

                New password:     

                Re-type new password:

                Adding password for user <username>

Go to directory cd /etc/apache2/sites-enabled/.

In nano openxpki.conf, add the following lines in <VirtualHost *: 443 block>:

#HTTPS BASIC AUTH FOR LABELS

Location /.well-known/est/*/simpleenroll

    AuthType Basic

    AuthName "estrealm"

    AuthUserFile /etc/apache2/.htpasswd

    require valid-user

    </Location>

    #HTTPS BASIC AUTH FOR NO LABEL

    <Location /.well-known/est/simpleenroll>

    AuthType Basic

    AuthName "estrealm"

    AuthUserFile /etc/apache2/.htpasswd

    require valid-user

    </Location>

Add ErrorDocument 401 %{unescape:%00} before SSLEngine in the same virtual Host block.

Example
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ServerAlias *

DocumentRoot /var/www/

ErrorDocument 401 %{unescape:%00}

SSLEngine On

Restart the apache2 service using service apache2 restart.

Note: Basic authentication works using the above user name and password.

Enabling Client Certificate Authentication

Go to the following directory: cd /etc/apache2/sites-enabled/.

For the required host in nano openxpki.conf, add SSLVerifyClient require.

For example, if you are using port 443, modify the VirtualHost section to:

<VirtualHost *:443>

SSLVerifyClient require

</VirtualHost>

Remove the SSLVerifyClient optional_no_ca command.

Save the file, and then type quit to exit from MySQL.

Go to the following directory: cd /etc/openxpki/config.d/realm/democa/est.

Open default.yaml and democa.yaml.

Note: If the label is different, then change the YAML file.

Run the following command:

vi default.yaml

In the authorized_signer section, add the following:

authorized_signer:

rule2:

            subject: CN=,.

For example, if your client certificate subject name is test123, then add the following in the 
authorized_signer section:
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authorized_signer:

rule1:

        # Full DN    

        subject: CN=.+:pkiclient,.

rule2:    

        subject: CN=test123,.*

Save the file, and then type quit to exit MySQL.

Restart the OpenXPKI service using openxpkictl restart .

Restart the Apache service using service apache2 restart .

What causes the SAN mismatch error that prevents the system from 
fetching the CRL?

The SAN mismatch error may occur when you are enabling the CRL information. This error indicates that the IP 
or host name does not match the value of the SAN in the web certificate. To avoid getting this error, use the 
FQDN in the path of the CRL instead of the IP. You can also configure the web certificate and use the FQDN of 
your system in the SAN field.

Why are the ca‑signer‑1 and vault‑1 tokens offline?

If the System Status page shows that your ca‑signer‑1 and vault‑1 tokens are offline, then do the following:

In /etc/openxpki/config.d/realm/realm name/crypto.yaml, change the corresponding key value.

Restart the OpenXPKI service.
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Overview
Alerts are triggered when a printer requires attention. Actions let you send customized e-mails or run scripts when 
an alert occurs. Events define which actions are executed when specific alerts are active. To register for alerts 
from a printer, create actions and then associate them with an event. Assign the event to the printers that you 
want to monitor.

Note: This feature is not applicable to secured printers.

Creating an action
An action is either an email notification or an event viewer log. Actions assigned to events are triggered when a 
printer alert occurs.

From the Printers menu, click Events & Actions › Actions › Create.

Type a unique name for the action and its description.

Select an action type.

Email

Note: Before you begin, make sure that the email settings are configured. For more information, see 
Configuring e‑mail settings on page 155.

In the Type menu, select E‑mail.

Type the appropriate values in the fields. You can also use the available placeholders as the entire 
or part of the subject title, or as part of an email message. For more information, see 
Understanding action placeholders on page 144.

Click Create Action.

Log event
In the Type menu, select Log event.

Type the event parameters. You can also use the available placeholders in the drop‑down menu. 
For more information, see Understanding action placeholders on page 144

Managing printer alerts
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Click Create Action.

Understanding action placeholders
Use the available placeholders in the subject title or e‑mail message. Placeholders represent variable elements, 
and are replaced with actual values when used.

${eventHandler.timestamp}—The date and time that MVE processed the event. For example, Mar 14, 
2017 1:42:24 PM.

${eventHandler.name}—The name of the event.

${configurationItem.name}—The system name of the printer that triggered the alert.

${configurationItem.address}—The MAC address of the printer that triggered the alert.

${configurationItem.ipAddress}—The IP address of the printer that triggered the alert.

${configurationItem.ipHostname}—The host name of the printer that triggered the alert.

${configurationItem.model}—The model name of the printer that triggered the alert.

${configurationItem.serialNumber}—The serial number of the printer that triggered the alert.

${configurationItem.propertyTag}—The property tag of the printer that triggered the alert.

${configurationItem.contactName}—The contact name of the printer that triggered the alert.

${configurationItem.contactLocation}—The contact location of the printer that triggered the alert.

${configurationItem.manufacturer}—The manufacturer of the printer that triggered the alert.

${alert.name}—The name of the alert that is triggered.

${alert.state}—The state of the alert. It can be active or cleared.

${alert.location}—The location within the printer where the triggered alert occurred.

${alert.type}—The severity of the triggered alert, such as Warning or Intervention Required.

Managing actions
From the Printers menu, click Events & Actions > Actions.

Do any of the following:
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Edit an action

Select an action, and then click Edit.

Configure the settings.

Click Save Changes.

Delete actions

Select one or more actions.

Click Delete, and then confirm deletion.

Test an action

Select an action, and then click Test.

>To verify the test results, see the tasks logs.

Notes
For more information, see Viewing logs on page 151.

If you are testing an e‑mail action, then verify if the e‑mail was sent to the recipient.

Creating an event
You can monitor alerts in your printer fleet. Create an event, and then set an action to execute when the specified 
alerts occur. Events are not supported in secured printers.

From the Printers menu, click Events & Actions > Events > Create.

Type a unique name for the event and its description.

From the Alerts section, select one or more alerts. For more information, see Understanding printer alerts
on page 146.

From the Actions section, select one or more actions to execute when the selected alerts are active.

Note: For more information, see Creating an action on page 143.

Enable the system to execute selected actions when alerts are cleared on the printer.

Set a grace period before executing any selected actions.

Note: If the alert is cleared during the grace period, then the action is not executed.

Click Create Event.
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Understanding printer alerts
Alerts are triggered when a printer requires attention. The following alerts can be associated with an event in 
MVE:

Automatic Document Feeder (ADF) jam—A paper is jammed in the ADF and must be physically 
removed.

Scanner ADF Exit Jam

Scanner ADF Feeder Jam

Scanner ADF Inverter Jam

Scanner ADF Paper Cleared

Scanner ADF Paper Missing

Scanner ADF PreRegistration Jam

Scanner ADF Registration Jam

Scanner Alert - Replace All Originals if Restarting Job

Door or cover open—A door is open on the printer and must be closed.

Check Door/Cover - Mailbox

Door Open

Cover Alert

Cover Closed

Cover Open

Cover Open Or Cartridge Missing

Duplex Cover Open

Scanner ADF Cover Open

Scanner Jam Access Cover Open

Incorrect media size or type—A job is printing and requires certain paper to be loaded in a tray.

Incorrect Envelope Size

Incorrect Manual Feed

Incorrect Media

Incorrect Media Size

Load Media

Memory full or error—The printer is running low on memory and must apply changes.

Complex Page

Files Will Be Deleted

Insufficient Collation Memory

Insufficient Defrag Memory

Insufficient Fax Memory

Insufficient Memory

Insufficient Memory - Held Jobs May Be Lost
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Insufficient Memory For Resource Save

Memory Full

PS Memory Shortage

Scanner Too Many Pages - Scan Job Canceled

Resolution Reduction

Option malfunction—An option attached to the printer is in an error state. Options include input options, 
output options, font cards, user flash cards, disks, and finishers.

Check Alignment/Connection

Check Duplex Connection

Check Finisher/Mailbox Installation

Check Power

Corrupted Option

Defective Option

Detach Device

Duplex Alert

Duplex Tray Missing

External Network Adapter Lost

Finisher Alert

Finisher Door Or Interlock Open

Finisher Paper Wall Open

Incompatible Duplex Device

Incompatible Input Device

Incompatible Output Device

Incompatible Unknown Device

Incorrect Option Installation

Input Alert

Input Configuration Error

Option Alert

Output Bin Full

Output Bin Nearly Full

Output Configuration Error

Option Full

Option Missing

Paper Feed Mechanism Missing

Print Jobs On Option

Reattach Device

Reattach Output Device

Too Many Inputs Installed

Too Many Options Installed
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Too Many Outputs Installed

Tray Missing

Tray Missing During Power On

Tray Sensing Error

Uncalibrated Input

Unformatted Option

Unsupported Option

Reattach Input Device

Paper jam—A paper is jammed in the printer and must be physically removed.

Internal Paper Jam

Jam Alert

Paper Jam

Scanner error—The scanner has a problem.

Scanner Back Cable Unplugged

Scanner Carriage Locked

Scanner Clean Flatbed Glass/Backing Strip

Scanner Disabled

Scanner Flatbed Cover Open

Scanner Front Cable Unplugged

Scanner Invalid Scanner Registration

Supplies error—A printer supply has a problem.

Abnormal Supply

Cartridge Region Mismatch

Defective Supply

Fuser Unit Or Coating Roller Missing

Invalid Or Missing Left Cartridge

Invalid Or Missing Right Cartridge

Invalid Supply

Priming Failure

Supply Alert

Supply Jam

Supply Missing

Toner Cartridge Eject Handle Pulled

Toner Cartridge Not Installed Correctly

Uncalibrated Supply

Unlicensed Supply

Unsupported Supply

Supplies or consumable empty—A printer supply must be replaced.
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Input Empty

Life Exhausted

Printer Ready for Maintenance

Scheduled Maintenance

Supply Empty

Supply Full

Supply Full or Missing

Note: The printer sends the alert as an error and a warning. If one of these alerts is triggered, then its 
associated action occurs twice.

Supplies or consumable low—A printer supply is running low.

Early Warning

First Low

Input Low

Life Warning

Nearly Empty

Nearly Low

Supply Low

Supply Nearly Full

Uncategorized alert or condition

Color Calibration Failure

Data Transmission Error

Engine CRC Failure

External Alert

Fax Connection Lost

Fan Stall

Hex Active

Insert Duplex Page and Press Go

Internal Alert

Internal Network Adapter Needs Service

Logical Unit Alert

Offline

Offline for Warning Prompt

Operation Failed

Operator Intervention Alert

Page Error

Port Alert

Port Communication Failure

Port Disabled
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Power Saver

Powering Off

PS Job Timeout

PS Manual Timeout

Setup Required

SIMM Checksum Error

Supply Calibrating

Toner Patch Sensing Failed

Unknown Alert Condition

Unknown Configuration

Unknown Scanner Alert Condition

User(s) Locked Out

Warning Alert

Managing events

Edit an event

From the Printers menu, click Events & Actions › Events.

Select an event, and then click Edit.

Configure the settings.

Click Save Changes.

Delete events

From the Printers menu, click Events & Actions › Events.

Select one or more events.

Click Delete, and then confirm deletion.
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Overview
Tasks are any printer management activities performed in MVE, such as printer discovery, audit, and 
configurations enforcement. The Status page shows the status of all currently running tasks and the tasks run in 
the last 72 hours. Information on the currently running tasks is entered into the log. Tasks older than 72 hours can 
be viewed only as individual log entries in the Log page, and can be searched using the task IDs.

Viewing the task status
From the Tasks menu, click Status.

Note: The task status is updated in real time.

Stopping tasks
From the Tasks menu, click Status.

From the Currently Running Tasks section, select one or more tasks.

Click Stop.

Viewing logs
From the Tasks menu, click Logs.

Select task categories, task types, or a time period.

Notes
Use the search field to search for multiple Task IDs. Use commas to separate multiple Task IDs 
or a hyphen to indicate a range. For example, 11, 23, 30-35.

To export the search results, click Export to CSV.

Clearing logs
From the Tasks menu, click Log.

Click Clear Log, and then select a date.

Click Clear Log.

Viewing task status and history
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Exporting logs
From the Tasks menu, click Log.

Select task categories, task types, or a time period.

Click Export to CSV.
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Creating a schedule
From the Tasks menu, click Schedule › Create.

From the General section, type a unique name for the scheduled tasks and its description.

From the Task section, do one of the following:

Schedule an audit
Select Audit.

Select a saved search.

Schedule a conformance check
Select Conformance.

Select a saved search.

Schedule a printer status check
Select Current Status.

Select a saved search.

Select an action.

Schedule a configuration deployment
Select Deploy File.

Select a saved search.

Browse to the file, and then select the file type.

If necessary, select a deployment method or protocol.

Schedule a discovery
Select Discovery.

Select a discovery profile.

Schedule a configuration enforcement
Select Enforcement.

Select a saved search.

Schedule a certificate validation

Select Validate Certificate.

Note: During validation, MVE communicates with the CA server to download the certificate chain and 
the Certificate Revocation List (CRL). The enrollment agent certificate is also generated. This certificate 
enables the CA server to trust MVE.

Schedule a view export
Select View Export.

Select a saved search.

Scheduling tasks
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Select a view template.

Type the list of email addresses where the exported files are sent.

From the Schedule section, set the date, time, and frequency of the task.

Click Create Scheduled Task.

Managing scheduled tasks

Edit a scheduled task

From the Tasks menu, click Schedule.

Select a task, and then click Edit.

Configure the settings.

Click Edit Scheduled Task.

Note: The Last Run information is removed when a scheduled task is edited.

Delete a scheduled task

From the Tasks menu, click Schedule.

Select a task, and then click Delete.

Click Delete Scheduled Task.
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Configuring general settings

Click  on the upper‑right corner of the page.

Click General, and then select a host name source.

Printer—The system retrieves the host name from the printer.

Reverse DNS Lookup—The system retrieves the host name from the DNS table using the IP 
address.

Set the alert reregistration frequency.

Note: Printers may lose the alert registration state when changes are made, such as rebooting or 
updating the firmware. MVE attempts to recover the state automatically on the next interval set in the 
alert reregistration frequency.

Configure the following system log settings:

System log cleanup start time—The time when the cleanup of system or task logs starts.

System log retention period (weeks)—The number of weeks that system logs are stored in the 
database.

Note: Entries stored in the database for more than 52 weeks are removed.

System log archive—Allows the system to archive the system logs and the encoded entries on 
the file system. The destination and format of the archive files are defined in the log4j2.xml file.

Click Save Changes.

Configuring e‑mail settings
Enable SMTP configuration to let MVE send data export files and event notifications through e‑mail.

Click  on the upper‑right corner of the page.

Click E‑mail, and then select Enable E‑mail SMTP configuration.

Type the SMTP mail server and port.

Select the proper encryption.

Notes
For SSL encryption, select port 465.

For TLS/STARTTLS encryption, select port 587.

Performing other administrative tasks
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Type the e‑mail address of the sender.

If a user must log in before e‑mailing, then select Login required, and then type the user credentials.

Click Save Changes.

Adding a login disclaimer
You can configure a login disclaimer to be shown when users log in with a new session. Users must accept the 
disclaimer before they can access MVE.

Click  on the upper‑right corner of the page.

Click Disclaimer, and then select Enable disclaimer prior to login.

Type the disclaimer text.

Click Save Changes.

Signing the MVE certificate
Secure Socket Layer (SSL) or Transport Layer Security (TLS) is a security protocol that uses data encryption and 
certificate authentication to protect server‑client communication. In MVE, TLS is used to protect the sensitive 
information shared between the MVE server and the web browser. The protected information can be printer 
passwords, security policies, MVE user credentials, or printer authentication information, such as LDAP or 
Kerberos.

TLS enables the MVE server and the web browser to encrypt the data before sending it, and then decrypt it after 
it is received. SSL also requires the server to present the web browser with a certificate that proves that the 
server is who it claims to be. This certificate is either self-signed or signed using a trusted third-party CA. By 
default, MVE is configured to use a self-signed certificate.

Download the certificate signing request.

Click  on the upper‑right corner of the page.

Click TLS > Download.

Select Certificate signing request.

Note: The certificate signing request includes Subject Alternative Names (SANs).

Use a trusted CA to sign the certificate signing request.

Install the CA-signed certificate.

Click  on the upper‑right corner of the page.

Click TLS > Install Signed Certificate.

Upload the CA-signed certificate, and then click Install Certificate.

Click Restart MVE Service.

Note: Restarting the MVE service reboots the system, and the server may be unavailable for the 
next few minutes. Before restarting the service, make sure that no tasks are currently running.
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Removing user information and references
MVE is compliant with the data protection rules under General Data Protection Regulation (GDPR). MVE can be 
configured to apply the right to be forgotten and remove private user information from the system.
Removing users

Click  on the upper‑right corner of the page.

Click User, and then select one or more users.

Click Delete > Delete Users.

Removing user references in LDAP

Click  on the upper‑right corner of the page.

Click LDAP.

Remove any user‑related information in the search filters and binding settings.

Removing user references in the e-mail server

Click  on the upper‑right corner of the page.

Click E‑mail.

Remove any user‑related information, such as user credentials used for authenticating with the e‑mail 
server.

Removing user references in a configuration

From the Configurations menu, click All Configurations.

Click the configuration name.

From the Basic tab, remove any user‑related values from the printer settings, such as contact name and 
contact location.

Removing user references in an advanced security component

From the Configurations menu, click All Advanced Security Components.

Click the component name.

From the Advanced Security Settings section, remove any user‑related values.

Removing user references in saved searches

From the Printers menu, click Saved Searches.

Click a saved search.

Remove any search rule that uses any user‑related values, such as contact name and contact location.

Removing user references in keywords
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From the Printers menu, click Printer Listing.

Unassign user‑related keywords from the printers.

From the Printers menu, click Keywords.

Remove any keyword that uses user‑related information.

Removing user references in events and actions

From the Printers menu, click Events & Actions.

Remove any actions that contain e‑mail references to users.
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Overview
Active Directory Federation Services (ADFS) is an identity access solution that provides client computers with 
Single Sign-On (SSO) access to protected applications or services. Users can access these applications or 
services even when their accounts and applications are in completely different networks or organizations.
ADFS uses Security Assertion Markup Language (SAML) authentication and Claims-based Access Control 
(CBAC) authorization to ensure security across applications using the federated identity.
You must establish encrypted communication between the MVE and ADFS servers. To do so, ADFS must trust 
the MVE server. ADFS also contains user groups from the Active Directory (AD) server that must correspond to 
the required MVE user roles.
When you set up the ADFS server, the following information is required from the MVE application:

Relying party trust identifier—https://mve-host/mve/saml

Relying party SAML 2.0 SSO Service URL or Endpoint—https://mve-host/mve/adfs/saml

Note: In the URLs, mve-host is the IP address or FQDN of the MVE server.

Setting the claim‑issuance policy for GroupRule
From the AD FS window, click Relying Party Trusts, and then right-click the applicable relying‑party trust.

Click Edit Claim Issuance Policy, and then Add Rule.

From the Claim rule template list, select Send LDAP Attributes as Claims.

In the Claim rule name field, type GroupRule.

From the Attribute store list, select Active Directory.

Set LDAP attribute to Token-Groups - Unqualified Names, and then set Outgoing Claim Type to 
MVEGroup.

Click Finish.

Setting the claim‑issuance policy for Name ID
From the AD FS window, click Relying Party Trusts, and then right-click the applicable relying‑party trust.

Click Edit Claim Issuance Policy, and then Add Rule.

From the Claim rule template list, select Send LDAP Attributes as Claims.

In the Claim rule name field, type Name ID.

From the Attribute store list, select Active Directory.

Set LDAP attribute to SAM-Account-Name, and then set Outgoing Claim Type to Name ID.

Click Finish.

Managing SSO
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Enabling ADFS Server authentication

Click  on the upper‑right corner of the page.

Click ADFS, and then select Enable ADFS for authentication.

In the SSO URL (Required) field, type the SSO URL that is published by the ADFS server as an identity 
provider.

In the ADFS Groups to MVE Role Mapping section, enter the ADFS group names that correspond to the 
MVE roles.

Click Save Changes.

Accessing MVE by way of ADFS
When you enable ADFS, and then access MVE, the ADFS login page automatically opens. Perform the 
authentication on the ADFS page before you are redirected to the MVE home page.

Open a web browser, and then type https://MVE_SERVER/mve/, where MVE_SERVER is the host name 
or IP address of the server hosting MVE.

When the ADFS login page opens, enter your ADFS credentials, and then click Sign in.

Notes

If users encounter issues when accessing MVE by way of ADFS, then administrators can log in to MVE 
using their localhost credentials and resolve the issue.

If ADFS is not configured in the MVE server, then the default MVE login page is displayed for both 
localhost and non-localhost users. In this case, the users must log in to MVE using the accounts that 
are configured in the MVE server.

Logging out from MVE
If you accessed MVE using ADFS, then the Log out button does not appear on the MVE home page. The MVE 
session ends only if you close the MVE page or the MVE session is idle for more than 30 minutes. If you try to 
access the MVE URL after 30 minutes of inactivity, then you are redirected to the ADFS login page.

Note: If you accessed MVE using your localhost MVE credentials, then the Log out button still appears on the 
MVE home page.
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Markvision Enterprise FAQ

Why can I not choose multiple printers in the supported 
models list when creating a configuration?

Configuration settings and commands differ between printer models.

Can other users access my saved searches?

Yes. All users can access saved searches.

Where can I find the log files?

You can find the installation log files in the hidden directory of the user installing MVE. For example, C:
\Users\Administrator\AppData\Local\Temp\mveLexmark-install.log.

You can find the *.log application log files in the installation_dir\Lexmark\Markvision Enterprise\tomcat\logs folder, 
where installation_dir is the installation folder of MVE.

What is the difference between host name and reverse 
DNS lookup?

A host name is a unique name assigned to a printer on a network. Each host name corresponds to an IP address. 
Reverse DNS lookup is used to determine the designated host name and domain name of a given IP address.

Where can I find reverse DNS lookup in MVE?

Reverse DNS lookup can be found in the general settings. For more information, see Configuring general settings
on page 155.

How do I manually add rules to the Windows firewall?

Run the command prompt as an administrator, and then type the following:

firewall add allowedprogram "installation_dir/Lexmark/Markvision Enterprise/tomcat/bin/tomcat9.exe" "Markvision 
Enterprise Tomcat"
firewall add portopening UDP 9187 "Markvision Enterprise NPA UDP"
firewall add portopening UDP 6100 "Markvision Enterprise LST UDP"
Where installation_dir is the installation folder of MVE.

Frequently asked questions
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How do I set up MVE to use a different port than port 
443?

Stop the Markvision Enterprise service.

Open the Run dialog box, and then type services.msc.

Right‑click Markvision Enterprise, and then click Stop.

Open the installation_dir\Lexmark\Markvision Enterprise\tomcat\conf\server.xml file.

Where installation_dir is the installation folder of MVE.

Change the Connector port value to another unused port.

<Connector port="443" 

protocol="org.apache.coyote.http11.Http11NioProtocol" 

sslImplementationName="org.apache.tomcat.util.net.jsse.JSSEImple

mentation" 

SSLEnabled="true" scheme="https" secure="true" 

clientAuth="false" 

compression="on" compressableMimeType="text/html,text/xml,text/

plain,text/css,

text/javascript,application/javascript,application/json" 

maxThreads="150" 

maxHttpHeaderSize="16384" minSpareThreads="25" 

enableLookups="false" 

acceptCount="100" connectionTimeout="120000" 

disableUploadTimeout="true" 

URIEncoding="UTF-8" server="Apache" 

sslEnabledProtocols="TLSv1,TLSv1.1,TLSv1.2" 

sslProtocol="TLS" keystoreFile="C:/Program Files/Lexmark/

Markvision Enterprise/

../mve_truststore.p12" keystorePass="markvision" keyAlias="mve" 

keyPass="markvision" 

keystoreType="PKCS12" 

ciphers="TLS_ECDHE_RSA_WITH_AES_128_CBC_SHA256,

TLS_ECDHE_RSA_WITH_AES_128_CBC_SHA,TLS_RSA_WITH_AES_128_CBC_SHA2

56,

TLS_RSA_WITH_AES_128_CBC_SHA"/>

Change the redirectPort value to the same port number used as the connector port.

<Connector port="9788" maxHttpHeaderSize="16384" 

maxThreads="150" minSpareThreads="25" 

enableLookups="false" redirectPort="443" acceptCount="100" 

connectionTimeout="120000" 

disableUploadTimeout="true" compression="on" 

compressableMimeType="text/html,text/xml,

text/plain,text/css,text/javascript,application/



Frequently asked questions

163

5.

a.

b.

6.

1.

a.

b.

2.

3.

4.

a.

b.

1.

◦

◦

2.

3.

javascript,application/json" 

URIEncoding="UTF-8" server="Apache"/>

Restart the Markvision Enterprise service.

Open the Run dialog box, and then type services.msc.

Right‑click Markvision Enterprise, and then click Restart.

Access MVE using the new port.

For example, open a web browser, and then type https://MVE_SERVER:port/mve.

Where MVE_SERVER is the host name or IP address of the server hosting MVE, and port is the 
connector port number.

How do I customize the ciphers and TLS versions that 
MVE uses?

Stop the Markvision Enterprise service.

Open the Run dialog box, and then type services.msc.

Right‑click Markvision Enterprise, and then click Stop.

Open the installation_dir\Lexmark\Markvision Enterprise\tomcat\conf\server.xml file.

Where installation_dir is the installation folder of MVE.

Configure the ciphers and TLS versions.

For more information on the configuration, see the Apache Tomcat SSL/TLS configuration instructions.

For more information on the protocols and cipher values, see the Apache Tomcat SSL support information 
documentation.

Restart the Markvision Enterprise service.

Open the Run dialog box, and then type services.msc.

Right‑click Markvision Enterprise, and then click Restart.

How do I manage CRL files when using Microsoft CA 
Enterprise?

Obtain the CRL file from the CA server.

Notes
For Microsoft CA Enterprise, the CRL is not automatically downloaded through SCEP.

For more information, see the Microsoft Certificate Authority Configuration Guide.

Save the CRL file in the installation_dir\Lexmark\Markvision Enterprise\apps\library\crl folder, where 
installation_dir is the installation folder of MVE.

Configure the certificate authority in MVE.

https://tomcat.apache.org/tomcat-9.0-doc/ssl-howto.html#Configuration
https://tomcat.apache.org/tomcat-9.0-doc/config/http.html#SSL_Support
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Troubleshooting

165

1.

2.

3.

4.

•

•

1.

2.

3.

4.

5.

6.

7.

 

User has forgotten the password
Reset the user password
You need administrative rights to reset the password.

Click  on the upper‑right corner of the page.

Click User, and then select a user.

Click Edit, and then change the password.

Click Save Changes.

If you have forgotten your own password, then do either of the following:

Contact another Admin user to reset your password.

Contact Lexmark Customer Support Center.

Admin user has forgotten the password
Create another Admin user, and then delete the previous account
You can use the Markvision Enterprise Password Utility to create another Admin user.

Browse to the folder where Markvision Enterprise is installed.

For example, C:\Program Files\

Launch the mvepwdutility-windows.exe file in the Lexmark\Markvision Enterprise\ directory.

Select a language, and then click OK > Next.

Select Add User Account > Next.

Enter the user credentials.

Click Next.

Access MVE, and then delete the previous Admin user.

Note: For more information, see Managing users on page 31.

Page does not load
Clear the cache, and delete the cookies in your web browser Access the MVE login page, and then log in using 
your credentials
Open a web browser, and then type https://MVE_SERVER/mve/login, where MVE_SERVER is the host name or 
IP address of the server hosting MVE.

Troubleshooting
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Cannot discover a network printer

Remedy

Try one or more of the following:

Make sure that the printer is turned on.

Make sure that the power cord is securely plugged into the printer and into a properly grounded electrical 
outlet.

Make sure that the printer is connected to the network.

Restart the printer.

Make sure that TCP/IP is enabled on the printer.

Make sure that the ports used by MVE are open, and SNMP and mDNS are enabled. For more 
information, see Understanding ports and protocols on page 211.

Contact your Lexmark representative.

Incorrect printer information
Perform an audit
For more information, see Auditing printers on page 62.

MVE does not recognize a printer as a secured 
printer

Make sure that the printer is secured Make sure that mDNS is turned on and is not blocked Delete the printer, 
and then rerun the printer discovery
For more information, see Discovering printers chapter.

Enforcement of configurations with multiple 
applications fails in the first attempt but succeeds 
in the subsequent attempts

Increase the timeouts

Browse to the folder where Markvision Enterprise is installed.

For example, C:\Program Files\

Navigate to the Lexmark\Markvision Enterprise\apps\dm-mve\WEB-INF\classes folder.

Using a text editor, open the platform.properties file.

Edit the cdcl.ws.readTimeout value.

Notes
The value is in milliseconds. For example, 90000 milliseconds is equal to 90 seconds.

Using a text editor, open the devCom.properties file.



Troubleshooting

167

6.

7.

8.

Edit the lst.responseTimeoutsRetries values.

Notes
The value is in milliseconds. For example, 10000 milliseconds is equal to 10 seconds.

For example, lst.responseTimeoutsRetries=10000 15000 20000. The first connection retry is after 10 
seconds, the second connection retry is after 15 seconds, and the third connection retry is after 20 
seconds.

If necessary, when you are using LDAP GSSAPI, then create a parameters.properties file.

Add the following setting: lst.negotiation.timeout=400

Notes
The value is in seconds.

Save the changes.

Enforcement of configurations with printer 
certificate fails

Increase the number of enrolment retries
Add the following key in the platform.properties file:

enrol.maxEnrolmentRetry=10

The retry value must be greater than five.

OpenXPKI Certificate Authority

Certificate issuance failed using the OpenXPKI CA 
server

Make sure that the “signer on behalf” key in MVE matches the authorized signer key in the CA server
For example:

If the following is the ca.onBehalf.cn key in the platform.properties file in MVE,

ca.onBehalf.cn=Markvision_SQA-2012-23AB.lrdc.lexmark.ds

then the following must be the authorized_signer key in the generic.yaml file in the CA server.

rule1:

            # Full DN

                    Subject: 

CN=Markvision_SQA-2012-23AB.lrdc.lexmark.ds

For more information on configuring the OpenXPKI CA server, see the OpenXPKI Certificate Authority 
Configuration Guide.
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An internal server error occurs

Install the en_US.utf8 locale

Run the dpkg-reconfigure locales command.

Install the en_US.utf8 (locale -a | grep en_US) locale.

The login prompt does not appear

Enable fcgid
Run the following commands:

a2enmod fcgid

service apache2 restart

A nested connector without class error occurs

Update scep.scep-server-1
In /etc/openxpki/config.d/realm/REALM/scep/generic.yaml, replace scep.scep-server-1 with scep.generic.

Note: Replace REALM with the name of your realm. For example, when using the default realm, use ca-one.

eligible:

     initial:

            value@: connector:scep.generic.connector.initial

Cannot manually approve certificates

Update scep.scep-server-1
In /etc/openxpki/config.d/realm/REALM/scep/generic.yaml, replace scep.scep-server-1 with scep.generic.

Note: Replace REALM with the name of your realm. For example, when using the default realm, use ca-one.

eligible:

     initial:

            value@: connector:scep.generic.connector.initial

A Perl error occurs when approving enrollment 
requests

Update scep.scep-server-1
In /etc/openxpki/config.d/realm/REALM/scep/generic.yaml, replace scep.scep-server-1 with scep.generic.

Notes
Replace REALM with the name of your realm. For example, when using the default realm, use ca-one.
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eligible:

     initial:

            value@: connector:scep.generic.connector.initial

The ca-signer-1 and vault-1 tokens are offline

Change the certificate key password
In /etc/openxpki/config.d/realm/ca-one/crypto.yaml, change the certificate key password.

Create correct symlinks and copy the key file
For more information, see Copying the key file and creating a symlink on page 108.
Make sure that the key file is readable by OpenXPKI
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Differences in supported databases data types
MVE supports Firebird and Microsoft SQL Server. The following table shows the Firebird data types used in MVE 
and their corresponding data types in Microsoft SQL Server.
Firebird data types Microsoft SQL Server data types

BIGINT Bigint

VARCHAR(x) varchar(x)

TIMESTAMP Datetime

INTEGER Int

SMALLINT/ TINYINT* Bit

BLOB SUB_TYPE 0 varbinary(1024)

*This data type is required for Microsoft SQL Server.

FRAMEWORK tables and field names
This document lists and explains most of the tables in the FRAMEWORK database and describes the fields that 
each table contains. The tables and columns in the database are subject to change from one release to the next.

Printer

The following tables deal with the logical representation of a physical printer.

CONFIG_ITEM

The CONFIG_ITEM table represents the ITIL configuration items (CI) of the printer. It shows the state of the CI 
and time stamps of its creation, initial management, last discovery, and other actions. The table does not 
represent any physical portion of a printer; it is simply an abstract representation of the device.
Field Name Data Type Description

CI_ID BIGINT Primary key.

CI_STATE VARCHAR(255) The current state of the CI. The 
options are NEW, MANAGED, 
MISSING, FOUND, CHANGED, 
UNMANAGED, and RETIRED.

CREATION_DATE TIMESTAMP The date when the CI first 
entered the system.

INITIAL_MANAGEMENT_DATE TIMESTAMP The date when the CI first 
entered the MANAGED state or 
substate.

Database access
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Field Name Data Type Description

LAST_AUDIT_DATE TIMESTAMP The date of the last audit 
attempted on the CI (whether or 
successful or not).

PRINTER_ID BIGINT The foreign key to 
NETWORK_PRINTER.PRINTE
R_ID.

LAST_DISCOVERY_DATE TIMESTAMP The date when the last discovery 
was attempted on the CI 
(whether successful or not).

LAST_SUCCESSFUL_AUDIT_D
ATE

TIMESTAMP The date of the last successful 
audit of the CI.

LAST_SUCCESSFUL_DISCOV
ERY_ DATE

TIMESTAMP The date of the last successful 
discovery of the CI.

DEFAULT_CERT_COMMON_N
AME

VARCHAR(255) The name of the default 
certificate.

DEFAULT_CERT_ISSUER_NA
ME

VARCHAR(255) The name of the issuer of the 
certificate.

DEFAULT_CERT_SIGNING_ST
ATUS

VARCHAR(255) The certificate signing status of 
the printer. The options are 
SIGNED, INVALID_CERT, 
NO_CA, and UNKNOWN.

DEFAULT_CERT_VALID_FROM TIMESTAMP The starting date of the validity 
of the certificate.

DEFAULT_CERT_VALID_TO TIMESTAMP The last date of the validity of 
the certificate.

DEFAULT_CERTIFICATE VARCHAR(8190) The default certificate.

DEFAULT_CERT_SERIAL_NUM
BER

VARCHAR(255) The serial number of the default 
certificate.

NETWORK_ADAPTER

This table represents the network adapter (also known as the print server) of a physical printer.
Field name Data type Description

ADAPTER_TYPE VARCHAR(31) Always INA (internal network 
adapter).

ADAPTER_ID BIGINT The primary key.

FIRMWARE_REVISION VARCHAR(255) The current network firmware 
revision.

MANUFACTURER VARCHAR(255) N/A.

MODEL_NAME VARCHAR(255) N/A.

SERIAL_NUMBER VARCHAR(50) N/A.

SYSTEM_NAME VARCHAR(255) N/A.
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RETRIES INTEGER The number of times to retry 
communicating with a printer.

SNMP_READ_COMMUNITY_N
AME

VARCHAR(255) The SNMP community name for 
reading.

TIMEOUT BIGINT The number of milliseconds to 
wait for a particular 
communication attempt with a 
printer to succeed.

CONTACT_LOCATION VARCHAR(255) N/A.

CONTACT_NAME VARCHAR(255) N/A.

DOMAIN_NAME_SUFFIX VARCHAR(191) The domain name suffix 
associated with this network 
adapter (for example, 
foo.lexmark.com). Combine with 
HOSTNAME to get the fully 
qualified domain name (FQDN).

HOSTNAME VARCHAR(63) The host name associated with 
this network adapter. MVE can 
be configured to retrieve the host 
name from DNS or from the 
network adapter itself. Combine 
with DOMAIN_NAME_SUFFIX 
to get the fully qualified domain 
name (FQDN).

IP_ADDRESS VARCHAR(15) The integer representation of the 
IP address of this network 
adapter. Deprecated.

IP_ADDRESS_INT INTEGER The integer representation of the 
IP address of this network 
adapter.

IP_ADDRESS_SUBNET INTEGER The integer representation of the 
subnet on which this network 
adapter resides.

MAC_CANONICAL VARCHAR(12) The MAC address of the network 
adapter, in canonical format.

PORTS INTEGER The number of ports that the 
network adapter supports. 
Always 1.

RAND_MAC SMALLINT/ TINYINT* The flag indicating whether the 
current value of 
MAC_CANONICAL was 
randomly generated.

CREDENTIAL_REQUIRED SMALLINT/ TINYINT* The flag indicating whether a 
credential is necessary to 
communicate with the 
associated printer.

CREDENTIAL_PASSWORD BLOB SUB_TYPE 0 This value is encrypted and not 
available for use outside MVE.
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CREDENTIAL_PIN BLOB SUB_TYPE 0 This value is encrypted and not 
available for use outside MVE.

CREDENTIAL_REALM VARCHAR(64) The credential realm, if set.

CREDENTIAL_USERNAME VARCHAR(255) The credential username, if set.

PORT_CONFIG_LST_TCP_OP
EN

SMALLINT/ TINYINT* The flag indicating whether this 
port on the associated printer is 
open.

PORT_CONFIG_LST_UDP_OP
EN

SMALLINT/ TINYINT* The flag indicating whether this 
port on the associated printer is 
open.

PORT_CONFIG_MDNS_OPEN SMALLINT/ TINYINT* The flag indicating whether this 
port on the associated printer is 
open.

PORT_CONFIG_NPA_TCP_OP
EN

SMALLINT/ TINYINT* The flag indicating whether this 
port on the associated printer is 
open.

PORT_CONFIG_NPA_UDP_OP
EN

SMALLINT/ TINYINT* The flag indicating whether this 
port on the associated printer is 
open.

PORT_CONFIG_RAW_PRINT_
OPEN

SMALLINT/ TINYINT* The flag indicating whether this 
port on the associated printer is 
open.

PORT_CONFIG_SNMP_OPEN SMALLINT/ TINYINT* The flag indicating whether this 
port on the associated printer is 
open.

PORT_CONFIG_XML_TCP_OP
EN

SMALLINT/ TINYINT* The flag indicating whether this 
port on the associated printer is 
open.

PORT_CONFIG_XML_UDP_OP
EN

SMALLINT/ TINYINT* The flag indicating whether this 
port on the associated printer is 
open.

SECURE_COMMUNICATION_S
TATE

VARCHAR(255) The state of the communication. 
The options are UNSECURED, 
MISSING_CREDENTIALS, and 
SECURED.

USER_PASSWORD Blob sub_type 0 The username portion of the 
credentials.

SNMP_USERNAME VARCHAR(32) The user name used for 
SNMPv3 communications.

SNMP_PASSWORD VARCHAR(255) This value is encrypted and not 
available for use outside MVE.

SNMP_MIN_AUTHENTICATION
_LEVEL

Varchar(50) The minimum authentication 
level used for SNMPv3 
communications.

SNMP_AUTHENTICATION_HA
SH

VARCHAR(50) The hash authentication used for 
SNMPv3 communications.
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SNMP_PRIVACY_ALGORITHM VARCHAR(50) The privacy algorithm used for 
SNMPv3 communications.

LOGIN_METHOD VARCHAR(256) The authentication method used 
to log in to the printer.

LOGIN_METHOD_NAME VARCHAR(256) If LOGIN_METHOD is either 
LDAP or LDAP+GSSAPI, then 
this field shows the name of the 
authentication method.

TRACING_SERIAL_NUMBER VARCHAR(64) The authentication method used 
to trace the serial number.

*This data type is required for Microsoft SQL Server.

NETWORK_PRINTER

This table represents the actual printer portion of the physical printer.
Field Name Data Type Description

PRINTER_ID BIGINT The primary key.

MANUFACTURER VARCHAR(255) The company that actually made 
the printer. May differ from 
DISPLAY_MANUFACTURER.

MODEL_NAME VARCHAR(255) The model name of the printer.

SERIAL_NUMBER VARCHAR(50) The serial number of this printer.

SYSTEM_NAME VARCHAR(255) The name used to identify the 
device.

COPY SMALLINT/ TINYINT* The flag indicating whether the 
printer supports copying.

DUPLEX SMALLINT/ TINYINT* The flag indicating whether the 
printer supports two‑sided 
printing.

ESF SMALLINT/ TINYINT* The flag indicating whether the 
printer supports eSF 
applications.

MARKING_TECHNOLOGY VARCHAR(255) The type of marking technology 
used by the printer (for example, 
electrophotographic).

MEMORY BIGINT The amount of memory, in bytes.

PROFILE SMALLINT/ TINYINT* The flag indicating whether this 
printer supports profiles.

RECEIVE_FAX SMALLINT/ TINYINT* The flag indicating whether this 
printer supports receiving faxes.

SCAN_TO_EMAIL SMALLINT/ TINYINT* The flag indicating whether this 
printer supports scanning to 
email.
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SCAN_TO_FAX SMALLINT/ TINYINT* The flag indicating whether this 
printer supports scanning to fax.

SCAN_TO_NETWORK SMALLINT/ TINYINT* The flag indicating whether this 
printer supports scanning to a 
network.

SPEED VARCHAR(255) The number of sheets that the 
paper can print per minute.

DISPLAY_MANUFACTURER VARCHAR(255) The name that appears on the 
outside of the printer. For 
example, MANUFACTURER 
could be LEXMARK, but 
DISPLAY_MANUFACTURER 
could be Dell.

FAMILY_ID INTEGER The NPA family ID.

INITIAL_DISCOVERY_TIMESTA
MP

TIMESTAMP When the printer was first 
discovered.

LIFETIME_PAGE_COUNT BIGINT The lifetime page count.

MAINTENANCE_COUNTER BIGINT The maintenance counter.

ADAPTER_PORT INTEGER The port on which this printer is 
connected to its associated 
network adapter. For now, the 
data is always 1.

PROPERTY_TAG VARCHAR(255) The asset, brass, or property 
tag.

ADAPTER_ID BIGINT The foreign key to 
NETWORK_ADAPTER.ADAPT
ER_ID.

RAND_SN SMALLINT/ TINYINT* The flag indicating whether the 
current value of 
SERIAL_NUMBER was 
randomly generated.

DEV_STATUS_REG_COUNTER INTEGER The number of device status 
registrations.

SCANNER_SERIAL_NUMBER VARCHAR(12) For modular MFPs, the serial 
number of the scan head.

DISK_ENCRYPTION VARCHAR(8) The frequency at which disk 
encryption is enabled.

DISK_WIPING VARCHAR(8) The frequency at which disk 
wiping is enabled.

COLOR SMALLINT/ TINYINT* The flag indicating whether the 
printer prints in color.

PRINTER_STATUS_SUMMARY SMALLINT/ TINYINT* The indicator of the most severe 
status message that is present 
on the printer.
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SUPPLY_STATUS_SUMMARY SMALLINT/ TINYINT* The indicator of the most severe 
supply status message that is 
present on the printer.

TLI VARCHAR(255) The Top Level Indicator (TLI) of 
the printer model.

FAX_STATION_NAME VARCHAR(255) The value of the fax name 
setting on the printer.

FAX_STATION_NUMBER VARCHAR(255) The value of the fax number 
setting on the printer.

SCANNER_SERIAL_NUMBER VARCHAR(50) The serial number of the 
scanner of the printer.

TIME_ZONE VARCHAR(255) The ID for different time zones 
supported by the printer.

MODULAR_SERIAL_NUMBER VARCHAR(255) The modular serial number.

TRACING_SERIAL_NUMBER VARCHAR(64) The authentication method that 
is used to trace the serial 
number.

*This data type is required for Microsoft SQL Server.

PRINTER_CURRENT_STATUS

This table represents the printer status when data was collected. There is a row in this table for each status 
condition on a given printer, all pointing to the same PRINTER_ID.
Field Name Data Type Description

STATUS_ID BIGINT The primary key.

STATUS_MESSAGE VARCHAR(255) The text for this status (for 
example, Tray 1 Low).

STATUS_SEVERITY VARCHAR(255) The severity of this status (for 
example, Warning).

STATUS_TYPE VARCHAR(255) The type of this status (for 
example, Printer or Supply).

PRINTER_ID BIGINT The foreign key to 
NETWORK_PRINTER.PRINTE
R_ID.

PRINTER_ESF_APPS

This table represents the installed eSF applications on printers when data was collected. There is a row in this 
table for each eSF application currently installed on a given printer, all pointing to the same PRINTER_ID.
Field Name Data Type Description

APPLICATION_ID BIGINT The primary key.

NAME VARCHAR(255) The application name.
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STATE VARCHAR(255) The current state.

VERSION VARCHAR(255) The current version.

PRINTER_ID BIGINT The foreign key to 
NETWORK_PRINTER.PRINTE
R_ID.

PRINTER_INPUT_OPTIONS

This table represents installed input options on printers when data was collected. There is a row in this table for 
each input option currently installed on a given printer, all pointing to the same PRINTER_ID.
Field Name Data Type Description

INPUT_OPTION_ID BIGINT The primary key.

NAME VARCHAR(255) The name of the input option (for 
example, Multipurpose Tray).

PRINTER_ID BIGINT The foreign key to 
NETWORK_PRINTER.PRINTE
R_ID.

PRINTER_INPUT_TRAYS

This table represents input trays associated with an input option. There is a row in this table for each input tray 
associated with a given input option, all pointing to the same INPUT_OPTION_ID.
Field Name Data Type Description

INPUT_OPTION_ID BIGINT The foreign key to 
PRINTER_INPUT_OPTIONS.IN
PUT_OPTION_ID.

CAPACITY BIGINT The maximum number of sheets 
that the tray can hold.

FEED_TYPE VARCHAR(255) Manual or Auto.

FORM_SIZE VARCHAR(255) The current paper size (for 
example, Letter).

FORM_TYPE VARCHAR(255) The current paper type (for 
example, Plain Paper).

TYPE VARCHAR(255) The type of input tray (for 
example, Multipurpose Feeder).

PRINTER_OPTIONS

This table represents installed options on printers when data was collected. There is a row in this table for each 
option currently installed on a given printer, all pointing to the same PRINTER_ID. Typically, the option is a 
storage device.
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OPTION_ID BIGINT The primary key.

FREESPACE_ BIGINT The amount of space remaining 
on the storage device.

NAME VARCHAR(255) The name of the printer option 
(for example, DISK).

SIZE_ BIGINT The total amount of space.

PRINTER_ID BIGINT The foreign key to 
NETWORK_PRINTER.PRINTE
R_ID.

PRINTER_OUTPUT_BINS

This table represents output bins associated with an output option. There is a row in this table for each output bin 
associated with a given output option, all pointing to the same OUTPUT_OPTION_ID.
Field name Data type Description

OUTPUT_OPTION_ID BIGINT The foreign key to 
PRINTER_OUTPUT_OPTIONS.
OUTPU T_OPTION_ID.

BINDING SMALLINT/ TINYINT* The flag indicating whether this 
bin supports binding.

BURSTING SMALLINT/ TINYINT* The flag indicating whether this 
bin supports bursting.

CAPACITY BIGINT The maximum number of sheets 
that the bin can hold.

COLLATION SMALLINT/ TINYINT* The flag indicating whether this 
bin supports collation.

FACE_DOWN SMALLINT/ TINYINT* The flag indicating whether 
paper is loaded facedown in this 
bin.

FACE_UP SMALLINT/ TINYINT* The flag indicating whether 
paper is loaded faceup in this 
bin.

LEVEL_SENSING SMALLINT/ TINYINT* The flag indicating whether this 
bin supports paper‑level 
sensing.

PUNCHING SMALLINT/ TINYINT* The flag indicating whether this 
bin supports hole punching.

SECURITY SMALLINT/ TINYINT* The flag indicating whether this 
bin supports security.

SEPARATION SMALLINT/ TINYINT* The flag indicating whether this 
bin supports separation.

STITICHING SMALLINT/ TINYINT* The flag indicating whether this 
bin supports stitching.
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TYPE VARCHAR(255) The type of printer output bin (for 
example, Standard Bin, Bin 5, 
etc.)

*This data type is required for Microsoft SQL Server.

PRINTER_OUTPUT_OPTIONS

This table represents installed output options on printers. There is a row in this table for each output option 
currently installed on a given printer, all pointing to the same PRINTER_ID.
Field Name Data Type Description

OUTPUT_OPTION_ID BIGINT The primary key.

NAME VARCHAR(255) The name of the option (for 
example, Integrated Hopper, 
Mailbox, and Finisher).

PRINTER_ID BIGINT The foreign key to 
NETWORK_PRINTER.PRINTE
R_ID.

PRINTER_STATISTICS

This table contains information gathered from the meters and counters data of the printer. Each row represents 
data for an individual printer. Depending on the printer model with which the record is associated, not all columns 
apply.
Field Name Data Type Description

STATISTICS_ID BIGINT The primary key.

COVG_LAST_JOB_BLACK BIGINT The black toner coverage of the 
last print job.

COVG_LIFETIME_BLACK BIGINT The black toner coverage of jobs 
from the currently installed black 
cartridge.

CART_PAGES_PRINT_BLACK BIGINT The count of the printed pages 
that used black toner cartridge.

BLACK_TONER_LEVEL VARCHAR(255) The current supply level of the 
black toner cartridge.

PHOTO_COND_LEVEL_K VARCHAR(255) The current supply level of the 
photoconductor (black).

BLANK_SAFE_SIDE_COPY BIGINT The count of the blank safe 
sides from a copy.

BLANK_SAFE_SIDE_FAX BIGINT The count of the blank safe 
sides from a fax.

BLANK_SAFE_SIDE_PRINT BIGINT The count of the blank safe 
sides from a print.
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PAPER_CHANGE BIGINT The count of paper change 
events.

COVER_OPEN BIGINT The count of cover open events.

COVG_LAST_JOB_CYAN BIGINT The cyan toner coverage of the 
last print job.

COVG_LIFETIME_CYAN BIGINT The cyan toner coverage of jobs 
from the currently installed cyan 
cartridge.

CART_PAGES_PRINT_CYAN BIGINT The count of the printed pages 
that used the cyan toner 
cartridge.

CYAN_TONER_LEVEL VARCHAR(255) The current supply level of the 
cyan toner cartridge.

CYAN_TONER_STATUS VARCHAR(255) The supply status for the cyan 
cartridge (for example, 
Intermediate).

YELLOW_TONER_STATUS VARCHAR(255) The supply status for the yellow 
cartridge (for example, 
Intermediate).

MAGENTA_TONER_STATUS VARCHAR(255) The supply status for the 
magenta cartridge (for example, 
Intermediate).

BLACK_TONER_STATUS VARCHAR(255) The supply status for the black 
cartridge (for example, 
Intermediate).

PHOTO_COND_LEVEL_C VARCHAR(255) The current supply level of the 
photoconductor (cyan).

DEVICE_INSTALL_DATE TIMESTAMP The time stamp of the first 
installation of the printer.

FUSER_CURRENT_LEVEL VARCHAR(255) The current supply level of the 
fuser.

IMG_SAFE_SIDE_COPY BIGINT The count of imaged printed 
sides of a copy job.

IMG_SAFE_SIDE_FAX BIGINT The count of imaged printed 
sides of a fax job.

IMG_SAFE_SIDE_PRINT BIGINT The count of imaged printed 
sides of a print job.

LAST_FAX_JOB_DATE TIMESTAMP The time stamp of the last fax 
job.

LAST_PRINTED_JOB_DATE TIMESTAMP The time stamp of the last print 
job.

LAST_SCAN_JOB_DATE TIMESTAMP The time stamp of the last scan 
job.

COVG_LAST_JOB_MAGENTA BIGINT The magenta toner coverage of 
the last job.
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COVG_LIFETIME_MAGENTA BIGINT The magenta toner coverage of 
jobs from the currently installed 
magenta cartridge.

CART_PAGES_PRINT_MAGEN
TA

BIGINT The count of the printed pages 
that used the magenta toner 
cartridge.

MAGENTA_TONER_LEVEL VARCHAR(255) The current supply level of the 
magenta toner cartridge.

PHOTO_COND_LEVEL_M VARCHAR(255) The current supply level of the 
photoconductor (magenta).

MAINT_KIT_LEVEL VARCHAR(255) The current supply level of the 
maintenance kit.

MEDIA_SIZE_TYPE_MONO_SI
DE_ SAFE

BIGINT The mono printed sides (safe).

MEDIA_SIZE_TYPE_COLOR_S
IDE_ SAFE

BIGINT The color printed sides (safe).

SUPPLY_EVENTS BIGINT The count of other supply 
events.

PAPER_JAMS BIGINT The count of paper jam events.

PAPER_LOAD BIGINT The count of paper load events.

PRINT_SHEET_USE_PICKED BIGINT The printed sheets (picked).

PRINT_SIDE_USE_PICKED BIGINT The printed sides (picked).

POR BIGINT The count of Power-On Resets.

PRINT_AND_HOLD_JOB BIGINT The count of print-and-hold jobs.

SAFE_SHT_COPY BIGINT The printed sheets (safe) from 
copy jobs.

SAFE_SHT_FAX BIGINT The printed sheets (safe) from 
fax jobs.

SAFE_SHT_PRINT BIGINT The printed sheets (safe) from 
print jobs.

SCAN_PAPER_JAMS BIGINT The count of scanner jams.

PRINTED_FROM_PRINT_AND
_HOLD

BIGINT The count of printed print-and-
hold jobs.

PRINTED_FROM_USB BIGINT The count of prints from USB.

TRANS_BELT_LEVEL VARCHAR(255) The current supply level of the 
transfer belt.

USB_DIRECT_JOB BIGINT The count of USB insertions.

WASTE_TONER_LEVEL VARCHAR(255) The current level of the waste 
toner bottle.

COVG_LAST_JOB_YELLOW BIGINT The yellow toner coverage of the 
last job.
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COVG_LIFETIME_YELLOW BIGINT The yellow toner coverage of 
lifetime jobs.

CART_PAGES_PRINT_YELLO
W

BIGINT The count of the printed pages 
that used the yellow toner 
cartridge.

YELLOW_TONER_LEVEL VARCHAR(255) The current supply level of the 
yellow toner cartridge.

PHOTO_COND_LEVEL_Y VARCHAR(255) The current level of the 
photoconductor (yellow).

IMG_SAFE_SIDE_PRINT_MON
O

BIGINT The count of imaged mono 
printed sides (safe) from print 
jobs.

IMG_SAFE_SIDE_PRINT_COL
OR

BIGINT The count of imaged color 
printed sides (safe) from print 
jobs.

IMG_SAFE_SIDE_COPY_MON
O

BIGINT The count of imaged mono 
printed sides (safe) from copy 
jobs.

IMG_SAFE_SIDE_COPY_COL
OR

BIGINT The count of imaged color 
printed sides (safe) from copy 
jobs.

IMG_SAFE_SIDE_FAX_MONO BIGINT The count of imaged mono 
printed sides (safe) from fax 
jobs.

IMG_SAFE_SIDE_FAX_COLOR BIGINT The count of imaged color 
printed sides (safe) from fax 
jobs.

FAX_JOB_RECV BIGINT The count of received fax jobs.

FAX_JOB_SENT BIGINT The count of sent fax jobs.

FAX_PAGE_RECV BIGINT The count of received fax pages.

FAX_PAGE_SENT BIGINT The count of sent fax pages.

SCAN_COPY BIGINT The count of scans from copy 
jobs.

SCAN_FAX BIGINT The count of scans from fax.

SCAN_LOCAL BIGINT The count of local scans.

SCAN_NET BIGINT The count of scans to network.

SCAN_FLAT BIGINT The count of scans from the 
scanner glass flatbed.

SCAN_ADF_SIMPLEX BIGINT The count of scans from the ADF 
(simplex).

SCAN_ADF_DUPLEX BIGINT The count of scans from the ADF 
(duplex).
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SCAN_USB_DIRECT BIGINT The count of scans directly to 
USB.

USB_DIRECT_INSERT BIGINT The count of USB insertions.

CART_INST_DATE_CYAN TIMESTAMP The time stamp of the cyan 
cartridge installation.

CART_INST_DATE_YELLOW TIMESTAMP The time stamp of the yellow 
cartridge installation.

CART_INST_DATE_MAGENTA TIMESTAMP The time stamp of the magenta 
cartridge installation.

CART_INST_DATE_BLACK TIMESTAMP The time stamp of the black 
cartridge installed.

PRINTER_ID BIGINT The foreign key to 
NETWORK_PRINTER.PRINTE
R_ID.

MAINT_KIT_STATUS_100K VARCHAR(255) The 100K maintenance kit level.

MAINT_KIT_STATUS_160K VARCHAR(255) The 160K maintenance kit level.

MAINT_KIT_STATUS_200K VARCHAR(255) The 200K maintenance kit level.

MAINT_KIT_STATUS_300K VARCHAR(255) The 300K maintenance kit level.

MAINT_KIT_STATUS_320K VARCHAR(255) The 320K maintenance kit level.

MAINT_KIT_STATUS_480K VARCHAR(255) The 480K maintenance kit level.

MAINT_KIT_STATUS_600K VARCHAR(255) The 600K maintenance kit level.

PRINTER_SUPPLIES

This table represents supplies in printers. There is a row in this table for each supply in a given printer, all pointing 
to the same PRINTER_ID. Depending on the type, not all columns apply.
Field Name Data Type Description

SUPPLY_ID BIGINT The primary key.

CAPACITY BIGINT The maximum sheet capacity of 
the supply.

COLOR VARCHAR(255) The color of the supply (for 
example, Black, Cyan, or NULL).

NAME VARCHAR(255) The name of the supply (for 
example, Black Toner, Fuser, 
and Waste Bottle).

SMART_CARTRIDGE_PREBAT
E

SMALLINT/ TINYINT* The flag indicating whether this 
supply is a smart cartridge 
prebate.

SMART_CARTRIDGE_REFILLE
D

SMALLINT/ TINYINT* The flag indicating whether this 
supply is a smart cartridge refill.
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SMART_CARTRIDGE_SERIAL_
NUM BER

VARCHAR(255) The smart cartridge serial 
number.

TYPE VARCHAR(255) The type of supply (for example, 
Toner, Transfer Belt, Fuser, 
Container, or Imaging Unit).

PRINTER_ID BIGINT The foreign key to 
NETWORK_PRINTER.PRINTE
R_ID.

PERCENT_FULL BIGINT The calculated remaining 
percentage of the supply.

*This data type is required for Microsoft SQL Server.

CHANGED_SETTINGS

This table contains information about settings that changed between the last two audits.
Field Name Data Type Description

ID BIGINT The primary key.

CI_ID BIGINT Refers to CONFIG_ITEM.ID.

SETTING_NAME VARCHAR(255) The name of the setting that 
changed.

CHANGE_TYPE VARCHAR(255) The type of change. The options 
are ADD, UPDATE, and 
REMOVE.

PRINTER_PORTS

This table contains information about the status of the printer TCP/UDP ports.
Field name Data type Description

PRINTER_PORTS_ID BIGINT The primary key.

PRINTER_ID BIGINT Refers to PRINTER.ID.

TCP21 VARCHAR(255) The options are OFF, ON, 
UNKNOWN, and NONE.

UDP69 VARCHAR(255) The options are OFF, ON, 
UNKNOWN, and NONE.

TCP79 VARCHAR(255) The options are OFF, ON, 
UNKNOWN, and NONE.

TCP80 VARCHAR(255) The options are OFF, ON, 
UNKNOWN, and NONE.

UDP137 VARCHAR(255) The options are OFF, ON, 
UNKNOWN, and NONE.
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UDP161 VARCHAR(255) The options are OFF, ON, 
UNKNOWN, and NONE.

UDP162 VARCHAR(255) The options are OFF, ON, 
UNKNOWN, and NONE.

TCP515 VARCHAR(255) The options are OFF, ON, 
UNKNOWN, and NONE.

TCP631 VARCHAR(255) The options are OFF, ON, 
UNKNOWN, and NONE.

TCP5001 VARCHAR(255) The options are OFF, ON, 
UNKNOWN, and NONE.

UDP5353 VARCHAR(255) The options are OFF, ON, 
UNKNOWN, and NONE.

TCP8000 VARCHAR(255) The options are OFF, ON, 
UNKNOWN, and NONE.

TCP9100 VARCHAR(255) The options are OFF, ON, 
UNKNOWN, and NONE.

TCP9200 VARCHAR(255) The options are OFF, ON, 
UNKNOWN, and NONE.

UDP9200 VARCHAR(255) The options are OFF, ON, 
UNKNOWN, and NONE.

UDP9300 VARCHAR(255) The options are OFF, ON, 
UNKNOWN, and NONE.

UDP9301 VARCHAR(255) The options are OFF, ON, 
UNKNOWN, and NONE.

UDP9302 VARCHAR(255) The options are OFF, ON, 
UNKNOWN, and NONE.

TCP9400 VARCHAR(255) The options are OFF, ON, 
UNKNOWN, and NONE.

TCP9500 VARCHAR(255) The options are OFF, ON, 
UNKNOWN, and NONE.

TCP9501 VARCHAR(255) The options are OFF, ON, 
UNKNOWN, and NONE.

TCP9600 VARCHAR(255) The options are OFF, ON, 
UNKNOWN, and NONE.

UDP9700 VARCHAR(255) The options are OFF, ON, 
UNKNOWN, and NONE.

TCP9000 VARCHAR(255) The options are OFF, ON, 
UNKNOWN, and NONE.

TCP5000 VARCHAR(255) The options are OFF, ON, 
UNKNOWN, and NONE.

TCP443 VARCHAR(255) The options are OFF, ON, 
UNKNOWN, and NONE.
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TCP4000 VARCHAR(255) The options are OFF, ON, 
UNKNOWN, and NONE.

UDP6100 VARCHAR(255) The options are OFF, ON, 
UNKNOWN, and NONE.

TCP6100 VARCHAR(255) The options are OFF, ON, 
UNKNOWN, and NONE.

TCP65002 VARCHAR(255) The options are OFF, ON, 
UNKNOWN, and NONE.

TCP65004 VARCHAR(255) The options are OFF, ON, 
UNKNOWN, and NONE.

TCP65004 VARCHAR(255) The options are OFF, ON, 
UNKNOWN, and NONE.

TCP65001 VARCHAR(255) The options are OFF, ON, 
UNKNOWN, and NONE.

TCP65003 VARCHAR(255) The options are OFF, ON, 
UNKNOWN, and NONE.

PRINTER_SECURITY-OPTIONS

This table contains information related to the security details of the printer.
Field Name Data Type Description

PRINTER_SECURITY_ID BIGINT The primary key.

PRINTER_ID BIGINT Refers to PRINTER.ID.

OWASP_CIPHER_CATEGORY VARCHAR(500) The list of cipher categories 
supported by the device.

TLS10 VARCHAR(255) The options are OFF, ON, 
UNKNOWN, and NONE.

TLS11 VARCHAR(255) The options are OFF, ON, 
UNKNOWN, and NONE.

Keywords

The following tables deal with MVE keywords.

ASSIGNED_KEYWORDS

This table represents the keywords assigned to their respective CIs and printers.
Field Name Data Type Description

KEYWORD_ID BIGINT The composite primary key, and 
the foreign key to 
KEYWORD.KEYWORD_ID.
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CI_ID BIGINT The composite primary key, and 
the foreign key to 
CONFIGURATION_ITEM.CI_ID.

KEYWORD

This table represents all the keywords defined in the system.
Field Name Data Type Description

KEYWORD_ID BIGINT The primary key.

KEYWORD_VALUE VARCHAR(255) The keyword name.

CATEGORY_ID BIGINT The foreign key to 
KEYWORD_CATEGORY.CATE
GORY_ID.

KEYWORD_CATEGORY

This table lists all the categories defined in the system. It is used for grouping keywords together.
Field Name Data Type Description

CATEGORY_ID BIGINT The primary key.

CATEGORY_VALUE VARCHAR(255) The category name.

Configurations

The following tables deal with MVE’s configurations.

CONFIGURATION

This table represents a printer configuration at the highest level, including the printer name, model, and whether it 
can be assigned.
Field name Data type Description

CONFIGURATION_ID BIGINT The primary key.

CONFIGURATION_NAME VARCHAR(255) The configuration name.

ASSIGNABLE SMALLINT/ TINYINT* The flag indicating whether the 
configuration is assignable.

DESCRIPTION VARCHAR(4000) A user‑entered description of the 
configuration.

LAST_MODIFIED TIMESTAMP The time stamp of the last edit of 
the configuration.
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Field name Data type Description

MANAGING_DEV_CERTIFICAT
E

BOOLEAN The default Boolean value. This 
field indicates whether this 
configuration manages the 
device certificate automatically.

*This data type is required for Microsoft SQL Server.

CONFIGURATION_COMPONENT

This table represents one component of a configuration.
Field name Data type Description

CONFIGURATION_COMPONE
NT_ID

BIGINT The primary key.

COMPONENT_TYPE VARCHAR(255) The component type. The 
options are 
DEVICE_SETTINGS, 
SECURITY_CAESAR1, 
SECURITY_CAESAR2, ESF, 
and FIRMWARE.

CREDENTIAL_PASSWORD BLOB SUB_TYPE 0 The encrypted credential 
password, if set.

CREDENTIAL_PIN BLOB SUB_TYPE 0 The encrypted credential PIN, if 
set.

CREDENTIAL_REALM VARCHAR(255) The credential realm, if set.

CREDENTIAL_USERNAME VARCHAR(255) The credential user name, if set.

COMPONENT_NAME VARCHAR(255) The component name.

LICENSE_TYPE VARCHAR(255) The license type of the 
configuration component. The 
options are PRODUCTION, 
TRIAL, and FACTORY.

LOGIN_METHOD VARCHAR(256) The authentication method used 
to log in to the printer.

MERGE_DATA_PATH VARCHAR(255) The file location of a variable 
settings file.

FLASH_FILE_SHA1 VARCHAR(255) The SHA1 hash of the flash file 
for a firmware component.

LOGIN_METHOD_NAME VARCHAR(256) If the LOGIN_METHOD is either 
LDAP or LDAP+GSSAPI, then 
this field shows the name of the 
particular login method.

DESCRIPTION VARCHAR(4000) This field shows the description 
if it is added in a component.

LAST_MODIFIED TIMESTAMP The time stamp of the last 
modification.
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Field name Data type Description

ASSIGNABLE Boolean The value is true if the 
component is assigned to a 
printer. Otherwise, the value is 
false.

PRE_POPULATED Boolean Added to identify pre-populated 
Advanced Security Components.

CONFIGURATION_COMPONENTS

This table contains information about different components related to different configurations, if selected.
Field Name Data Type Description

CONFIGURATION_ID BIGINT The foreign key to 
CONFIGURATION.CONFIGURA
TION_ID.

CONFIGURATION_COMPONE
NT_ID

BIGINT The foreign key to 
CONFIGURATION_COMPONE
NT. 
CONFIGURATION_COMPONE
NT_ID.

COMPONENT_TYPE VARCHAR(255) Added to discriminate among 
Device Setting Component and 
eight other components.

ASSIGNED_CONFIGURATIONS

This table shows which configurations are assigned to which CIs and printers.
Field Name Data Type Description

CI_ID BIGINT The composite primary key, and 
the foreign key back to 
CONFIGURATION_ITEM.CI_ID.

CONFIGURATION_ID BIGINT Composite primary key, and the 
foreign key back to 
CONFIGURATION.CONFIGURA
TION_ID.

COMPLIANCE_STATE VARCHAR(255) The current conformance state 
for the configuration.

LAST_COMPLIANCE_CHECK TIMESTAMP Time stamp of the last 
conformance check was run.

FAILED_COMPONENT

This table includes all components that have a setting out of conformance.
Field Name Data Type Description

FAILED_COMPONENT_ID BIGINT The primary key.
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Field Name Data Type Description

CI_ID BIGINT The foreign key back to 
ASSIGNED_CONFIGURATION
S.CI_ID.

CONFIGURATION_ID BIGINT (not null) The foreign key back to 
ASSIGNED_CONFIGURATION
S.CONFIGURATION_ID.

COMPONENT_TYPE VARCHAR(255) The type of the failed 
component.

COMPONENT_NAME VARCHAR(255) The name of the failed 
component.

FAILED_COMPONENT_SETTINGS

This table includes all settings that are out of conformance and their values.
Field Name Data Type Description

TYPE SMALLINT/ TINYINT*, Default 0 Added to discriminate 
conformance failure reasons 
among Discrepancy, 
Inapplicable, Unsupported, 
Resource not in Library, and 
Unable to Merge Token Settings.

FAILED_COMPONENT_ID BIGINT (not null) The foreign key back to 
FAILED_COMPONENT.FAILED
_COMPONENT_ID.

SETTING_NAME VARCHAR(255) The name of the failed setting.

PRINTER_VALUE dropNotNullConstraint Can be a null value.

COMPONENT_VALUE dropNotNullConstraint Can be a null value.

*This data type is required for Microsoft SQL Server.

FLASHFILE

This table represents information about MVE Firmware library resources.
Field Name Data Type Description

ID BIGINT The primary key.

FILENAME VARCHAR(256) The file name and location within 
the MVE repository.

SHA1 VARCHAR(255) The SHA1 hash of the flash file.

DISPLAY_NAME VARCHAR(255) A version identifier of the flash 
file.

DATE_IMPORTED TIMESTAMP The date when the flash file was 
imported.

DESCRIPTION VARCHAR(255) The description of the flash file.
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FLASH_NET_IDS

This table stores the NETFLASH ID found at the top of each flash file in the Resource Library.
Field Name Data Type Description

FLASHNETID BIGINT The primary key.

NET_ID VARCHAR(255) The NETFLASH ID.

CERTIFICATES

This table represents information about the MVE CA certificate library resources.
Field Name Data Type Description

CERTIFICATE_ID BIGINT The primary key.

NAME VARCHAR(255) The user‑friendly name of a CA 
certificate.

PEM_CERTIFICATE BLOB The PEM representation of a CA 
certificate.

DATE_IMPORTED TIMESTAMP The date when the CA certificate 
was imported to MVE.

PEM_CERTIFICATE_SHA2 VARCHAR (64) SHA2 hash of this CA certificate.

DESCRIPTION VARCHAR (255) Description of the CA certificate.

CERTIFICATE_COMP_CERTIFICATES

This table shows the linking of certificate in the Resource Library to a configuration component, and thus to a 
configuration.
Field Name Data Type Description

CONFIGURATION_COMP 
ONENT_ID

BIGINT The foreign key back to 
CONFIGURATION_COMPONE
NT.CONFIGURATION_ 
COMPONENT_ID.

CERTIFICATE_ID BIGINT The foreign key back to 
CERTIFICATES.CERTIFICATE_
ID.

COMPONENT_SETTINGS

This table represents settings contained within a given configuration component. There is a row in this table for 
each setting associated with the configuration component, all pointing to the same 
CONFIGURATION_COMPONENT.CONFIGURATION_COMPONENT_ID. The values are encrypted and not 
available outside of MVE.
Field Name Data Type Description

SETTING_ID BIGINT The primary key.
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Field Name Data Type Description

SETTING_NAME VARCHAR(255) The name of the setting.

SETTING_VALUE VARCHAR(1280) The encrypted setting value.

CONFIGURATION_COMPONE
NT_ID

BIGINT The foreign key to 
CONFIGURATION_COMPONE
NT.CONFIG 
URATION_COMPONENT_ID.

DISCRIMINATOR VARCHAR(255) The options are 
SIMPLE_SETTING and 
TABULAR_SETTING.

TABULAR_SETTING_VALUE_I
D

BIGINT The foreign key to 
COMPONENT_TAB_SETTING_
VALUE.TA 
BULAR_SETTING_VALUE_ID.

COMPONENT_TAB_TABLE

This table represents Color Print Permission tables included in configurations.
Field name Data type Description

TABLE_ID BIGINT The primary key.

TABLE_TYPE VARCHAR(255) The options are HOST_TABLE 
and USER_TABLE.

COMPONENT_TAB_ROW

This table represents a row from the Color Print Permissions tables. Values are encrypted and cannot be used 
outside MVE.
Field Name Data Type Description

TABLE_ID BIGINT The foreign key to 
COMPONENT_TAB_TABLE.TA
BLE_ID

HOST_NAME VARCHAR(255) The value of the Host Name 
setting in the hosts table.

USER_NAME VARCHAR(255) The value of the User Name 
setting in the users table.

ALLOWED_TO_PRINT_COLOR SMALLINT/ TINYINT* The value of the Allow Color 
Printing setting for both host and 
user tables.

USER_PERMISSION_OV 
ERRIDDEN

SMALLINT/ TINYINT* The value of the Overrides User 
Permission setting in the host 
table.

*This data type is required for Microsoft SQL Server.
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COMPONENT_TAB_SETTING_VALUE

This table shows the correlation of Color Print Permissions tables to components, and thus to configurations.
Field Name Data Type Description

TABULAR_SETTING_VALUE_I
D

BIGINT The foreign key to 
COMPONENT_SETTINGS.TAB
ULAR_SETTING_VALUE_ID.

TABLE_ID BIGINT The foreign key to 
COMPONENT_TAB_TABLE.TA
BLE_ID.

CC_SUPPORTED_MODEL_BACKUP

Field Name Data Type Description

ID BIGINT The primary key.

SUPPORTED_MODEL VARCHAR(255) Used for creating a backup from 
CONFIGURATION and 
CONFIGURATION_COMPONE
NT for Device Setting 
Components.

ESF_COMP_PRODUCTS

Field Name Data Type Description

CONFIGURATION_COMPONE
NT_ID

BIGINT The foreign key references.

Table: 
CONFIGURATION_COMPONE
NT

Column: 
CONFIGURATION_COMPONE
NT_ID

PART_NUMBER VARCHAR(255) The product part number of the 
solution component.

VCCFILE

Field Name Data Type Description

ID BIGINT The primary key.

FILENAME VARCHAR(255) The uploaded file name.

DISPLAY_NAME VARCHAR(255) The VCC file name displayed in 
MVE.
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Field Name Data Type Description

DATE_IMPORTED TIMESTAMP The time stamp of the upload of 
the file.

SHA1 VARCHAR(255) The file content hash.

DESCRIPTION VARCHAR(255) The description of the VCC file.

UCFFILE

Field Name Data Type Description

ID BIGINT The primary key.

FILENAME VARCHAR(255) The uploaded file name.

DISPLAY_NAME VARCHAR(255) The UCF file name displayed in 
MVE.

DATE_IMPORTED TIMESTAMP The time stamp of the upload of 
the file.

SHA1 VARCHAR(255) The file content hash.

DESCRIPTION VARCHAR(255) The description of the UCF file.

UCF_VCC_RESOURCE_FILES

This table contains information on the status of the printer TCP/UDP ports.
Field Name DataType Description

RESOURCE_ID BIGINT The primary key.

SHA1 VARCHAR(255) The file content hash.

RESOURCE_TYPE VARCHAR(255) The type of resource file. The 
options are UCF_FILE, 
VCC_FILE, and APP_FLS.

CONFIGURATION_COMPONE
NT_ID

VARCHAR(255) The foreign key of the ID of the 
CONFIGURATION_COMPONE
NT table.

Discovery profiles

The following tables are used to track the discovery profiles of MVE.
DISCOVERY_PROFILE

Field Name Data Type Description

ID BIGINT The primary key.

NAME VARCHAR(255) The user-supplied name for the 
profile.
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Field Name Data Type Description

RETRIES INTEGER The number of times to retry 
communicating with a printer.

SNMP_READ_COMMUNITY_N
AME

VARCHAR(255) The SNMP community name to 
use when reading.

TIMEOUT BIGINT The number of milliseconds to 
wait for a particular 
communication attempt with a 
printer to succeed.

SNMP_USERNAME VARCHAR(32) The user name for SNMP 
communication.

SNMP_PASSWORD VARCHAR(32) The password for SNMP 
communication.

SNMP_MIN_AUTHENTICATION
_LEVEL

VARCHAR(255) The minimum authentication 
level for SNMP.

SNMP_AUTHENTICATION_HA
SH

VARCHAR(50) The hash used for SNMP 
authentication.

SNMP_PRIVACY_ALGORITHM VARCHAR(50) The algorithm used for SNMP 
privacy.

DISCOVERY_PROFILE_CI

This table contains the CI-specific pieces of the discovery profile.

Field Name Data Type Description

CI_DP_ID BIGINT The primary key, and the foreign 
key to 
DISCOVERY_PROFILE.ID.

AUTOMANAGE SMALLINT/ TINYINT* The flag indicating whether CIs 
discovered using this profile 
must be automatically managed.

DESCRIPTION VARCHAR(4000) The user-provided description of 
the discovery profile.

LAST_RUN TIMESTAMP Time stamp of the last run of the 
profile.

CREDENTIAL_USERNAME VARCHAR(255) The credential user name, if set.

CREDENTIAL_REALM VARCHAR(64) The credential realm, if set.

LOGIN_METHOD VARCHAR(256) The authentication method used 
to log in to the printer.

LOGIN_METHOD_NAME VARCHAR(256) The name of the authentication 
method if LOGIN_METHOD is 
either LDAP or LDAP+GSSAPI.

CREDENTIAL_PASSWORD BLOB This value is encrypted and not 
available for use outside MVE.

CREDENTIAL_PIN BLOB This value is encrypted and not 
available for use outside MVE.
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Field Name Data Type Description

ASSIGN_KEYWORD_IDS VARCHAR(512) The assigned keywords in a 
discovery profile.

*This data type is required for Microsoft SQL Server.
EXCLUDE_PROFILE_ITEM

This table represents the Exclude list for a profile. Each excluded item has a row in this table.

Field Name Data Type Description

DISCOVERY_PROFILE_ID BIGINT The composite primary key, and 
the foreign key to 
DISCOVERY_PROFILE.ID.

VALUE_ VARCHAR(255) The composite primary key. This 
field defines what items to 
exclude.

INCLUDE_PROFILE_ITEM

This table represents the Include list for a profile. Each included item has a row in this table.

Field Name Data Type Description

DISCOVERY_PROFILE_ID BIGINT The composite primary key, and 
the foreign key to 
DISCOVERY_PROFILE.ID.

VALUE_ VARCHAR(255) The composite primary key. This 
field defines what items to 
include.

DISCOVERY_PROFILE_MODEL_CONFIG

This table represents the Assign Configurations portion of a discovery profile.

Field Name Data Type Description

ID BIGINT The primary key.

MODEL VARCHAR(255) The model name of the printers 
to which the configuration is 
assigned.

DISCOVERY_PROFILE_ID BIGINT The foreign key to 
DISCOVERY_PROFILE.ID.

CI_CONFIGURATION_ID BIGINT The foreign key to 
CONFIGURATION.CONFIGURA
TION_ID.

ESF

ESF_APPLICATION

This table contains all the eSF applications in all deployable eSF packages. There may be many eSF applications 
in each deployable package.
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Field name Data type Description

ESF_APP_ID BIGINT The primary key.

ESF_DP_ID BIGINT The foreign key back to 
ESF_DEPLOYABLE_PACKAGE.
ESF_DP_ID.

APP_ID VARCHAR(255) The application ID of the eSF 
applications.

VERSION VARCHAR(255) The eSF application version.

DESCRIPTION_URI VARCHAR(255) The URI description to the ESF 
application.

FLS_URI VARCHAR(255) The URI to the flash file.

ESF_APPLICATION_LOCALE

This table contains the name and description of each eSF application in all languages supported by MVE.

Field Name Data Type Description

ESF_APP_LOCALE_ID BIGINT The primary key.

ESF_APP_ID BIGINT The foreign key to 
ESF_APPLICATION.ESF_APP_
ID.

LOCALE VARCHAR(255) The two‑character language 
code.

NAME VARCHAR(255) The name of the eSF application 
in the language indicated by 
LOCALE.

DESCRIPTION VARCHAR(510) The description of the eSF 
application in the language 
indicated by LOCALE.

ESF_COMP_DEPLOYABLE_PACKAGE

This table contains one row for each deployable package in use by an MVE configuration.

Field Name Data Type Description

ESF_COMPONENT_ID BIGINT The foreign key to 
CONFIGURATION_COMPONE
NT.CONFIGURATION_COMPO
NENT_ID.

ESF_DP_ID VARCHAR(255) The foreign key to 
ESF_DEPLOYABLE_PACKAGE.
ESF_DP_ID.

ESF_DEPLOYABLE_PACKAGE

This table represents all the deployable packages uploaded to the MVE library.

Field Name Data Type Description

ESF_DP_ID BIGINT The primary key.
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Field Name Data Type Description

NAME VARCHAR(255) The name of the deployable 
package.

PART_NUMBER VARCHAR(255) The part number of the 
deployable package.

PART_REVISION VARCHAR(255) The part revision of the 
deployable package.

LICENSE_REQUIRED SMALLINT/ TINYINT* The flag indicating whether a 
license is required for the 
deployable package.

URI VARCHAR(255) The URI of the deployable 
package.

DATE_IMPORTED TIMESTAMP The date when the deployable 
package was imported.

VERSION VARCHAR(255) The version of the deployable 
package.

DESCRIPTION VARCHAR(255) The description of the 
deployable package.

*This data type is required for Microsoft SQL Server.
ESF_DEPLOYABLE_PACKAGE_LOCALE

This table contains the name and description for each deployable package in all languages supported by MVE.

Field Name Data Type Description

ESF_DP_LOCALE_ID BIGINT The primary key.

ESF_DP_ID BIGINT The foreign key to 
ESF_DEPLOYABLE_PACKAGE.
ESF_ DP_ID.

LOCALE VARCHAR(255) The two‑character language 
code.

NAME VARCHAR(255) The name of the deployable 
package in the language 
indicated by LOCALE.

DESCRIPTION VARCHAR(2048) The increased description 
length, from 510 to 2048 
characters.

ESF_DP_SUPPORTED MODELS

This table contains one row for each model supported by a deployable package in the MVE library.

Field Name Data Type Description

ESF_DP_ID BIGINT The foreign key back to 
ESF_DEPLOYABLE_PACKA 
GE.ESF_DP_ID.

SUPPORTED_MODEL VARCHAR(255) The model name of printer 
supported by the deployable 
package.
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ESF_LICENSE

This table represents the licenses for eSF applications available in the MVE library.

Field Name Data Type Description

ESF_LICENSE_ID BIGINT The primary key.

PRINTER_SERIAL VARCHAR(255) The serial number of the printer 
to which the license is tied.

PART_NUMBER VARCHAR(255) The part number of the package 
to which the license is tied.

PART_REVISION VARCHAR(255) The part revision of the package 
to which the license is tied.

LICENSE_TYPE VARCHAR(255) The options are TRIAL and 
PRODUCTION.

FILE_NAME VARCHAR(255) The file name of the license 
binary.

DEPLOYED SMALLINT/ TINYINT* The flag indicating whether the 
license has been deployed.

*This data type is required for Microsoft SQL Server.
RAWESFAPPFILE

This table represents the raw eSF application file details available in the MVE library.

Field Name Data Type Description

ID BIGINT The primary key.

FILENAME VARCHAR(255) The name of the package file.

DISPLAY_NAME VARCHAR(255) The display name of the 
package file.

DATE_IMPORTED TIMESTAMP The time stamp of the import of 
the package.

SHA1 VARCHAR(255) The SHA1 hash of the package.

DESCRIPTION VARCHAR(255) The description of the package.

APP_ID VARCHAR(255) The application ID of the 
package.

VERSION VARCHAR(255) The version of the package.

APP_FLS_RESOURCE_FILES

This table represents the association of eSF applications file available in the MVE library with configuration.

Field Name Data Type Description

RESOURCE_ID BIGINT The primary key.

SHA1 VARCHAR(255) The SHA1 hash of the package.

RESOURCE_TYPE VARCHAR(255) The type of the Resource File. 
The options are UCF_FILE, 
VCC_FILE, and APP_FLS.



Database access

200

Field Name Data Type Description

CONFIGURATION_COMPONE
NT_ID

BIGINT The foreign key with the ID 
column of 
CONFIGURATION_COMPONE
NT.

Certificate management

The following represents the list of certifications to be verified.
ENROLLMENT_STATUS

The following table lists the issued certificates.

Field Name Data Type Description

ENROLLMENT_STATUS_ID BIGINT The primary key.

CERTIFICATE_ENROL_STATU
S

VARCHAR(255) The certificate enrollment status. 
The options are Issued, 
Pending, and Failed.

CERT_ENROL_TRANSACTION
_ID

VARCHAR(2048) The pending certificate response 
for EST. Sometimes, this field 
shows the transaction ID for 
certificate enrollment.

CERT_SUBJECT_IDENTITY VARCHAR(255) The subject identity of the 
certificate.

CERT_SERIAL_NUMBER VARCHAR(255) The serial number of the 
certificate issued.

PRINTER_ID BIGINT The reference printer.

DEFAULT_CERT_REVISION_N
O

VARCHAR(255) The revision number of the 
certificate that is renewed.

DEFAULT_CERT_RENEWAL_D
ATE

VARCHAR(255) The renewal date of the 
certificate.

CERTIFICATE_FRIENDLY_NA
ME

VARCHAR(255) The friendly name of the 
certificate.

CERTIFICATE_USED_FOR VARCHAR(255) The association of the named 
certificate. The options are 
DEFAULT, HTTPS, WIRELESS, 
IPSEC, and UNASSIGNED.

CA_CERT_REVOCATION_COMP_LIST

The following table lists information about the revoked certificates.

Field Name Data Type Description

ID BIGINT The unique identifier.

SERIAL_NUMBER VARCHAR(255) The serial number of the 
certificate present in the 
revocation list primary key.
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Field Name Data Type Description

CERTIFICATE_SUBJECT VARCHAR(255) The subject of the revoked 
certificate.

REVOCATION_DATE TIMESTAMP The date when the certificate is 
revoked.

ISSUER VARCHAR(255) The issuer of the revoked 
certificate.

REVOCATION_REASON VARCHAR(255) The revocation reason.

NAMED_CERTIFICATE_SETTINGS

The following table lists the name and association of named certificate.

Field Name Data Type Description

CERT_SETTING_ID BIGINT The unique identifier.

FRIENDLY_NAME VARCHAR(255) The friendly name of the named 
certificate.

CERT_USED_FOR VARCHAR(255) The association of the named 
certificate. The options are 
DEFAULT, HTTPS, WIRELESS, 
IPSEC, and UNASSIGNED.

CONFIGURATION_COMPONE
NT_ID

BIGINT The foreign key associated with 
ID of the 
CONFIGURATION_COMPONE
NT table.

TEMPLATE_ID BIGINT The ID of the associated 
template.

PRINTER_CERTIFICATE

The following table represents the details of the named certificate.

Field Name Data Type Description

CERTIFICATE_ID BIGINT The unique identifier.

CERTIFICATE_FRIENDLY_NA
ME

VARCHAR(255) The friendly name of the 
certificate.

CERTIFICATE_COMMON_NAM
E

VARCHAR(255) The common name of the 
certificate.

CERTIFICATE_ISSUER_NAME VARCHAR(255) The name of the issuer of the 
certificate.

CERTIFICATE_SIGNING_STAT
US

VARCHAR(255) The signing status of the 
certificate. The options are 
SIGNED, INVALID_CERT, 
NO_CA, REVOKED, and 
UNKNOWN.

CERTIFICATE_VALID_FROM TIMESTAMP The time when the certificate 
started to be valid.

CERTIFICATE_VALID_TO TIMESTAMP The time when the certificate is 
no longer valid.
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Field Name Data Type Description

CERTIFICATE_SIGNATURE VARCHAR(8190) The signature of the certificate.

CERTIFICATE_SERIAL_NUMB
ER

VARCHAR(255) The serial number of the 
certificate.

TYPE VARCHAR(255) The type of the certificate. The 
options are DEFAULT, HTTPS, 
WIRELESS, IPSEC, and 
UNASSIGNED.

PRINTER_ID BIGINT The foreign key associated with 
ID of 
CONFIGURATION_COMPONE
NT table.

ENROLLED_CERTIFICATE_TYPE

The following table shows the relationship between certificate and enrollment status.

Field Name Data Type Description

TYPE_ID BIGINT The unique identifier.

ENROLLMENT_STATUS_ID BIGINT The foreign key of the ID column 
of ENROLLMENT_STATUS 
table.

TYPE VARCHAR(255) The type of the certificate. The 
options are DEFAULT, HTTPS, 
WIRELESS, IPSEC, and 
UNASSIGNED.

CA_TEMPLATE

The following table shows the details of the templates selected when setting up the MSCA server using the 
MSCEWS protocol.

Field Name Data Type Description

TEMPLATE_ID BIGINT The unique identifier for 
templates for MSCA Server with 
MSCEWS (cannot be null).

TEMPLATE_NAME VARCHAR(255) The name of templates in the 
CEP server.

TEMPLATE_OID VARCHAR(255) The corresponding SNMP MIB 
path.

Authentication and authorization

The following tables are used for the user authentication and authorization mechanism of MVE.
MASTER_ROLE

This table contains all the roles supported by MVE.

Field name Data type Description

ID BIGINT The primary key.
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Field name Data type Description

ROLE_NAME VARCHAR(255) The name of the role.

USERS

This table lists all the internal user accounts of MVE.

Field name Data type Description

ID BIGINT The primary key.

USER_NAME VARCHAR(15) The user-supplied user name.

USER_PASS VARCHAR(1024) The user-supplied password.

ENABLED SMALLINT/ TINYINT* The flag indicating whether this 
account is enabled.

NAME VARCHAR(255) The user’s full name.

LAST_LOGIN TIMESTAMP The time stamp of the last login 
attempt.

LOGIN_ATTEMPT BIGINT The current number of attempts 
made at a successful login.

REFRESH_TOKEN VARCHAR(1024) The authentication token when 
the user logs in.

*This data type is required for Microsoft SQL Server.
USER_ROLE

This table describes the association of users to roles.

Field name Data type Description

ID BIGINT The primary key.

USER_NAME VARCHAR(15) The foreign key back to 
USERS.USER_NAME.

ROLE_NAME VARCHAR(30) The foreign key back to 
MASTER_ROLE.ROLE_NAME.

Security settings

The following tables describe security settings in a configuration. The security configuration information is 
encrypted for data safety, unavailable outside of MVE, and not useful in the scope of this document. So the 
details of the following tables are omitted.

SEC_ACCESS_CONTROL

SEC_AUTH_GROUP

SEC_BUILDING_BLOCK

SEC_BUILDING_BLOCK_SETTINGS

SEC_COMPONENT_MISC_SETTINGS

SEC_INTERNAL_ACCOUNT

SEC_INTERNAL_ACCOUNT_GROUPS
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SEC_INTERNAL_ACCOUNT_SETTINGS

SEC_SECURITY_TEMPLATE

SEC_SECURTY_TEMPLATE_BBS

SEC_SECURITY_TEMPLATE_GROUPS

CAESAR2_LOCAL_ACCOUNTS

CAESAR2_MISC_SETTINGS

CAESAR2_KRB_SETUP

CAESAR2_COMP_LOCAL_ACCTS

CAESAR2_LOCAL_ACCOUNT_GROUPS

CAESAR2_GROUPS

CAESAR2_COMP_GROUPS

CAESAR2_GROUP_PERMISSIONS

CAESAR2_KRB_SETUP_PERMISSIONS

CAESAR2_COMP_PUBLIC_PERMS

CAESAR2_LDAP_SETUPS

CAESAR2_COMP_LDAP_SETUPS

CAESAR2_LDAP_SEARCH_OBJECTS

CAESAR2_LDAP_SETUP_GROUPS

CAESAR2_LDAP_SERVER_INFO

CAESAR2_LDAP_DEVICE_CREDS

CAESAR2_SOLUTION_ACCTS

CAESAR2_LDAP_ADDRESS_BOOKS

CAESAR2_LDAP_SEARCH_ATTRS

CAESAR2_COMP_SOLN_ACCTS

CAESAR2_SOLUTION_ACCT_GROUPS

CAESAR2_MISC_SETTINGS

Field Name Data Type Description

MINIMUM_PASSWORD_LENG
TH

SMALLINT/ TINYINT* Added new miscellaneous 
setting under Advanced Security 
Component.

PROTECTED_FEATURES VARCHAR(255)

PRINT_PERMISSION_PRINT VARCHAR(255)

PRINT_PERMISSION_BROWS
ER

VARCHAR(255)

PRINT_PERMISSION_CONTR
OL_PAN EL

VARCHAR(255)

*This data type is required for Microsoft SQL Server.
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Views and data export

The following tables describe information on Views in MVE and fields included in each view.
DATA_EXPORT_TEMPLATE

This table contains information on Views in MVE.

Field Name Data Type Description

DATA_EXPORT_ID BIGINT The primary key.

NAME VARCHAR(255) The name of the view.

DEFAULT_TEMPLATE SMALLINT/ TINYINT* Whether the template is the 
default template to be shown 
when initially logged in, only one 
view can have this value set to 
True.

LANGUAGE_CODE VARCHAR(255) Deprecated.

INCLUDE_HEADER SMALLINT/ TINYINT* Deprecated.

WRAP_FIELDS SMALLINT/ TINYINT* Deprecated.

DESCRIPTION VARCHAR(4000) The description of the view.

IS_SYSTEM SMALLINT/ TINYINT* This field indicates whether the 
template is in system view, 
which cannot be edited or 
deleted.

IDENTIFIER_FIELD VARCHAR(255) The identifier field chosen for 
this view.

*This data type is required for Microsoft SQL Server.
DATA_EXPORT_FIELDS

This table contains the fields included in each view.

Field Name Data Type Description

FIELD_INDEX Integer The primary key.

FIELD VARCHAR(255) The name of the field to be 
included in the view.

DATA_EXPORT_ID BIGINT The foreign key to 
DATA_EXPORT_TEMPLATE.DA
TA_EXP ORT_ID.

Event manager

The following tables deal with information related to creating and managing events.
ALERT

This table contains all the alerts that MVE supports.
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Field name Data type Description

ID BIGINT The primary key

NAME VARCHAR(255) The textual name of the alert. 
For example, “Supply Alert.”

SEVERITY VARCHAR(255) For example, “ERROR.”

CATEGORY VARCHAR(255) For example, “SUPPLIES.”

ASSIGNED_EVENTS

This table links events with their assigned Configuration Items.

Field name Data type Description

CI_ID BIGINT The composite primary key. 
Refers to CONFIG_ITEM.CI_ID.

EVENT_ID BIGINT The composite primary key. 
Refers to EVENT.EVENT_ID.

EVENT_REGISTRATION_STAT
E

VARCHAR(255) The options are REGISTERED 
and NOT_REGISTERED.

DESTINATION

This table represents an action within the Event Manager module.

Field name Data type Description

ID BIGINT The primary key.

DESTINATION_TYPE VARCHAR(31) The type of destination, currently 
either email or shell command. 
Depending on the type, not all 
columns apply.

NAME VARCHAR(255) The user-supplied name of the 
destination.

EMAIL_BODY VARCHAR(255) The email body text.

EMAIL_CC VARCHAR(255) The email CC list.

EMAIL_FROM VARCHAR(255) The email From text.

EMAIL_SUBJECT VARCHAR(255) The email Subject text.

EMAIL_TO VARCHAR(255) The email to text.

COMMAND_PATH VARCHAR(255) The full path to the command.

COMMAND_PARAMS VARCHAR(255) Any parameters to send to the 
command.

DESCRIPTION VARCHAR(4000) An optional user description of 
the action.

LAST_MODIFIED Timestamp The date of the last edit of the 
action.

EVENT
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This table contains user-created events, which consist of a name, a description, and a collection of alerts to 
include.

Field name Data type Description

NAME VARCHAR(255) The user-supplied name of the 
event.

DESCRIPTION VARCHAR(255) The user-supplied description of 
the event.

EVENT_ID BIGINT The primary key.

TRIGGER_DESTINATIONS VARCHAR(255) The trigger destinations of the 
event. The options are 
on_active_only and 
on_active_and_clear.

GRACE_PERIOD_ENABLED SMALLINT/ TINYINT* The flag indicating whether a 
grace period is enabled.

GRACE_PERIOD_MINUTES INTEGER The number of minutes for the 
grace period.

LAST_MODIFIED TIMESTAMP The time of the last edit of the 
event.

*This data type is required for Microsoft SQL Server.
EVENT_ALERTS

This table links an event to the collection of alerts it includes.

Field name Data type Description

EVENT_ID BIGINT The composite primary key. 
Refers to EVENT.EVENT_ID.

ALERT_ID BIGINT The composite primary key. 
Refers to ALERT.ALERT_ID.

EVENT_DESTINATIONS

This table links an event to an associated action.

Field name Data type Description

EVENT_ID BIGINT The composite primary key. 
Refers to EVENT.EVENT_ID.

DESTINATION_ID BIGINT The composite primary key. 
Refers to 
DESTINATION.DESTINATION_I
D.

PRINTER_EVENT_ACTIVE_CONDITIONS

This table represents the active conditions or alerts for printers with events that trigger that condition or alert. 
Multiple conditions have their corresponding rows, all pointing to the same PRINTER_ID.

Field name Data type Description

ACTIVE_CONDITION_ID BIGINT The primary key.

LOCATION VARCHAR(255) For example, “Tray 1.”
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Field name Data type Description

MESSAGE VARCHAR(255) For example, “Tray Missing.”

TYPE VARCHAR(255) For example, “Intervention 
Required.”

CI_ID BIGINT Refers to CONFIG_ITEM.ID.

DESTINATION_TASK_ID VARCHAR(80) The foreign key back to 
SYSTEM_LOG.TASK_ID.

Miscellaneous

The following tables provide useful storage but do not fit into any of the previous table categories.
APPLICATION_SETTINGS

This table currently holds all the MVE system settings. The values are encrypted and not available outside of 
MVE.

Field name Data type Description

ID BIGINT The primary key.

SETTING_KEY VARCHAR(255) The preference name.

SETTING_VALUE VARCHAR(8190) The preference value.

BOOKMARK

This table contains all saved searches of MVE. They are currently stored as BLOB, so they cannot be edited 
outside of MVE.

Field name Data type Description

ID BIGINT The primary key.

DEFAULT_SEARCH SMALLINT/ TINYINT* The flag indicating whether this 
bookmark is one of the defaults 
that come with MVE.

NAME VARCHAR(255) The user-supplied name of the 
bookmark.

SEARCH_CRITERIA BLOB SUB_TYPE 0 The binary representation of the 
bookmark.

DESERIALIZABLE SMALLINT/ TINYINT* Indicates whether the saved 
search is deserializable.

DESCRIPTION VARCHAR(4000) An optional user‑entered 
description of the saved search.

*This data type is required for Microsoft SQL Server.
Liquibase and Hibernate Tables

Liquibase and Hibernate are third‑party libraries that MVE uses to help maintain the database. The following 
tables are used by these libraries. These tables do not contain any significant printer data so their contents are 
not detailed here.

DATABASECHANGELOG
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DATABASECHANGELOGLOCK

All tables whose names begin with HT_.

HIBERNATESEQUENCE

SMTP_CONFIGURATION

This table contains configuration for the Simple Mail Transfer Protocol (SMTP), which allows MVE users to send 
emails.

Field name Data type Description

ID BIGINT The primary key.

FROM_ADDRESS VARCHAR(255) The email address of the sender.

LOGIN_ID VARCHAR(255) The user ID for the SMTP 
server.

LOGIN_PASSWORD VARCHAR(255) The password associated with 
the user ID for the SMTP server.

LOGIN_REQ SMALLINT/ TINYINT* The flag indicating whether the 
SMTP server requires a login.

SMTP_PORT BIGINT The port of the SMTP server.

SMTP_SERVER VARCHAR(255) The host name or IP address of 
the SMTP server.

SMTP_ENABLE SMALLINT/ TINYINT* The flag indicating whether 
SMTP is enabled.

EMAIL_ENCRYPTION VARCHAR(64) Refers to the supported 
encryption types., default is null.

*This data type is required for Microsoft SQL Server.
SYSTEM_LOG

This table contains all of the system log messages that are produced as MVE carries out its tasks. This table can 
get very large.

Field name Data type Description

LOG_ID BIGINT The primary key.

TIMESTAMP_ TIMESTAMP The time when the message was 
logged.

TASKID BIGINT The task instance that generated 
the message.

TASKNAME VARCHAR(50) The task that generated the 
message.

LEVEL_ INTEGER The options are DEBUG, INFO, 
etc.

MESSAGE_ VARCHAR(8000) The actual log message.

USER_NAME VARCHAR(255) The username of the user who 
performed the action.

IP_ADDRESS VARCHAR(50) The client IP address.
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Quartz DB

Field name Data type Description

SCHED_TIME BIGINT A new column added for 
Scheduled Time.
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Understanding ports and protocols
MVE uses different ports and protocols for several types of network communication, as shown in the following 
diagram:

Notes

The ports must be open or active for MVE to function properly. Make sure that all the printer ports are 
enabled.

Some communications require an ephemeral port, which is an allocated range of available ports on the 
server. When a client requests a temporary communication session, the server assigns a dynamic port 
to the client. The port is valid only for a short duration and can become available for reuse when the 
previous session expires.

Server‑to‑printer communication

Protocol MVE server Printer Used for

Network Printing 
Alliance Protocol 
(NPAP)

UDP 9187 UDP 9300 Communicating with 
Lexmark network 
printers

XML Network 
Transport (XMLNT)

UDP 9187 UDP 6000 Communicating with 
some Lexmark network 
printers

Lexmark Secure 
Transport (LST)

UDP 6100

Ephemeral 
Transmission Control 
Protocol (TCP) port

(handshaking)

UDP 6100

TCP 6110

(handshaking)

Communicating 
securely with some 
Lexmark network 
printers

Appendix
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Protocol MVE server Printer Used for

Multicast Domain 
Name System 
(mDNS)

Ephemeral User 
Datagram Protocol 
(UDP) port

UDP 5353 Discovering Lexmark 
network printers and 
determining the 
security capabilities of 
printers

Note: This port is 
required to allow 
MVE to 
communicate with 
secured printers.

Simple Network 
Management Protocol 
(SNMP)

Ephemeral UDP port UDP 161 Discovering and 
communicating with 
Lexmark and third-
party network printers

File Transfer Protocol 
(FTP)

Ephemeral TCP port TCP 21

TCP 20

Deploying files

Hypertext Transfer 
Protocol (HTTP)

Ephemeral TCP port TCP 80 Deploying files or 
enforcing 
configurations

TCP 443 Deploying files or 
enforcing 
configurations

Hypertext Transfer 
Protocol over SSL 
(HTTPS)

Ephemeral TCP port TCP 161

TCP 443

Deploying files or 
enforcing 
configurations

RAW Ephemeral TCP port TCP 9100 Deploying files or 
enforcing 
configurations

Printer‑to‑server communication

Protocol Printer MVE server Used for

NPAP UDP 9300 UDP 9187 Generating and 
receiving alerts

Server‑to‑database communication

MVE server Database Used for

Ephemeral TCP port User‑defined port. The default 
port is TCP 1433.

Communicating with an SQL 
Server database

Ephemeral TCP port TCP 3050 Communicating with a Firebird 
database
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Client‑to‑server communication

Protocol Browser client MVE server

Hypertext Transfer Protocol 
over SSL (HTTPs)

TCP port TCP 443

Server-to-mail-server communication

Protocol MVE server SMTP server Used for

Simple Mail Transfer 
Protocol (SMTP)
[Encryption = None]

Ephemeral TCP port User‑defined port. The 
default port is TCP 25.

Providing email 
functionality for 
receiving alerts from 
printers and scheduled 
view export emails 
related to printer data

Simple Mail Transfer 
Protocol (SMTP)
[Encryption = SSL]

Ephemeral TCP port User‑defined port. The 
default port is TCP 
465.

Providing email 
functionality for 
receiving alerts from 
printers and scheduled 
view export emails 
related to printer data 
over SSL

Simple Mail Transfer 
Protocol (SMTP)
[Encryption = TLS/
STARTTLS]

Ephemeral TCP port User‑defined port. The 
default port is TCP 
587.

Providing email 
functionality for 
receiving alerts from 
printers and scheduled 
view export emails 
related to printer data 
over TLS/STARTTLS

Server-to-LDAP-server communication

Protocol MVE server LDAP server Used for

Lightweight Directory 
Access Protocol 
(LDAP)

Ephemeral TCP port User‑defined port. The 
default port is TCP 
389.

Authenticating MVE 
users using an LDAP 
server

Lightweight Directory 
Access Protocol over 
TLS (LDAPS)

Ephemeral TCP port User‑defined port. The 
default port is TCP 
636.

Authenticating MVE 
users using an LDAP 
server over TLS

Kerberos Ephemeral UDP port User‑defined port. The 
default port is UDP 88.

Authenticating MVE 
users using Kerberos

Enabling automatic approval of certificate 
requests in Microsoft CA

By default, all CA servers are in pending mode and you must manually approve each signed certificate request. 
Since this method is not feasible for bulk requests, enable the automatic approval of signed certificates.
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4.

1.

2.

3.

4.

5.

From Server Manager, click Tools › Certificate Authority.

From the left panel, right‑click the CA, and then click Properties › Policy Module.

From the Request Handling tab, click Follow the settings in the certificate template if applicable, and 
then click OK.

Notes
If Set the certificate request status to pending is selected, then you must manually approve the 
certificate.

Restart the CA service.

Revoking certificates

Note: Before you begin, make sure that the CA server is configured for CRLs and that they are available.

From the CA server, open Certification Authority.

From the left panel, expand the CA, and then click Issued Certificates.

Right‑click a certificate to revoke, and then click All Tasks › Revoke Certificate.

Select a reason code and the date and time for revocation, and then click Yes.

From the left panel, right‑clickRevoked Certificates, and then click All Tasks › Publish.

Note: Make sure that the certificate that you revoked is in Revoked Certificates.

You can see the revoked certificate serial number in the CRL.
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